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Using This Guide

This guide is your introduction to the wealth of effects and design options 
available for use in your projects. Along with the standard editing features 
included with this latest release of the Avid Xpress® DV system, you have 
at your fingertips all the sophisticated effects capabilities of a high-end 
postproduction suite, combined with the versatility of a digital nonlinear 
system.

You can use the tools and techniques described in this guide to create and 
incorporate into your sequence titles and effects with a wide variety of 
attributes. This guide also describes how to apply third-party plug-in effect 
filters for stunning effects formerly available only on high-end graphics 
workstations.

n The documentation describes the features and hardware of all models. 
Therefore, your system might not contain certain features and hardware 
that are covered in the documentation.

Who Should Use This Guide

This guide is intended for all Avid Xpress DV users, from beginning to 
advanced.
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About This Guide

This guide is designed to keep pace with current advances in the 
Avid Xpress DV effects capabilities by consolidating in one 
comprehensive resource all the information you will need to take 
advantage of the many options available. This guide leads you through 
even the most complex procedures with task-oriented instructions. The 
information provided here builds on editing procedures described in the 
getting started guide and the user’s guide for Avid Xpress DV, while 
adding a complete explanation of all the tools and techniques required to 
create, apply, and adjust various effects and graphics, including useful tips, 
shortcuts, and custom options.

n Consider keeping the Avid Xpress DV User’s Guide and the 
Avid Xpress DV Quick Reference available during each session.

The Contents lists all topics included in the book. They cover the following 
general areas:

• Effects editing: Chapters 1 through 6 of this book describe various 
beginning and advanced techniques for incorporating literally 
hundreds of digital video effects (DVEs), third-party effect filters, 
complex motion effects, keys, and layering options.

• Creating and editing titles and graphic objects: Chapter 7 and 
Chapter 8 cover titling and use of the tools to create and control the 
attributes of on-screen text, backgrounds, lines, boxes, ovals, and other 
graphics objects. You can create multiple titles without exiting the 
Title tool, and apply shadows, color, transparency, layers, and 
alignment to both objects and text.

• 2D effects reference: Chapter 9 provides quick access to specific 
information about the 2D effects and parameters available with 
Avid Xpress DV.

• The Index helps you locate specific topics.
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Symbols and Conventions

Unless noted otherwise, the material in this document applies to the 
Windows® XP and Mac® OS X operating systems. When the text applies 
to a specific operating system, it is marked as follows:

• (Windows) or (Windows only) means the information applies to the 
Windows XP operating system.

• (Macintosh) or (Macintosh only) means the information applies to the 
Mac OS X operating system.

The majority of screen shots in this document were captured on a 
Windows XP system, but the information applies to both Windows XP and 
Mac OS X systems. Where differences exist, both Windows XP and 
Mac OS X screen shots are shown.

The Avid Xpress DV documentation uses the following special symbols 
and conventions:

1. Numbered lists, when the order of the items is important.

a. Alphabetical lists, when the order of secondary items is important.

• Bulleted lists, when the order of the items is unimportant.

- Indented dashed lists, when the order of secondary items is 
unimportant.

t One arrow indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

The k symbol refers to the Apple® or Command key. Press and hold the 
Command key and another key to perform a keyboard shortcut.

In this document, the term “user’s guide” refers to the Avid Xpress DV 
User’s Guide. The term “getting started guide” refers to the Avid Xpress 
DV Getting Started Guide. The term “online publications CD-ROM” refers 
to the Avid Xpress DV Online Publications CD-ROM.

Courier Bold font identifies text that you type.
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Look here in the 
margin for tips.

In the margin, you will find tips that help you perform tasks more easily 
and efficiently.

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

If You Need Help

If you’re having trouble using Avid Xpress DV:

1. Retry the action, carefully following the instructions given for that task 
in this guide. It is especially important to check each step of your 
workflow.

2. Check the release notes supplied with your Avid application for the 
latest information that might have become available after the hardcopy 
documentation was printed.

3. Check the documentation that came with your Avid application or your 
hardware for maintenance or hardware-related issues.

4. Visit the online Knowledge Center at www.avid.com/support. Online 
services are available 24 hours per day, 7 days per week. Search this 
online Knowledge Center to find answers, to view error messages, to 
access troubleshooting tips, to download updates, and to read/join 
online message-board discussions.

5. For Technical Support, please call 800-800-AVID (800-800-2843).

For Broadcast On-Air Sites and Call Letter Stations, call
800-NEWSDNG (800-639-7364).

http://www.avid.com/support/


Related Information

25

Related Information

The following documents provide more information about the 
Avid Xpress DV product:

• Avid Xpress DV Release Notes for the Windows XP Operating System

• Avid Xpress DV Release Notes for Mac OS X

• Avid Xpress DV Getting Started Guide

• Avid Xpress DV Quick Reference for the Windows XP Operating 
System 

• Avid Xpress DV Quick Reference for Mac OS X

• Avid Xpress DV User’s Guide

• Avid Xpress DV User’s Guide Supplement (available on the 
Avid Xpress DV Online Publications CD-ROM in PDF format)

• Avid Color Correction User’s Guide

• Avid Xpress DV Online Publications CD-ROM

This online collection provides electronic versions of most documents 
listed in this section, as well as documents for related Avid 
applications. You can view these documents with Adobe® 

Acrobat® Reader®, which you can install from the CD-ROM.

• Avid Xpress DV Help

The Help system provides all the information included in the 
Avid Xpress DV User’s Guide, the Avid Xpress DV Effects Guide, and 
the Avid Color Correction User’s Guide supplied with your system. It 
also includes supplemental information not in the manuals. The Help 
operates in a Web browser. To open the Help, choose Avid Xpress DV 
Help from the Help menu in the Avid Xpress DV application. For 
information on using Help, click the Using Help button in the Help 
system.
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If You Have Documentation Comments

Avid Technology continuously seeks to improve its documentation. We 
value your comments about this guide, the Help, the Online Publications 
CD-ROM, and other Avid-supplied documentation.

Simply e-mail your documentation comments to Avid Technology at 

TechPubs@avid.com

Please include the title of the document, its part number, revision, and the 
specific section you are commenting on in all correspondence. 

How to Order Documentation

To order additional copies of this documentation from within the 
United States, call Avid Sales at 800-949-AVID (800-949-2843). If you 
are placing an order from outside the United States, contact your local 
Avid representative.

Avid Educational Services

For information on courses/schedules, training centers, certifications, 
courseware, and books, please visit www.avid.com/training or call 
Avid Sales at 800-949-AVID (800-949-2843).

http://www.avid.com/training/


Chapter 1

Preparing to Work 
with Effects

Avid Xpress DV offers many effects that you can apply to your sequences. 
This chapter describes concepts you should understand before you begin 
creating and editing effects into sequences.

• Effect Types

• Effects Creation Tools

• Understanding Effect Playback Capabilities

• Using the Effect Palette

• Using Third-Party Plug-in Effects
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Effect Types

Much overlapping occurs between the various types of effects you can 
create, as well as the methods used to create them. Your system offers four 
basic effect types.

• Transition effects (dissolves, wipes, and so forth) are applied at the 
cut point between two video clips that are on the same video track (that 
is, the same video layer). For more information on creating transition 
effects, see Chapter 2, “Basics of Effects Editing” and Chapter 3, 
“Customizing Effects.”

• Segment effects are applied to an entire clip or group of clips. There 
are two types of segment effects:

- A single-layer segment effect, such as the Mask effect, is applied 
to a segment on one video track. Single-layer segment effects use 
one stream of video. For more information on creating single-layer 
segment effects, see Chapter 2, “Basics of Effects Editing” and 
Chapter 3, “Customizing Effects.”

- A multilayer segment effect, such as the Picture-in-Picture effect, 
is applied to the top layer or a middle layer of segments that 
contain two or more video tracks that will be played 
simultaneously. For more information on techniques for creating 
multilayer effects, see Chapter 6, “Creating Layered and Nested 
Effects.”

• Title effects are created with the Title tool and edited onto their own 
layers in a sequence. For more information on techniques for creating 
and editing title effects, see Chapter 7, “Creating Titles and 
Graphic Objects” and Chapter 8, “Editing with Titles.”

• Motion effects (freeze frame, variable speed, and strobe) are created 
by manipulating the playback characteristics of a clip of footage. For 
more information on techniques for creating motion effects, see 
Chapter 5, “Creating Motion Effects.”
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Effects Creation Tools

The following chart presents the basic tools used to create effects.

Sources of 
effects:

Effects editing in default 
editing mode: 

Effects adjustment in 
Effect mode: Effect Editor: 

Allows you to 
adjust effect 
parameters.

Effect Preview monitor: 
Allows you to preview an 
effect, manipulate 
keyframes, and 
manipulate wire-frame 
representations of the 
effect.

Apply transition and 
segment effects 
directly to tracks.

Title and motion 
effects appear first 
as clips in the bin.

Edit effect 
clips into the 
Timeline.

Motion Effect dialog box Title tool

Effect Palette
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Understanding Effect Playback Capabilities

When you apply an effect to video in Avid Xpress DV, you change the look 
of that video, for example by altering its color values or by blending 
frames from one clip with frames from another. In some circumstances, 
your system is able to calculate these changes and display them in real 
time. In other circumstances, your system is unable to do this, so you must 
render the effect to play it at full speed. When you render an effect, the 
system calculates the changes made to each frame of the effect and stores 
them in a file, known as a precomputed master clip (or simply a 
precompute), which it can then use to play back the effect.

It is important to understand when you can use real-time effect playback to 
keep your effect editing work fast and flexible, and when you must render 
effects. The following paragraphs provide a brief introduction to the main 
alternatives available. For complete information on effect playback and 
rendering, see Chapter 4.

Most effects in Avid Xpress DV can be played in real time within the 
system while your work is still in progress. This allows you to preview the 
look of effects and make adjustments to them without having to render the 
effects. Your system cannot play motion effects or some third-party plug-in 
effects in real time; these effects must always be rendered before you can 
see how they look when playing at full speed.

Avid Xpress DV’s ability to preview effects in real time is dependent on the 
complexity of the effects in your sequence and on system factors such as 
processor speed and available memory. For more information on real-time 
preview of effects, see “Real-Time Preview of Video Effects” on page 159.

If you want to preview effects that your system cannot play in real time 
without rendering them, you can use the Render On-the-Fly option to 
preview them frame by frame. For more information, see “Previewing 
Effect Frames with Render On-the-Fly” on page 158.
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When you are ready to output a sequence that includes effects, you must 
render the majority of those effects. The exact number of effects that you 
must render for output depends on the following factors:

• Whether your output will be analog or DV

• How complex your sequence is, and especially how your effects are 
layered on multiple video tracks.

For more information, see “Rendering Effects” on page 167.

Using the Effect Palette

The Effect Palette is a window that lists all the effects available on your 
Avid Xpress DV system. The complete set of effects available on your 
system includes all standard Avid effects for your model as well as any 
additional third-party plug-ins you might have installed. You select 
transition and segment effects from the Effect Palette.

Understanding the Effect Palette

The left side of the Effect Palette displays a scrollable list of effect 
categories that includes the following standard categories as well as 
categories for any third-party plug-ins you have installed.

• Blend

• Box Wipe

• Conceal

• Edge Wipe

• Film

• IllusionFX™

• Image

• Key

• L-Conceal

• Matrix Wipe
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• Peel

• Push

• Sawtooth Wipe

• Shape Wipe

• Spin

• Squeeze

n If you have effect templates saved in an open bin, or if you have third-party 
plug-in effects installed on your system, additional effect categories appear 
in the Effect Palette.

n The IllusionFX category appears in the Effect Palette and contains the 
IllusionFX Pack plug-ins that are standard with your Avid system. For 
information on IllusionFX Pack effects, see the Help or the documentation 
in the Goodies folder on the application CD-ROM: 
Goodies\IllusionFXPack\IllusionFXPack.pdf.

The right side of the Effect Palette shows a list of the individual effects 
available for the currently selected effect category. Each effect has its own 
effect icon. Effects that are or might be playable in real time appear with a 
color-coded dot. For more information, see “Enabling Real-Time Effects” 
on page 161.
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Displaying the Effect Palette

You can display the Effect Palette within the Project window or as a 
standalone window.

To display the Effect Palette within the Project window:

1. In the Project window, click the Effects tab, which displays the Effect 
icon.

2. Click an effect category in the left side of the Effect Palette to select it 
and display effects in that category in the right side.

Effect icon

Scrollable list of 
effect categories

Blend effect choices
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To display the Effect Palette as a standalone window:

1. Do one of the following:

t From the Tools menu, choose Effect Palette.

t Press Ctrl+8 (Windows) or k+8 (Macintosh).

The Effect Palette opens.

2. Click an effect category in the left side of the Effect Palette to select it 
and display effects in that category in the right side.

Resizing the Effect Palette

You can resize the Effect Palette to display more effects when a particular 
category includes a long list of icons.

To resize the Effect Palette:

t Click the lower right corner of the standalone palette or of the Project 
window, drag the palette to the size you want, and then release the 
mouse button.

Scrollable list of 
effect categories

Matrix Wipe 
effect choices
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Displaying Effect Templates

Effect templates allow you to save the parameters of an effect to a bin and 
use them again to create or modify other effects. To learn more about 
applying templates, see “Using an Effect Template” on page 150.

In addition to displaying all the standard effects, the Effect Palette allows 
you to view and access effect templates stored in open bins. The names of 
open bins containing effects appear in a list below the effect categories.

To view effect templates:

1. Open the bin containing the effect templates.

2. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

The Effect Palette opens.

3. Click the bin name below the effect category list to view the effect 
templates in the bin. 
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For example, in the preceding illustration, the bin named Effects and 
Titles contains effect templates using the Zig-Zag Matrix and Matte 
Key effects.

n The Effect Palette also displays other effect files, such as matte key clips.

Whenever you open or close a bin and whenever you drop an effect into a 
bin, Avid Xpress DV automatically updates both lists. Once a template 
appears in the right side of the Effect Palette, you can apply it as you would 
any other effect.

Using Third-Party Plug-in Effects

You can use third-party plug-in effects to add new effects to your 
Avid Xpress DV system or to update existing effects.

Understanding AVX Plug-Ins

Third-party plug-in effects are compatible with the Avid Visual Extensions 
(AVX™) standard. AVX is a cross-platform software architecture designed 
to allow software effect modules to be dynamically linked with a host 
application such as an Avid editing system.

n If you are transferring from another system a project that includes 
sequences with AVX plug-in effects, you must install matching AVX 
plug-ins to see the effects.

Effect category list

Bin name containing 
effect templates

Effect templates
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You can purchase these plug-ins directly from a third-party vendor. Two of 
the current AVX plug-in vendors are:

• Ultimatte Corporation (Ultimatte®) 

www.ultimatte.com

• Artel Software (Boris FX™) 

www.borisfx.com

For a complete, up-to-date list of AVX plug-in vendors and other 
information on AVX, see the AVX Web site:

www.avid.com/partners/avx/index.html

After you install third-party plug-ins, the effects appear in the Effect 
Palette in their own category (usually the name of the plug-in vendor). 
Individual effects all have a plug effect icon. The plug icon also appears in 
the Timeline when you apply a third-party plug-in effect. After you create 
an effect, you can save it as an effect template and reapply the template to 
other transitions or segments in your sequence. Effect templates also 
appear in a special section at the bottom of the Effect Palette.

n Your Avid Xpress DV system also supports Digidesign® AudioSuite™ 
plug-ins. These plug-ins apply only to audio clips and do not appear in the 
Effect Palette. For more information, see the chapter “Working with 
Audio” in the user’s guide.

IllusionFX Pack Plug-Ins

The IllusionFX category in the Effect Palette contains a number of AVX 
plug-ins that are standard on your Avid system. For information on these 
effects, see the Help for your system or the documentation in the following 
folder on the application CD-ROM:

Goodies\IllusionFXPack\IllusionFXPack.pdf

http://www.ultimatte.com
http://www.borisfx.com
http://www.avid.com/partners/avx/index.html
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Installing AVX Plug-Ins

AVX plug-ins usually come complete with any necessary documentation. 
This section describes how to install the plug-ins and how to access them 
from your Avid Xpress DV system.

Most AVX plug-ins have their own installation program. This program 
locates the AVX_Plug-Ins folder and installs the plug-ins automatically 
when you follow the installation instructions.

c If an AVX plug-in has an installation program, you should always use 
the program to install the plug-ins. For more information, see the 
documentation for the plug-in.

Some AVX plug-ins do not have an installation program and must be 
installed manually.

To install AVX plug-ins manually:

1. Quit the Avid Xpress DV application.

c Do not add or remove plug-ins while Avid Xpress DV is running.

2. Copy the plug-in files from the software vendor’s folder to the 
AVX_Plug-Ins folder located on your Avid Xpress DV system.

The default location for the AVX_Plug-Ins folder is:

C:\Program Files\Avid\AVX_Plug-Ins (Windows)

Avid:Avid Xpress:SupportingFiles:AVX_Plug-Ins (Macintosh)

However, the AVX_Plug-Ins folder might be in a different location on 
your system.

n (Windows only) If the AVX_Plug-Ins folder does not appear in the default 
location and you don’t know its location, you can locate the folder by using 
the Regedit application. For more information, see “Locating the AVX 
Plug-Ins Folder (Windows Only)” on page 40.
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The following illustration shows the location of the AVX_Plug-Ins 
folder within the Avid file structure on a Macintosh system.

3. Restart the Avid Xpress DV application, and open the Effect Palette. 
The AVX plug-in effects appear in the Effect Palette, usually in their 
own category under the name of the vendor.

c You must place the plug-ins directly in the AVX_Plug-Ins folder. They 
cannot be inside another folder within this folder or elsewhere on your 
Avid Xpress DV system. If they are, Avid Xpress DV will not recognize 
them.

n If the plug-in effects do not appear in the Effect Palette after installation, 
see “Troubleshooting AVX Plug-Ins” on page 44.
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Locating the AVX Plug-Ins Folder (Windows Only)

When the Avid Xpress DV application is first installed, the installation 
program asks the administrator to choose a location for the AVX_Plug-Ins 
folder. The default path is:

C:\Program Files\Avid\AVX_Plug-Ins

If the administrator accepts the default location for the AVX_Plug-Ins 
folder, you can install AVX plug-ins here.

If the AVX_Plug-Ins folder is not in the default location, or if the effects 
are not appearing in the Effect Palette after you install them, you can use 
the Regedit application that comes with your Windows system to identify 
the location of the AVX_Plug-Ins folder.

c Use the following procedure only to obtain information on the location 
of the AVX_Plug-Ins folder. Do not change any of the information in 
the Windows Registry. Changing values in the Windows Registry 
might affect the performance of your system.

To locate the AVX_Plug-Ins folder by using Regedit:

1. Click the Start button, and then click Run.

2. Type regedit in the command line, and click OK.

The Registry Editor window opens.

3. In the left pane of the window, navigate to the following path:

HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\AVX Plug-Ins

4. Click the AVX Plug-Ins folder in the left pane, and then check the 
entry for “Directory” in the right pane.

The value of this entry is the path that contains the AVX_Plug-Ins 
folder. For example, if the AVX_Plug-Ins folder is in its default 
location, the Directory entry will be “C:\Program Files\Avid.” If you 
navigate to C:\Program Files\Avid by using My Computer or Windows 
Explorer, you will find the AVX_Plug-Ins folder in that location.
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n Remember that AVX plug-ins must be installed in the AVX_Plug-Ins folder 
itself, not elsewhere in the path that contains that folder.

Upgrading AVX Plug-ins and Effects

You can upgrade an AVX plug-in simply by uninstalling the old version of 
the plug-in and installing the new version in your AVX_Plug-Ins folder.

Once you have installed a new version of an AVX plug-in, Avid Xpress DV 
upgrades older effects in sequences to be compatible with the new version. 
The parameter values previously set by the user for an effect appear in the 
Effect Editor or in the plug-in’s own user interface.

If the new version of the plug-in has new or redesigned parameter controls, 
Avid Xpress DV sets these controls to their default settings when 
upgrading existing effects. Controls that are unchanged from the older 
version of the plug-in retain the values previously set by the user when 
Avid Xpress DV upgrades existing effects.

HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\AVX Plug-Ins Directory entry. The path listed here is the path 
that contains the AVX Plug-Ins folder.
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c After you upgrade a plug-in effect or transition, you should not 
reinstall the older version of the plug-in. Avid Xpress DV cannot use 
an older version of a plug-in to process effects that have been created 
with a newer version. Similarly, if you transfer projects between 
systems, an effect created with a newer version of a plug-in will not 
work on a system that has an older version installed.

Assigning Multiple Tracks in Plug-in Effects

Some plug-in effects can take an arbitrary number of tracks as input. Your 
system allows you to choose the number of video inputs from the AVX 
Optional Inputs dialog box.

For more information on the multiple-track capabilities of a plug-in, see 
the documentation for that plug-in.

To assign multiple tracks to a plug-in effect by using the AVX 
Optional Inputs dialog box:

1. Drag the plug-in icon to the Timeline.

2. When the AVX Optional Inputs dialog box appears, select the number 
of video inputs you want from the Number of Tracks pop-up menu, 
and then click OK.

For more information on nested effects, see “Nesting Effects” on page 224.

Using AVX Plug-in Controls

AVX plug-ins use a variety of different interfaces that give you control 
over the effects. Some plug-ins use custom interfaces that appear in their 
own dialog boxes. Others use some combination of controls that appear 
within the Effect Editor. These controls might include standard Avid 
controls familiar from Avid effects, custom controls designed by Avid for 
use by plug-in vendors, and custom controls designed by the plug-in 
vendors themselves.
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Accessing an AVX Custom Interface

If an AVX plug-in has a custom interface, you access that interface from 
the Effect Editor.

To access an AVX plug-in’s custom interface:

t Click the Other Options button in the Effect Editor.

The AVX plug-in’s custom interface appears.

n Dialog boxes that appear as part of an AVX plug-in’s custom interface are 
modal dialog boxes. If you move one of these dialog boxes, the screen 
behind the dialog box will not redraw. To restore your screen, close the 
dialog box.

Custom AVX Controls in the Effect Editor

This section introduces some of the custom controls that might appear in 
the Effect Editor for an AVX plug-in effect. For more information on using 
these controls, and other controls specific to individual effects, see the 
documentation for the plug-in.

Some plug-in effects allow you to adjust an image by using controls that 
appear as overlays, such as handles and wire frames, in the Effect Preview 
monitor. You access these overlays by clicking the Outline/Path button at 
the bottom of the Effect Editor. In some cases, you can then access 
additional controls by clicking buttons on the right side of the Effect 
Editor. 

The following Effect Editor parameters, which are not available in standard 
Avid effects, are available to some AVX plug-in effects:

• The Thumbwheel is a slider that provides a window on a wide range of 
values and allows precise control over increments. 
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• The Angle parameter category allows you to manipulate an effect’s 
angle or direction by dragging within a graphic representation of a 
circle to alter the angle or direction value. Values can be positive or 
negative and are not limited to a single 360o rotation.

Troubleshooting AVX Plug-Ins

This section describes problems that you might encounter with AVX 
plug-ins and makes suggestions for possible solutions or sources for more 
information.

If a plug-in does not work as expected and the following suggestions do 
not solve the problem, contact the plug-in vendor.

Plug-in Does Not Appear in the Effect Palette

AVX plug-ins have a plug icon in the Effect Palette and in the Timeline. If 
the plug icon does not appear in the Effect Palette after installation, the 
plug-in might be in the wrong folder. For information on locating the 
AVX_Plug-Ins folder on a Windows system, see “Locating the AVX 
Plug-Ins Folder (Windows Only)” on page 40.

Plug-in Does Not Load

AVX plug-ins might not load correctly for a variety of reasons. In 
particular, even though it is installed correctly in the AVX_Plug-Ins folder, 
a plug-in might require supporting files (for example, .dll files) that are 
missing from your system or are installed in the wrong location.

If a correctly located plug-in does not load, check the plug-in 
documentation for information on required supporting files.
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Avid Xpress DV Cannot Render the Plug-In

If Avid Xpress DV cannot render the plug-in, possible causes include the 
following:

• The plug-in has expired.

• The plug-in’s application key is missing or damaged.

Some plug-ins write more information about the failure to the Console 
window. Also, some plug-ins might report the problem in a message box. 

Blank Effect Icons in the Timeline

AVX plug-ins have a plug icon in the Effect Palette and in the Timeline. If 
the effect icon in the Timeline is blank, Avid Xpress DV could not find the 
plug-in.

To identify a plug-in that is missing or misplaced:

t Open the Console window (choose Console from the Tools menu), and 
look for the message “Can’t find effect.”

The message identifies the plug-in that Avid Xpress DV cannot locate. 
You can then reinstall the plug-in in your AVX_Plug-Ins folder and 
restart Avid Xpress DV.

Missing Effect Categories in the Effect Palette

If you cannot see the plug-in categories in the Effect Palette, you might 
have an incorrect version of the AVXLibrary or the plug-ins might not have 
been installed correctly. In this case, check the Console window for a 
message that states that AVX is disabled. If it is not disabled, quit the 
Avid Xpress DV application, reinstall the plug-ins, and restart the 
application.

If the message in the Console window states that AVX is disabled, call 
Avid Customer Support to determine whether you need a new version of 
the AVXLibrary.
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Chapter 2

Basics of Effects Editing

This chapter explains how to create basic transition and single-layer 
segment effects.

• Deconstructing Effects

• Applying Effects to a Sequence

• Deleting Effects in a Sequence

• Using the Fade Effect Button

• Working with Transition Effects
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Deconstructing Effects

Breaking down existing effects into their basic elements provides one good 
way to understand how Avid Xpress DV builds effects. By learning how 
the various pieces fit together, and how Avid Xpress DV allows you to 
manipulate them, you can begin to construct new effects from these 
building blocks.

The sequence depicted in the following Timeline contains a series of 
effects that cover all the basic techniques — from simple dissolves to 
nested layers.

Imported title elements 
set in motion with a 
wipe effect

Layered background 
elements

Layered foreground 
elements
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The sequence includes both transition and segment effects applied 
horizontally, vertically, and nested within video tracks. The callouts 
summarize deconstructed elements and list the sections of this guide that 
describe them in more detail.

Dissolve sequence forms the foreground on V2: 
See “Applying an Effect to Multiple Transitions” on page 53 
and “Working with Transition Effects” on page 59.

Nested segments 
add more layers to 
the foreground 
track: See “Nesting 
Effects” on 
page 224.

Submaster segment, created from collapsed 
layers, forms the background on V1: See 
“Submaster Editing” on page 231.

Title graphics imported as Matte Key effects: See 
“Working with Imported Graphics and Animation” on 
page 221.

Effect template applied repeatedly to crop 
and position foreground images on V2: 
See “Applying an Effect Template” on 
page 152.

Keyed titles are faded in and out: See 
“Using the Fade Effect Button” on 
page 58.

Various effect parameters are adjusted 
throughout to soften, distort, or position images: 
See “Using the Effect Editor” on page 86.

Imported graphic used as a wipe: 
See “Working with Imported Graphics and Animation” 
on page 221.

Deconstructing an Effects Sequence
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Applying Effects to a Sequence

This section explains how to apply an effect to a sequence in the Timeline. 
You can apply an effect to:

• One transition or segment on a single video layer

• Multiple transitions or segments

The effect type (transition or segment) determines where you can place the 
effect in the sequence. For an explanation of the effect types, see “Effect 
Types” on page 28. For information on individual effects, see “2D Effects” 
on page 349.

After you apply an effect, the next step is to adjust the effect’s parameters. 
To understand how to adjust the effect parameters, see “Understanding 
Effect Parameters” on page 91.

Applying an Effect to a Single Transition or Segment

This section describes how to add a single transition or segment effect to a 
single video layer by dragging an effect from the Effect Palette or by 
double-clicking a segment or transition.

You can also apply several of the most common transition effects, such as 
the Dissolve effect, by clicking the Quick Transition button. For more 
information, see “Using the Quick Transition Button” on page 63.

Dragging an Effect from the Effect Palette

To apply an effect to a single transition or segment:

1. Create a sequence in the Composer monitor, using standard Avid 
editing procedures. 

For information about editing a sequence, see the chapter “First Edits” 
in your user’s guide.
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2. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

For an explanation of the Effect Palette, see “Using the Effect Palette” 
on page 31.

3. Click the effect icon in the Effect Palette, drag it to the segment or 
transition in the Timeline, and release the mouse button.

The effect icon appears in the Timeline as shown in the following 
example.

n If the effect is a transition effect and the sequence does not have enough 
incoming or outgoing media to apply that effect, a dialog box appears. For 
more information, see “Sizing the Effect to Fit the Media” on page 74.

Effect icon

Drag the effect icon from 
the Effect Palette to the 
sequence.
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n If the effect is a segment effect, one segment at a time is highlighted as you 
drag the effect within the Timeline. If the effect is a transition effect, one 
transition at a time is highlighted as you drag the effect within the 
Timeline. Some effects are both transition and segment effects; when you 
drag such an effect within the Timeline, both transitions and segments are 
highlighted.

Double-Clicking an Effect Icon in the Effect Palette

To apply an effect to a single segment:

1. Create a sequence in the Composer monitor, using standard Avid 
editing procedures. 

For information about editing a sequence, see the chapter “First Edits” 
in your user’s guide.

2. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

3. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline.

4. Click the segment to which you want to add the effect.

5. Double-click the effect icon in the Effect Palette.

The effect icon appears in the Timeline.

n If the effect is a transition effect and the sequence does not have enough 
incoming or outgoing media to apply that effect, a dialog box appears. For 
more information, see “Sizing the Effect to Fit the Media” on page 74.

To apply an effect to a single transition in Trim mode:

1. Create a sequence in the Composer monitor, using standard Avid 
editing procedures. 

2. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.
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3. Click the transition where you want to add the effect.

4. Double-click the effect icon in the Effect Palette.

The effect icon appears in the Timeline.

n If the effect is a transition effect and the sequence does not have enough 
incoming or outgoing media to apply that effect, a dialog box appears. For 
more information, see “Sizing the Effect to Fit the Media” on page 74.

n This procedure for adding a transition effect works only in Trim mode. See 
“Creating a Dissolve in Trim Mode” on page 61.

Applying an Effect to Multiple Transitions

To apply an effect to multiple transitions:

1. If there is not already an effect on one of the transitions, add a 
transition effect. Avid Xpress DV allows you to perform this procedure 
only if one of the transitions already has an effect on it.

2. Choose Effect Editor from the Tools menu.

3. Click the transition effect described in step 1.

4. If the Effect Editor is blank, click the Effect Editor to display the 
information for the transition effect.

5. Click above the Timeline, and begin dragging to activate a selection 
box. Continue to drag down and either to the left or right to include 
additional transitions in the selection.

Selection box
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6. Release the mouse button when you have lassoed all the transitions 
you want.

The transitions that you selected are highlighted, and the position 
indicator moves to the first transition.

7. If the transitions where you want to apply the effect are not contiguous, 
Shift+click any transition to deselect it.

8. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

9. Double-click the icon for the effect that you want to apply to the 
transitions.

The effect appears on the highlighted transitions in the Timeline.

n If the sequence does not have enough incoming or outgoing media to apply 
the transition effect, a dialog box appears. For more information, see 
“Sizing the Effect to Fit the Media” on page 74.
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Applying an Effect to Multiple Segments

You can apply an effect to multiple segments on the same video layer or on 
multiple video layers in a single step. The following procedure describes 
selecting multiple segments in the same video layer. You can also use this 
procedure to select segments on multiple layers.

n You cannot apply effects to multiple segments while in Trim mode.

To apply an effect to multiple segments on the same video layer:

1. Click above the Timeline and to the left of the leftmost segment that 
you want to select, and begin dragging to the right and down to activate 
a selection box.

2. Continue to drag the selection box to the right until you lasso the 
rightmost segment that you want to select.

3. Release the mouse button.

Avid Xpress DV highlights the segments you selected.

4. If the segments where you want to apply the effect are not contiguous, 
Shift+click a segment to deselect it. You can also Shift+click to add 
one or more segments.

Selection box
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5. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

6. Double-click the effect’s icon that you want to apply to the segments.

Avid Xpress DV applies the effect to the highlighted segments in the 
Timeline.

Deleting Effects in a Sequence

You can delete transition effects from a sequence in the Timeline at any 
time. You can delete segment effects from a sequence in the Timeline at 
any time except when you are in Trim mode. Use the following procedures 
to either delete a single effect from a sequence or delete effects in multiple 
segments.

Deleting a Single Effect

To delete a single effect:

1. Move the position indicator to the Timeline segment containing the 
effect’s icon.

The track containing the effect is selected.
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2. If multiple tracks contain effects at the same position in the Timeline, 
select only the track where the effect to be deleted resides.

In this example, only track V3 is selected.

c If you delete a segment effect and the segment contains a transition 
effect, the transition effect will be deleted as well, because the 
transition effect resides “on top of” the segment effect. If necessary, 
you will have to reapply the transition effect.

3. Delete the effect by doing one of the following:

t If the Effect Editor is not active, click the Remove Effect button in 
the Tool palette.

For information on opening the Tool palette, see “Using the Tool 
Palette” in the chapter “Viewing and Marking Footage” in the 
user’s guide.

t When the Effect Editor is active, select the effect and press the 
Delete key.

To open the Effect Editor, choose Effect Editor from the Tools 
menu.

t In Trim mode (for transition effects only), either press the Delete 
key or click the Remove Effect button.

For information on entering Trim mode, see “Entering Trim 
Mode” in the chapter “Working in Trim Mode” in the user’s guide.

n When you delete an effect from a sequence, Avid Xpress DV does not delete 
the associated media file. To delete the effect’s media file, you must 
manually remove it from the drive. Avid Xpress DV operates this way so 
that you will be able to undo the deletion of an effect or undo the change 
you made to an effect. To delete an effect’s media file, see “Managing 
Effect Media Files” on page 188.

The effect is removed.
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Deleting Multiple Transition Effects

To delete multiple transition effects:

1. Shift+click each transition effect you want to delete. 

2. Click the Remove Effect button, or press the Delete key.

Deleting Multiple Segment Effects

To delete multiple segment effects:

1. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline.

2. Shift+click each segment that contains a segment effect you want to 
delete.

3. Click the Remove Effect button, or press the Delete key.

Using the Fade Effect Button

You can use the Fade Effect button to fade segment effects quickly and 
easily. A dialog box appears that allows you to enter the number of frames 
to fade up and fade down.

The Fade Effect feature automatically creates keyframes for the effect. You 
can access the keyframes in the Effect Editor.

To fade one or more segment effects in a sequence:

1. Make a selection in the Timeline by doing one of the following:

t To fade a single segment effect, move the position indicator to the 
segment.

t To fade multiple segment effects, click either of the Segment 
Mode buttons (Extract/Splice-in or Lift/Overwrite) below the 
Timeline; then Shift+click the segments.
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2. Click the Fade Effect button in the Tool palette.

For information on opening the Tool palette, see “Using the Tool 
Palette” in the chapter “Viewing and Marking Footage” in the user’s 
guide.

The Fade Effect dialog box appears.

3. In the Fade Effect dialog box, type the number of frames to fade up 
and fade down, and click OK.

You can immediately view the Fade effect by playing the segment or 
segments.

Working with Transition Effects

You apply a transition effect to the cut point between two clips on the same 
video track. You can adjust the alignment and duration of a transition 
effect. Depending on the specific effect, other effect parameters might also 
be available.

Transition effects are included in all effect categories in the Effect Palette, 
except the Image effect category. For an explanation of the transition 
effects in each effect category, see Chapter 9.
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Applying a Dissolve Effect

One of the most common transition effects is a dissolve. Avid Xpress DV 
has four methods you can use to apply the Dissolve effect:

• Select the Dissolve effect from the Effect Palette.

For more information, see “Using the Effect Palette to Create a 
Dissolve Effect” on page 60.

• In Trim mode, use the Transition parameters to create a dissolve.

For more information, see “Creating a Dissolve in Trim Mode” on 
page 61.

• Use the Head Fade or Tail Fade button.

For more information, see “Adding Dissolves with the Head Fade and 
Tail Fade Buttons” on page 62.

• Click the Quick Transition button in the Tool palette.

You can also use the Quick Transition button as a fast method for 
creating and adjusting several other common transition effects. For 
more information, see “Using the Quick Transition Button” on 
page 63.

Using the Effect Palette to Create a Dissolve Effect

To apply a Dissolve effect using the Effect Palette:

1. Create a sequence in the Composer monitor using standard editing 
procedures. For information about editing a sequence, see the chapter 
“First Edits” in the user’s guide.

2. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

3. Click the Blend category.
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4. Drag the Dissolve Effect icon to the transition in the Timeline, and 
release the mouse button.

The Dissolve Effect icon appears in the Timeline.

n If the sequence does not have enough incoming or outgoing media to apply 
a transition effect, a dialog box appears. See “Sizing the Effect to Fit the 
Media” on page 74.

Creating a Dissolve in Trim Mode

You can create a Dissolve effect in Trim mode using the Transition 
parameters displayed in the Effect Editor and in the Composer monitor.

To create a Dissolve effect using the Transition parameters:

1. Click a transition in the Timeline while in Trim mode.

2. In the Transition Effect Duration box in the Effect Editor or in the 
Composer monitor, type the dissolve’s duration. 

This adds the Dissolve effect at the transition and a Dissolve effect in 
the Timeline.

n The Duration setting determines the duration format above the Composer 
monitor, for example, seconds:frames. For more information, see the 
chapter “Working in Trim Mode” in the user’s guide.

3. Click the Transition Effect Alignment button, and select the effect’s 
position relative to the cut point from the pop-up menu.

For an explanation of the Transition Effect Alignment pop-up menu 
selections, see “Transition Parameters” on page 348.

Transition Effect Alignment 
button

Transition Effect Alignment 
pop-up menu

Transition Effect Duration box
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Adding Dissolves with the Head Fade and Tail Fade Buttons

You can use the Head Fade button and Tail Fade button to add dissolves on 
one or more video tracks (or fades on one or more audio tracks).

You can map the Head Fade button and Tail Fade button from the 
Command palette to a key on your keyboard or to an existing button 
location such as the Tool palette. For more information, see “Mapping 
User-Selectable Buttons” in the chapter “Using Basic Tools” in the user’s 
guide. 

To add dissolves using the Head Fade and Tail Fade buttons:

1. Move the position indicator to a clip where you want the dissolve to 
end or begin.

For example, if you move the position indicator ten frames after the 
beginning of the clip and then use the Head Fade button, the system 
creates a ten-frame dissolve that lasts from the beginning of the clip to 
the location of the position indicator.

2. Select the tracks on which you want to create dissolves.

If you choose more than one track, the system creates dissolves of 
appropriate lengths for each track, as shown in the following 
illustration.

3. Choose Command Palette from the Tools menu.

4. Click the FX tab, and then click Active Palette.

5. Click the Head Fade or the Tail Fade button.

The dissolves appear in the Timeline. If a dissolve begins or ends at the 
edit point between two clips, the dissolve crosses between the two 
clips. Otherwise the dissolve is a fade from or to black.

Before After — Two dissolves of different 
lengths are created on the two tracks.
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6. (Option) If, for any selected track, there is insufficient source media to 
create a dissolve of the length you specified with the position indicator, 
a message box appears. 

Do one of the following:

t Click Size to Fit. 

The system creates the longest dissolve possible. For more 
information on sizing effects to fit available media, see “Sizing the 
Effect to Fit the Media” on page 74.

t Click Skip Track.

The system does not create a dissolve on the track with insufficient 
source material but does create dissolves on any other selected 
tracks with sufficient source material.

t Click Cancel.

The system does not create any dissolves.

Using the Quick Transition Button

You can create common transition effects by clicking the Quick Transition 
button.

This button allows you to apply the following transition effects without 
using the Effect Palette:

• Dissolve

• Fade to Color

• Fade from Color

• Dip to Color
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You can choose to add the same transition effect to multiple transitions at 
the same time by marking IN and OUT points in your sequence that select 
all the transitions to which you want to apply the effect. When you click 
the Quick Transition button, the Quick Transition dialog box will contain a 
check box for Apply to All Transitions (IN -> OUT). For more 
information, see “Applying Effects to Multiple Transitions Using the 
Quick Transition Button” on page 67.

Creating an Effect Using the Quick Transition Button

To create an effect using the Quick Transition button:

1. Move the position indicator to the transition in the Timeline.

2. Click the Quick Transition button in the Tool palette.

For information on opening the Tool palette, see “Using the Tool 
Palette” in the chapter “Viewing and Marking Footage” in the user’s 
guide.

The Quick Transition dialog box appears.

Graphical display 
of media and effect
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The dialog box includes a graphical display of the outgoing media and 
incoming media, with the effect icon applied to the transition. For 
more information, see “Understanding the Graphical Display in the 
Quick Transition Dialog Box” on page 70.

3. Choose a transition effect from the Add pop-up menu.

For an explanation of individual effects shown in the menu, see “Blend 
Effects” on page 350.

n When you save a Dissolve effect template into a bin named Quick 
Transitions, the effect template appears in the Add pop-up menu. See 
“Using an Effect Template” on page 150.

n When you choose a color transition with Quick Transition, the default 
color is black. You must enter Effect mode to choose another color. For 
more information, see “Using the Effect Editor” on page 86.

4. Select the transition duration by doing one of the following:

t Type the duration in frames in the Duration text box.

t Click either the left or right edge of the Dissolve Effect icon, and 
drag it to change the duration. For more information, see 
“Understanding the Graphical Display in the Quick Transition 
Dialog Box” on page 70.

The graphical display changes — the size of the effect icon gets 
smaller or larger, and the numbers in the Duration and Start text boxes 
change — to reflect the new duration.
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5. Adjust the effect’s alignment relative to the cut point in one of the 
following ways:

t Choose an alignment from the Position pop-up menu to have the 
effect end at the cut point, center on the cut point, or start at the cut 
point.

t Choose Custom from the Position pop-up menu, and then type a 
number in the Start text box to specify how many frames before 
the cut point you want the effect to begin.

n Avid Xpress DV automatically selects the Custom option in the Position 
pop-up menu when you click in the graphical display.

t Click inside the effect in the graphical display, and drag it to 
position the effect with respect to the cut point.

t Click one of the alignment buttons below the graphical display.

For more information on the graphical display options, see 
“Understanding the Graphical Display in the Quick Transition 
Dialog Box” on page 70.

Avid Xpress DV positions the effect, updates the graphical display to 
show the new position of the effect, and updates the value in the Start 
text box.

n If you select an alignment for which there is not enough media, 
Avid Xpress DV comes as close as it can to the alignment you requested.

6. Click Target Drive, and from the pop-up menu choose a drive on which 
to store the effect if you choose to render it.

The Effect Source Drive is the drive where the media on the outgoing 
shot of a transition resides.
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7. (Option) If you have IN and OUT points marked in your sequence, the 
Quick Transition dialog box contains a check box for Apply to All 
Transitions (IN -> OUT). Select this option to apply the same effect to 
all transitions between the IN and OUT points. Deselect this option to 
apply the effect only to the transition to which you have moved the 
position indicator.

8. Do one of the following:

t To add the effect without rendering it, click Add.

t To add the effect and render it, click Add and Render.

Avid Xpress DV adds the effect to the selected transition in the 
sequence, or, if you selected Apply to All Transitions (IN -> OUT), 
Avid Xpress DV adds the effect to all transitions between the IN and 
OUT points.

Applying Effects to Multiple Transitions Using the Quick Transition Button

You can select multiple transitions by marking IN and OUT points and 
then apply an effect from the Quick Transition dialog box to all the 
selected transitions at once.

To apply an effect to multiple transitions using the Quick Transition 
button:

1. Mark IN and OUT points around the transitions to which you want to 
add the effect.

2. Make sure that the Record Track buttons in the Track Selector panel 
are selected for the tracks to which you want to add the effect.

3. (Option) If you want to see a particular transition in the graphical 
display of the Quick Transition dialog box, move the position indicator 
to that transition.

n The graphical display in the Quick Transition dialog box always shows the 
transition closest to the position indicator. When you define an effect to 
apply to multiple transitions, the positioning details of any one transition 
might not be useful since you need to create an effect that will fit all the 
transitions. However, you might want to choose one transition as a model. 
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For example, you might use the transition with the least amount of handle 
as a model. If your effect fits that transition, it should fit all the others you 
have selected.

4. Click the Quick Transition button. 

The Quick Transition dialog box appears.

5. Choose a transition effect from the Add pop-up menu.

Apply to All Transitions 
check box
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For an explanation of individual effects shown in the menu, see “Blend 
Effects” on page 350.

n When you save a Dissolve effect template into a bin named Quick 
Transitions, the effect template appears in the Add pop-up menu. See 
“Using an Effect Template” on page 150.

n When you choose a color transition with Quick Transition, the default 
color is black. You must enter Effect mode to choose another color. For 
more information, see “Using the Effect Editor” on page 86.

6. Select the transition duration by doing one of the following:

t Type the duration in frames in the Duration text box.

t Click either the left or right edge of the Dissolve Effect icon and 
drag it to change the duration. For more information, see 
“Understanding the Graphical Display in the Quick Transition 
Dialog Box” on page 70.

The graphical display changes — the size of the effect icon gets 
smaller or larger, and the numbers in the Duration and Start text boxes 
change — to reflect the new duration.

7. Adjust the effect’s position relative to the cut point in one of the 
following ways:

t Choose an option from the Position pop-up menu to have the effect 
end at the cut point, center on the cut point, or start at the cut point.

t Choose Custom from the Position pop-up menu, and then type a 
number in the Start text box to specify how many frames before 
the cut point you want the effect to begin.
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n Avid Xpress DV automatically selects the Custom option in the Position 
pop-up menu when you click in the graphical display.

t Click inside the effect in the graphical display, and drag it to 
position the effect with respect to the cut point.

t Click one of the alignment buttons below the graphical display.

For more information on the graphical display options, see 
“Understanding the Graphical Display in the Quick Transition 
Dialog Box” on page 70.

Avid Xpress DV positions the effect, updates the graphical display to 
show the new position of the effect, and updates the value in the Start 
text box.

8. Click Target Drive, and from the pop-menu choose a drive on which to 
store the effect if you choose to render it.

The Effect Source Drive is the drive where the media on the outgoing 
shot of a transition resides.

9. Select Apply to All Transitions (IN -> OUT).

10. Do one of the following:

t To add the effect without rendering it, click Add.

t To add the effect and render it, click Add and Render.

Avid Xpress DV adds the selected effect to all the transitions between 
the marked IN and OUT points on the selected tracks in the sequence.

n If there is not enough incoming or outgoing media material to apply the 
effect to a transition, a dialog box appears. For more information, see 
“Sizing the Effect to Fit the Media” on page 74.

Understanding the Graphical Display in the Quick Transition Dialog Box

The graphical display of the transition effect that appears in the Quick 
Transition dialog box allows you to control the length and position of the 
effect with frame accuracy simply by dragging. Using the three alignment 
buttons, you can also quickly reset the position of the effect.
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Features of the Graphical Display

The following illustration shows the graphical display in the Quick 
Transition dialog box.

The graphical display shows the following:

• The outgoing (A) and incoming (B) media for the transition to which 
you are applying the effect. The amount of handle that is available for 
each piece of media is clearly indicated both as a darker area on the 
graphic itself and as a number of frames.

• The transition effect that you are applying. The display shows the 
effect icon and indicates the length and position of the effect in relation 
to the media.

• Three alignment buttons. These buttons appear when you choose 
Custom from the Position pop-up menu or click in the graphical 
display. They allow you to quickly reposition the effect so that it either 
ends at the cut point, is centered on the cut point, or starts at the cut 
point.

Avid Xpress DV draws and scales the graphical display so that it represents 
the relative size and position of the transition effect in relation to the 
media. For example, in the illustration above, the effect is 30 frames long 
while the incoming handle is 33 frames long. The effect is therefore shown 
slightly shorter than the incoming handle.

Outgoing media

Frames of 
incoming media 
available for the 
effect

Incoming media

Frames of 
outgoing media 
available for the 
effect

Transition effect Handle on outgoing media

Alignment buttonsHandle on incoming media
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Adjusting the Effect by Dragging

You can control the length or position of the transition effect by dragging 
in the graphical display.

To adjust the length of the effect:

1. Do one of the following:

t To adjust the length of the effect without changing its start point, 
move the pointer over the right edge of the effect.

t To adjust the length of the effect without changing its end point, 
move the pointer over the left edge of the effect.

The pointer changes to a resizing arrow.

2. Do one of the following:

t Drag away from the effect icon in the center to lengthen the effect.

t Drag toward the effect icon in the center to shorten the effect.

The graphical display and the Duration text box update to reflect your 
adjustment. If you are dragging the left edge of the effect, the Start text 
box also updates to reflect the changed start point.

To adjust the position of the effect:

1. Move the pointer inside the effect.

The pointer changes to a hand.

Resizing arrow
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2. Drag the effect to adjust its position with respect to the cut point.

The graphical display updates to show the new effect position, and the 
Start text box updates to show the new number of frames before the cut 
point.

n You cannot drag an effect beyond the ends of the handles on the media 
because Avid Xpress DV cannot create a transition unless both incoming 
and outgoing media are available for every frame of the transition. You 
also cannot drag an effect beyond the cut point.

Repositioning the Effect with the Alignment Buttons

You can use the alignment buttons to quickly reposition the effect so that it 
either ends at the cut, is centered on the cut, or starts at the cut. The buttons 
have the same effect as the Ending at Cut, Centered on Cut, and Starting at 
Cut commands in the Position pop-up menu.

To reposition the effect with an alignment button:

t Click one of the following buttons:

- Ending at Cut, to have the effect end at the cut point

- Centered on Cut, to center the effect on the cut point

- Starting at Cut, to have the effect begin at the cut point

Centered on Cut Starting at CutEnding at Cut
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Sizing the Effect to Fit the Media

When you select a transition effect from the Effect Palette and not enough 
source media exists to apply the effect, the Insufficient Source dialog box 
appears.

The dialog box shows a graphical display that indicates whether the source 
that has insufficient material is Media A (outgoing footage), Media B 
(incoming footage), or both. 

To automatically size the effect to fit the media:

t Click Size to Fit.

Avid Xpress DV sets the duration of the effect to fit the available media. If 
you have selected an alignment, Avid Xpress DV attempts to preserve it.

To change the alignment or duration of the transition effect, see “Creating a 
Dissolve in Trim Mode” on page 61.

n Although the graphical display in the Insufficient Source dialog box is 
similar to the graphical display in the Quick Transition dialog box, you 
cannot adjust an effect by dragging in the Insufficient Source dialog box.
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Trimming a Transition Effect

Avid Xpress DV lets you do the following:

• Trim a transition effect, using the standard transition trim procedures. 
For more information, see the chapter “Working in Trim Mode” in the 
user’s guide.

• Customize a transition effect, such as changing the fade color. For a 
description of how to change effect parameters, see Chapter 3.
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Chapter 3

Customizing Effects

After you have created an effect and have applied it to a transition or 
segment in your sequence, you can adjust its appearance and operation in a 
variety of ways. This chapter explains how to customize effects by using 
the Effect Editor and the Effect Preview monitor.

• Opening the Effect Editor

• Customizing the Effect Display

• Changing Position in an Effect

• Replacing an Effect in Effect Mode

• Using the Effect Editor

• Understanding Keyframes

• Using Standard Keyframes

• Working with Advanced Keyframes

• Manipulating Effects Directly

• Using an Effect Template
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Opening the Effect Editor

After you add an effect to a sequence, you must open the Effect Editor to 
change the parameters of the effect. When you open the Effect Editor, the 
Composer monitor becomes the Effect Preview monitor. 

To open the Effect Editor:

1. Move the position indicator to the effect’s icon in the Timeline.

2. Do one of the following:

t Choose Effect Editor from the Tools menu.

t Choose Effects Editing from the Toolset menu.

t Click the Effect Mode button in the Timeline toolbar.

The Effect Editor opens and displays the values for the current effect in 
the window. At the same time, the Composer monitor becomes the 
Effect Preview monitor.

Both the Effect Editor and the Effect Preview Monitor toolbar display 
buttons for controlling and adjusting the effect. For more information, 
see “Effect Editor Controls” on page 86 and “Understanding the Effect 
Preview Monitor” on page 79.

Effect Editor Effect Preview 
monitor

Timeline
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n If the Effect Editor is blank, click an effect icon in the Timeline and then 
click in the Effect Editor.

Customizing the Effect Display

You can adjust the appearance and function of various aspects of the Effect 
display by resizing windows and images, by displaying tracking 
information, or by displaying guidelines for the placement of effects and 
titles, as described in this section.

Understanding the Effect Preview Monitor

The Effect Preview monitor displays the selected effect in the sequence 
where the position indicator is located in the Timeline. The effect’s 
position bar, located directly below the Effect Preview monitor, represents 
only the selected effect, not the entire sequence.

Length of 
effect

Current position 
in effect

Tracking information

Effect’s position 
indicator (blue line)

Pop-up slider for 
expanding the 
position bar

Effect Preview 
monitor

Keyframe

Effect Preview Monitor 
toolbar

Effect’s 
position bar
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n If the effect you expect does not appear in the Effect Preview monitor, make 
sure that you have selected the Record Track Monitor button in the Track 
Selector panel. If a black frame appears in the Effect Preview monitor, the 
position indicator might be at a location in the Timeline where an effect 
has not been applied to the sequence.

Effect Preview Monitor Toolbar Buttons

The Effect Preview Monitor toolbar has buttons for controlling effect 
position and adjustment. Table 1 describes the buttons in the toolbar that 
you use to play and adjust the effect.

Table 1 Effect Preview Monitor Toolbar Buttons

Button Description

Rewind Places the position indicator at the first frame of the effect.

Fast Forward Places the position indicator at the last frame of the effect.

Add Keyframe Creates a keyframe at the current position of the position indicator 
in the effect’s position bar.

Alt+click (Windows) or Option+click (Macintosh) to delete the 
selected keyframe.

Step Backward Moves the position indicator one frame backward.

Step Forward Moves the position indicator one frame forward.

Play Plays the effect from the current position in the effect’s position 
bar. Click again or press the space bar to stop play.

Rendered effects play at full speed. Most unrendered effects play 
at full speed when Real-Time Effects is enabled. Effects play at 
single-frame rate in other circumstances. For more information, 
see “Real-Time Preview of Video Effects” on page 159.
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Understanding the Tracking Information

The two boxes above the Effect Preview monitor display the length of the 
effect in seconds and frames and the current position in the effect’s 
position bar. If you are working with two-field media, the current position 
display indicates the field that appears in the monitor. The current position 
display ends with .1 for the first field of a frame and with .2 for the second 
field. These boxes replace the name of the sequence that appears in this 
position in the Composer monitor.

Displaying the Safe Title and Safe Action Guidelines

Many effects can utilize the outer edges of the viewing screen area. If you 
are editing material that will be viewed on screens with more limited 
viewing areas, such as standard televisions, you can use the Safe Title and 
Safe Action options to provide visual guidelines in the Effect Preview 
monitor that replicate the actual viewable area on a standard television 
screen.

Play Preview Plays back a wire-frame preview of an unrendered effect.

Play Loop Plays back the current effect repeatedly in a loop. Click again or 
press the space bar to stop play.

Rendered effects play at full speed. Most unrendered effects play 
at full speed when Real-Time Effects is enabled. Effects play at 
single-frame rate in other circumstances. For more information, 
see “Real-Time Preview of Video Effects” on page 159.

Reduce Reduces the size of the image in the Effect Preview monitor.

Enlarge Enlarges the size of the image in the Effect Preview monitor.

Table 1 Effect Preview Monitor Toolbar Buttons (Continued)

Button Description
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For example, you can use the Safe Title option as a template for the area in 
which you want the effect to operate. In this way, you can avoid the 
appearance of the effect floating off into a nonviewable area of a standard 
television screen.

To display the Safe Title/Action guidelines in the Effect Preview 
monitor, do one of the following:

t Click the Grid button in the Tool palette.

For information on opening the Tool palette, see “Using the Tool 
Palette” in the chapter “Viewing and Marking Footage” in the user’s 
guide.

t Click the Grid button in the Effect Editor.

To open the Effect Editor, choose Effect Editor from the Tools menu.

Two outlined boxes appear in the Effect Preview monitor. The inner box is 
the safe title area. All text and objects should remain within the inner box. 
The outer box is the safe action area for video display.

Safe title area

Safe action area
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To display the safe title and safe action areas in the Source pop-up 
monitor:

t Click the Grid button in the Tool palette of the Source pop-up monitor.

n You can also display Safe Title/Action guidelines in the Title tool. For more 
information, see “Displaying Safe Title or Safe Action Guidelines” on 
page 247.

Moving an Enlarged Image in the Effect Preview Monitor

You can use the Enlarge and Reduce buttons in the Effect Preview Monitor 
toolbar to zoom in or out on an image in the Effect Preview monitor.

This allows you to view parts of an image in detail or to view parts of 
effects and effect controls that extend beyond the limits of the standard-
size image. For more information, see “Understanding the Effect Preview 
Monitor” on page 79.

When you use the Enlarge button to increase the size of the image in the 
Effect Preview monitor, you cannot view the entire frame all at once. When 
you are creating an effect that requires great detail, you can reposition the 
enlarged frame in the monitor to view the sections that need your attention.

n This feature applies only to an enlarged image in the Effect Preview 
monitor, not to a standard-size or reduced image.

To move an enlarged image within the Effect Preview monitor:

1. Click within the boundaries of the Effect Preview monitor.

2. Press and hold Ctrl+Alt (Windows) or k+Option (Macintosh).

The pointer changes to a hand.
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3. Drag the hand in any direction to reposition the image within the 
Effect Preview monitor.

Changing Position in an Effect

To change your position in an effect, do one of the following:

t Drag the position indicator in the effect’s position bar.

t Type the timecode in the same way you do when you are editing a 
sequence. For more information, see the chapter “Viewing and 
Marking Footage” in the user’s guide.

The type of timecode you enter (master timecode or absolute timecode) 
depends on the tracking information you are displaying. The position 
information boxes above the Effect Preview monitor update as you change 
position.

Pointer

Zoom ratio
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Replacing an Effect in Effect Mode

While in Effect mode, you can replace an existing effect.

To replace an effect:

1. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

The Effect Palette opens.

2. Click an effect category in the left side of the Effect Palette.

3. Do one of the following:

t Click the icon for the new effect in the right side of the Effect 
Palette, and drag the icon to the Timeline. To replace an existing 
effect, move the new effect’s icon on top of the existing effect’s 
icon.

t Click the icon for the new effect in the right side of the Effect 
Palette, and drag the icon to the Effect Preview monitor.

t Select the effect in the Timeline, and double-click the new effect’s 
icon in the Effect Palette.

4. Set the applicable effect parameters in the Effect Editor.

n Some effects cannot replace other effects. For example, some segment 
effects, such as the Mask effect, cannot replace transition effects. In 
addition, two-layer effects, such as wipes, cannot replace three-layer 
effects, such as matte keys.
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Using the Effect Editor

The Effect Editor contains buttons that provide controls for effect 
adjustment and parameter controls that allow you to set values to define the 
appearance of an effect. The following sections explain how to use Effect 
Editor buttons and parameter controls.

The Effect Preview Monitor toolbar also contains buttons that you use to 
adjust and preview effects. For more information, see “Effect Preview 
Monitor Toolbar Buttons” on page 80.

 When you are working with the Picture-in-Picture effect you can expand 
the Effect Editor to display keyframe graphs. You can then create and 
adjust independent keyframes for each keyframeable effect parameter. For 
more information, see “Working with Advanced Keyframes” on page 102.

Effect Editor Controls

This section describes the controls in the Effect Editor. Not all controls 
apply to each effect. If a control is not applicable, it does not appear in the 
Effect Editor for that effect.

The following illustration shows the location of controls within the Effect 
Editor. Table 2 describes each button in detail.
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Additional buttons appear in the bottom toolbar of the Effect Editor when 
you are working with keyframe graphs. For more information, see “Effect 
Editor Controls for Advanced Keyframes” on page 105.

Triangular opener

Other Options button

Transition Effect 
Duration box

Grid button

Outline/Path button

Render Effect button

Effect icon

Sliders used to 
adjust parameters

Effect name

Parameter 
category

Parameter name

Transition Effect 
Alignment button

Promote to Advanced 
Keyframes button

Play button

Play Loop button

Enlarge button

Reduce button

Dual Split button
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Table 2 Effect Editor Controls

Button Location Description

Triangular opener Left side of 
Effect Editor

Click to display or hide the parameter category. A 
downward-pointing triangle displays the parameter 
category; a right-pointing triangle displays only the 
parameter name.

Other Options Inside some 
parameter 
categories

Click to access additional parameters for some 
effects, including access to the Macintosh Color 
Picker or the Windows Color dialog box for color 
selection. For more information, see “Using the 
Other Options Button to Access Parameters” on 
page 94.

Render Effect Bottom of 
Effect Editor

Click to render the current effect.

Outline/Path Bottom of 
Effect Editor

Click to display a wire-frame path to illustrate the 
movement of an effect from the first keyframe 
through the last keyframe.

Transition Effect 
Alignment

Bottom of 
Effect Editor

Click to open a pop-up menu with options for 
selecting the alignment of a transition effect relative 
to the cut point.

Transition Effect 
Duration box

Bottom of 
Effect Editor

Click in this box to type a duration for the transition 
effect other than the duration displayed.

Promote to 
Advanced 
Keyframes button

Bottom of 
Effect Editor

Promotes a Picture-in-Picture effect to advanced 
keyframes. Not available for other effects. For more 
information, see “Promoting Effects to Advanced 
Keyframes” on page 103.

Reduce Right side of 
Effect Editor

Reduces the size of the image in the Effect Preview 
monitor.
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The Effect Preview Monitor toolbar also contains buttons that you use to 
adjust and preview effects. For more information, see “Understanding the 
Effect Preview Monitor” on page 79.

Enlarge Right side of 
Effect Editor

Enlarges the size of the image in the Effect Preview 
monitor.

Dual Split Right side of 
Effect Editor

Click to divide the Effect Preview monitor in half, 
showing the image with and without the effect 
applied. Click again to remove.

Play Loop Right side of 
Effect Editor

Plays back the current effect repeatedly in a loop. 
Click again or press the space bar to stop play.

Rendered effects play at full speed. Most unrendered 
effects play at full speed when Real-Time Effects is 
enabled. Effects play at single-frame rate in other 
circumstances. For more information, see “Real-
Time Preview of Video Effects” on page 159.

Play Right side of 
Effect Editor

Plays the effect from the current position in the 
effect’s position bar. Click again or press the space 
bar to stop play.

Rendered effects play at full speed. Most unrendered 
effects play at full speed when Real-Time Effects is 
enabled. Effects play at single-frame rate in other 
circumstances. For more information, see “Real-
Time Preview of Video Effects” on page 159.

Grid Right side of 
Effect Editor

Click to display the Safe Title and Safe Action 
guidelines.

Table 2 Effect Editor Controls (Continued)

Button Location Description
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Displaying an Effect’s Parameters in the Effect Editor

To display an effect’s parameters in the Effect Editor:

1. Move the position indicator to the effect’s icon in the Timeline.

2. Make sure that the Record Track button for the track that contains the 
effect is selected in the Track Selector panel.

3. (Option) If you are not already in Effect mode, choose Effect Editor 
from the Tools menu.

The Effect Editor opens.

The name of the effect and its icon appear at the top of the Effect 
Editor and the parameters that pertain to the effect appear in the Effect 
Editor.

This example shows the Grid effect parameters.

Slider used to adjust 
parameter

Parameter 
category

Effect name

Triangular opener

Effect iconOther Options button

Transition parameters
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Understanding Effect Parameters

Effect parameters are values that define the appearance of an effect. For 
example, you can set parameters that control the size and position of a 
Picture-in-Picture effect.

Not all effect parameters apply to all effects. Parameters that do not apply 
to an effect do not appear in the Effect Editor for that effect. To determine 
which parameters pertain to an effect, refer to the effect’s description in 
“2D Effects” on page 349.

n If the position indicator is not on an effect’s icon in the Timeline, or if the 
track that contains the effect is not selected, then the Effect Editor is blank.

Effect parameters are either global or keyframeable. You adjust a global 
parameter once for the entire effect; its values cannot change over time. 
You can adjust keyframeable parameters once for the entire effect, or you 
can use the Effect Editor along with keyframes to adjust the parameter 
multiple times and change its value over time. For more information, see 
“Global and Keyframeable Parameters” on page 319.

For most effects, a keyframe applies to every keyframeable effect 
parameter in the effect. If you are working with the Picture-in-Picture 
effect or 3D PIP effect, however, you can use keyframe graphs to create 
independent keyframes for each keyframeable effect parameter. This 
greatly increases your control of how the effect changes over time. For 
more information, see “Working with Advanced Keyframes” on page 102.

Parameter controls are grouped in parameter categories within the Effect 
Editor. For example, the Border parameter category includes all the 
controls that you can use to define the color and appearance of an effect 
border.

Several types of parameter controls might appear for a particular effect:

• Parameter sliders

• Parameter Enable buttons

• Parameter options that you select from Fast menus
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• Additional parameters that you access with the Other Options button

• Color parameters that you can select using the eyedropper, the 
Windows Color dialog box, or the Macintosh Color Picker as well as 
by using sliders

n For reference information on all effect parameters, see “2D Effects 
Parameters” on page 318.

Using Parameter Sliders

Parameter sliders allow you to adjust effect parameters that have a range of 
possible values. For example, use the Level slider in the Foreground 
parameter category to adjust the degree of opacity of the foreground 
material on a scale from 0 to 100.

The thumbwheel is a specialized slider that provides a window on a wide 
range of values and allows precise control over increments. 

The parameter’s numeric value changes as you move the slider.

To activate a parameter that has a slider:

t Click the slider.

When you activate a slider, it changes to pink.

To move from one slider to the next slider:

t Press the Tab key.

Parameter’s numeric value

Slider Thumbwheel

Parameter’s slider Parameter’s numeric valueActivated thumbwheel
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To change the value of a parameter that has a slider, do one or more 
of the following:

t Move the slider with the mouse.

t Type a new value using the numeric keypad, and, if you entered fewer 
than three digits, press Enter (Windows) or Return (Macintosh).

t Use the Left Arrow or Right Arrow key to change the value by –1 or 
+1.

t Press the Shift key and use the Left Arrow or Right Arrow key to 
change the value by –10 or +10.

Using Parameter Enable Buttons

Some parameter categories contain parameter Enable buttons. These 
buttons control parameters that can either be active or inactive but cannot 
be adjusted over a range of values. For example, the Fixed Aspect 
parameter Enable button controls whether the aspect ratio of an image is 
maintained when you adjust one of its dimensions.

To turn a parameter on or off by using a parameter Enable button:

t Click the Enable button.

Parameter Enable buttons are pink when the parameter is active and 
gray when the parameter is inactive.

Using Fast Menu Parameters

Some effects have additional parameters that you select from the current 
parameter’s Fast menu.

To select an additional parameter:

t Click the Fast Menu button in the parameter, and then choose an 
option.
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Using the Other Options Button to Access Parameters

Some effects have additional parameters that control their operation. For 
example, the Grid effect has additional parameters in which you set the 
number of columns and rows in the wipe. When an effect has additional 
parameters, the Other Options button appears next to the effect name or in 
a parameter category.

To use an effect’s additional parameters:

t Click the Other Options button next to the effect name or in a 
parameter category.

A dialog box appears in which you set the additional parameters.

n You also use the Other Options button to use the parameters for third-party 
plug-in effects, for the Windows Color dialog box or Macintosh Color 
Picker, to open a title edited into a sequence in the Title tool (when you 
want to revise that title), and for other effects that allow you to change 
color parameters.

Adjusting a Color Parameter

You can change a color parameter or select a key color by using the 
eyedropper or the Windows Color dialog box or Macintosh Color Picker 
instead of the Hue, Sat (saturation), and Lum (luminance) sliders.

Other Options button

Eyedropper

Color Preview window
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Using the Eyedropper

To select a color using the eyedropper:

1. Position the pointer over the Color Preview window to activate the 
eyedropper.

2. Click the eyedropper, drag it into the Effect Preview monitor, and 
release the mouse button on the color you want to select from the video 
image.

Avid Xpress DV updates the parameter’s numeric values, and the 
selected color appears in the Color Preview window.

Using the Windows Color Dialog Box

The Windows Color dialog box is a standard application that ships with the 
Windows operating system.

To open the Windows Color dialog box:

t Click the Other Options button in a color parameter pane.

The Windows Color dialog box appears.

Custom 
colors 
palette

Default 
choices Color slider

Color|Solid box Currently chosen color Color matrix

Color 
selection
text 
boxes
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To use the Windows Color dialog box:

1. To choose a color from the Basic colors palette, click the color you 
want.

2. To specify a custom color, do one of the following: 

t Click in the color matrix to choose a color, and then drag the color 
slider to adjust the amount of white and black in the color.

t Type numerical values for each color component in the color 
selection text boxes.

The new color is displayed on the left side of the Color|Solid box. The 
right side of this box displays the solid color closest to the color you 
have specified. You can choose the displayed solid color by double-
clicking the right side of the box.

3. When you are satisfied with the color, click Add to Custom Colors to 
add it to the Custom colors palette.

4. To choose a custom color from the Windows Color dialog box, click 
the color you want.

5. Click OK.

The Windows Color dialog box closes, and the color is applied to the 
parameter in the Effect Editor.

Using the Macintosh Color Picker

The Macintosh® Color Picker is a standard application that ships with 
Macintosh systems. Its appearance varies, depending on the current release 
of the Macintosh operating system. 

To open the Macintosh Color Picker:

t Click the Other Options button in a color parameter pane.

The Macintosh Color Picker dialog box appears.
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The Macintosh Color Picker provides several methods for specifying 
colors. Select the appropriate icon on the left side of the Color Picker 
dialog box to display the method you want. The preceding illustration 
shows the HSV (Hue, Saturation, Value) display. The following procedures 
explain how to use the HSV display. For information on how to use the 
other Macintosh Color Picker interfaces, see the documentation that ships 
with your Macintosh system.

To use the HSV color wheel:

1. Drag the crosshair color selector in the wheel to select a color.

Hue values change as you move in a circle around the wheel. 
Saturation values change as you move from the center of the wheel 
(minimum saturation) to the edge of the wheel (maximum saturation).

2. Drag the Value slider below the wheel to make colors brighter or 
darker.

To pick a color using the color selection text boxes:

t Type the values you want to use for Hue Angle, Saturation, and Value 
in the text boxes on the right side of the dialog box.

The color selector automatically changes position in the color wheel as 
you change values.



 Chapter 3 Customizing Effects

98

Understanding Keyframes

You use keyframes to change the appearance and behavior of an effect over 
time. A keyframe is a point in the effect at which you can set parameters. 
Modifying an effect’s parameters at various points causes the effect’s 
appearance to vary as it plays. For example, you can add keyframes to a 
Picture-in-Picture effect and change the position parameters for each 
keyframe to add movement to the effect. 

Keyframe indicators appear as triangles in the position bar of the Effect 
Preview monitor when you select an effect and the Effect Editor is active. 
You adjust keyframe parameters by using the Effect Editor.

For the Picture-in-Picture effect, you can increase your control of the way 
effect parameters change over time by using advanced keyframes. With this 
capability, each keyframeable effect parameter has a separate Timeline 
track — a keyframe track that opens to display a keyframe graph — where 
you set and customize keyframes that are independent of other parameters’ 
keyframes. For more information, see “Working with Advanced 
Keyframes” on page 102.

n You can still select standard keyframes, in which each keyframe affects all 
parameters. You can also use advanced keyframes as if they were standard 
keyframes.

Starting keyframe Ending keyframeSelected keyframe (pink)Add Keyframe button
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Using Standard Keyframes

With standard keyframes, Avid Xpress DV always provides the starting 
and ending keyframes of an effect. These keyframes are selected by 
default, and thus any parameter changes are constant throughout the effect. 
By using techniques for adding, deleting, moving, selecting, and 
deselecting keyframes, you can begin to change the appearance and 
operation of the effect over time by applying parameter changes to specific 
keyframes.

Adding a Standard Keyframe

You can create a standard keyframe at any point in the effect’s position bar.

To create a standard keyframe:

1. Click in the position bar below the Effect Preview monitor at the point 
in the effect where you want to add the keyframe. 

The position indicator moves to that frame.

2. Do one of the following to add a keyframe:

t Click the Add Keyframe button either in the Effect Preview 
Monitor toolbar or in the Tool palette.

For information on opening the Tool palette, see “Using the Tool 
Palette” in the chapter “Viewing and Marking Footage” in the 
user’s guide.

t Manually adjust a parameter in the Effect Preview monitor 
(segment effects only). For example, when you click a handle on 
an effect outline and drag to resize or reposition it, the system 
automatically creates a new keyframe.
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Selecting a Standard Keyframe

You can select a single standard keyframe or multiple standard keyframes 
at the same time. A keyframe indicator changes to pink when selected.

To select one keyframe:

t Click the keyframe indicator in the position bar below the Effect 
Preview monitor.

To select multiple keyframes:

t Shift+click the keyframe indicators that you want in the effect’s 
position bar.

To select all keyframes in the effect’s position bar, do one of the 
following:

t Press Ctrl+A (Windows) or k+A (Macintosh).

t Press and hold Ctrl+Alt (Windows) or the k key (Macintosh), and 
click one keyframe indicator.

n For a quick way to jump to the next or previous keyframe indicator, use the 
Fast Forward and Rewind buttons on the Effect Preview Monitor toolbar.

Moving a Standard Keyframe

After you have created a standard keyframe, you can move it to another 
position in the position bar below the Effect Preview monitor.

n With standard keyframes, you cannot move the starting and ending 
keyframes.

To move a standard keyframe, do one of the following:

t Alt+click (Windows) or Option+click (Macintosh) the keyframe 
indicator, and drag it to its new position.

t Select a keyframe indicator, and click the Trim Left 1 Frame or Trim 
Right 1 Frame button or the Trim Left 10 Frames or Trim Right 10 
Frames button.



Using Standard Keyframes

101

Changing a Standard Keyframe’s Parameters

When you work with standard keyframes, with certain parameter 
categories, such as Acceleration, you adjust parameters globally (over all 
keyframes in the effect). You can also change many parameters for 
individual standard keyframes. For information on the scope of 
adjustments (global or keyframeable) for each parameter category, see “2D 
Effects Parameters” on page 318.

To change a standard keyframe’s parameters:

1. Click the keyframe indicator in the position bar below the Effect 
Preview monitor. 

The keyframe indicator changes to pink when selected.

2. Adjust any of the applicable parameters in the Effect Editor.

Copying and Pasting Standard Keyframe Parameters

You can copy and paste parameters from one standard keyframe and apply 
them to another standard keyframe. You can also copy keyframe 
parameters from one effect to another effect.

To copy and paste standard keyframe parameters:

1. Click one keyframe indicator in the position bar below the Effect 
Preview monitor whose parameters you want to copy.

2. Choose Copy from the Edit menu.

3. Select one or more standard keyframes: 

t To copy the parameters to one keyframe, click the keyframe 
indicator.

t To copy the parameters to multiple keyframes, Ctrl+click 
(Windows) or Shift+click (Macintosh) multiple keyframe 
indicators.

t To copy the parameters to all keyframes, choose Select All from 
the Edit menu.
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4. Choose Paste from the Edit menu.

The parameters that you copied from one standard keyframe are pasted 
to the keyframe, or frames, you selected.

Deleting a Standard Keyframe

You can delete any standard keyframe you create. You cannot delete the 
starting and ending keyframes Avid Xpress DV creates.

To delete a standard keyframe:

1. Click the keyframe indicator in the position bar below the Effect 
Preview monitor. 

The keyframe indicator changes to pink when selected.

2. Do one of the following:

t Press the Delete key.

t Alt+click (Windows) or Option+click (Macintosh) the Add 
Keyframe button.

Working with Advanced Keyframes

With standard keyframes, every keyframe affects every parameter. This 
section describes how to use advanced keyframes, where a separate 
Timeline track — a keyframe track — appears in the Effect Editor for each 
keyframeable parameter in an effect.

The keyframe track opens to display a keyframe graph. When you work 
with effects that have advanced keyframes, you customize a parameter’s 
actions using keyframes in the keyframe track, and each parameter’s 
keyframes are independent of any other parameter’s keyframes.

 In Avid Xpress DV, advanced keyframes are available for the Picture-in-
Picture (PIP) effect.
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You do not have to use advanced keyframes in the Effect Editor. You can 
work using standard keyframes, in which each keyframe affects all 
parameters. In addition, advanced keyframe functions are available even 
when a keyframe graph is closed to show only the keyframe track.

Using advanced keyframes, you can change the order of nested effects by 
manipulating the Nesting Priority icons that appear in the Effect Editor. 
See “Changing the Order of Nested Effects” on page 228.

The following sections describe using advanced keyframes.

Promoting Effects to Advanced Keyframes

You can promote a Picture-in-Picture effect to advanced keyframes.

You can choose whether or not a newly promoted effect first appears with 
no keyframes or with two keyframes, one at the start and one at the end of 
each parameter. You set this option in the Effect Editor entry of the 
Settings scroll list. For more information, see “Options for Using 
Advanced Keyframes” on page 143.

Once you promote an effect to advanced keyframes, the Acceleration 
parameter category no longer appears. You manipulate acceleration 
(ease-in and ease-out) of the effect by using the spline or Bézier 
interpolation options, which give you more control than the standard 
Acceleration parameter category. See “Parameter Changes at Keyframes” 
on page 124.

To promote a Picture-in-Picture effect to advanced keyframes:

t Click the Promote to Advanced Keyframes button on the Effect Editor 
toolbar.

The Effect Editor displays the effect with keyframe graphs as a 
Picture-in-Picture v2 effect.
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Opening Keyframe Tracks

Effects using advanced keyframes appear with keyframe tracks at the right 
side of the Effect Editor. Next to each keyframe track is a triangular 
opener. The parameter group name appears in a title track at the top of the 
keyframe tracks.

n You do not have to open a keyframe track to set and manipulate keyframes. 
You can add and delete keyframes, customize keyframe interpolation 
options, and use the standard controls for each parameter to set the values 
for its keyframes, while a keyframe track is closed.

To open a keyframe track and display the keyframe graph:

t Click the triangular opener.

The keyframe track opens into a keyframe graph.

Triangular openers for 
keyframe graphs

Parameter group 
title trackKeyframe track (closed)

Keyframe graph (open)

Keyframe graph open

Start of effect End of effect

Maximum parameter value

Minimum parameter value
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Depending on how you have the keyframe graph zoomed and scaled, the 
lines representing the keyframe graph boundaries — start and end of effect, 
maximum and minimum parameter values — might not be visible. See 
“Adjusting the View in Keyframe Graphs” on page 139.

Effect Editor Controls for Advanced Keyframes

You use the Effect Editor toolbar and the keyframe graph shortcut menu to 
create, delete, and customize advanced keyframes.

Table 3 describes the components of the Effect Editor toolbar for advanced 
keyframes.

Effect Editor buttons — see “Effect 
Editor Controls” on page 86.

Zoom slider Scroll thumbwheel Scale bar

Table 3 Effect Editor Toolbar for Advanced Keyframes

Control Description

Rewind Moves the position indicator one keyframe to the left and activates the 
keyframe. If there is no keyframe to the left, the position indicator does not 
move.

Fast Forward Moves the position indicator one keyframe to the right and activates the 
keyframe. If there is no keyframe to the right, the position indicator does not 
move.

Add Keyframe Creates a keyframe at the current position. Alt+click (Windows) or 
Option+click (Macintosh) this button to delete a keyframe. When you add or 
delete a keyframe, a pop-up menu gives you additional selections. See “Adding 
and Deleting Keyframes in Keyframe Graphs” on page 107.

Use the zoom slider in the scale bar, and the adjacent scroll thumbwheel, to 
zoom and scroll the view in the keyframe graph. See “Adjusting the View in 
Keyframe Graphs” on page 139.

Zoom slider
Scroll thumbwheel
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In addition to the controls in Table 3, a Nesting Priority icon appears in line 
with the effect name at the top of the Effect Editor. For more information, 
see “Changing the Order of Nested Effects” on page 228.

Other controls appear in a pop-up menu when you click the Add Keyframe 
button, and in the shortcut menu that appears when you right-click 
(Windows) or Ctrl+Shift+click (Macintosh) a keyframe graph or keyframe 
track. The following sections describe the menu selections.

Shortcut Menus for Advanced Keyframes

Advanced keyframes use two shortcut menus. You invoke the keyframe 
graph shortcut menu from the area of the Effect Editor that displays 
keyframe graphs. You invoke the Effect Editor shortcut menu from the part 
of the Effect Editor that does not display the keyframe graphs. For more 
information, see “Options for Using Advanced Keyframes” on page 143.

To display the shortcut menu for a keyframe graph:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) a keyframe 
graph or keyframe track.

Table 4 describes the options available with the keyframe graph shortcut 
menu.

Table 4 Keyframe Graph Shortcut Menu Options

Option Description

Add Keyframe Adds a keyframe at the position indicator. See “Adding and Deleting Keyframes in 
Keyframe Graphs” on page 107.

Delete Keyframe Deletes the selected keyframe. See “Adding and Deleting Keyframes in Keyframe 
Graphs” on page 107.

Select All Keyframes Selects all keyframes in the section of the editor where you click to bring up the 
shortcut menu. See “Selecting and Deselecting Advanced Keyframes” on page 120.



Working with Advanced Keyframes

107

Adding and Deleting Keyframes in Keyframe Graphs

You can add a keyframe using the Add Keyframe button on the Effect 
Editor toolbar, or you can use the keyframe graph shortcut menu. The first 
panel of the shortcut menu has commands for adding and deleting 
keyframes.

Align Keyframes Moves the selected keyframe in one or more keyframe graphs to the position 
indicator, depending on which keyframes you select and on where you click to bring 
up the shortcut menu. See “Align Keyframes and Slip Keyframes” on page 131.

Slip Keyframes Moves all the keyframes of the parameter so the active keyframe aligns with the 
position indicator, and the rest of the keyframes maintain their relative location. See 
“Align Keyframes and Slip Keyframes” on page 131.

Shelf
Linear
Spline
Bézier

The keyframe interpolation options set the way parameter changes occur at 
keyframes. See “Parameter Changes at Keyframes” on page 124.

Fixed Keyframes
Elastic Keyframes

Sets how the system moves keyframes when an effect is trimmed in or trimmed out. 
Elastic keyframes change the time at which they occur when you trim an effect, in 
proportion to the new effect length. Fixed keyframes do not change. See “Elastic 
Keyframes and Fixed Keyframes” on page 122.

Extrapolate
Hold

Determines how the system sets parameter values before the first keyframe and after 
the last keyframe. See “Extrapolate and Hold” on page 136.

Reset Graph View Vertically recenters the graph view. See “Resetting Keyframe Graph Views” on 
page 143.

Table 4 Keyframe Graph Shortcut Menu Options (Continued)

Option Description
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To add a keyframe to the active parameter:

1. Move the position indicator to the point where you want to add a 
keyframe.

2. Right-click (Windows) or Ctrl+Shift+click (Macintosh) the keyframe 
graph or keyframe track, and choose Add Keyframe from the shortcut 
menu.

An active keyframe indicator appears at the position indicator.

To add a keyframe to a keyframe graph using the Add Keyframe 
button:

1. Move the position indicator to the point where you want to add a 
keyframe.

2. Click the Add Keyframe button on the Effect Editor toolbar.

The Add Keyframe Mode menu appears.

n If the Add Keyframe Mode menu does not appear, it is deselected on the 
Effect Editor shortcut menu. For more information, see “Options for Using 
Advanced Keyframes” on page 143.

For more information on the command selections, see “Using the Add 
Keyframe Mode Menu and the Delete Keyframe Mode Menu” on 
page 110.
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3. Click the Add Keyframe button a second time to choose the command 
that has a check mark next to it, or choose another command from the 
Add Keyframe Mode menu.

An active keyframe indicator appears at the position indicator. If you 
chose a command that results in multiple keyframes, other keyframe 
indicators appear at the proper places.

If you changed the command, the Delete Keyframe mode also changes.

n You can set a default command using the Effect Editor shortcut menu. For 
more information, see “Options for Using Advanced Keyframes” on 
page 143.

To delete a keyframe from a keyframe graph:

1. Click a keyframe indicator to activate it.

2. Do one of the following:

t Press the Delete key.

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the 
keyframe graph or keyframe track, and choose Delete Keyframe 
from the keyframe graph shortcut menu.

t Alt+click (Windows) or Option+click (Macintosh) the Add 
Keyframe button on the Effect Editor toolbar.

The Delete Keyframe Mode menu appears. For more information 
on the commands, see “Using the Add Keyframe Mode Menu and 
the Delete Keyframe Mode Menu” on page 110.

If you select a new command from the Delete Keyframe Mode 
menu, the Add Keyframe mode also changes.

n If the Delete Keyframe Mode menu does not appear, Show Add Keyframe 
Mode Menu is deselected on the Effect Editor shortcut menu. For more 
information, see “Options for Using Advanced Keyframes” on page 143.
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Using the Add Keyframe Mode Menu and the Delete Keyframe 
Mode Menu

Before you begin adding keyframes, it is important to understand the terms 
your Avid system uses to refer to parameters and parameter groups. These 
terms are on the menu that appears when you add or delete a keyframe 
using the Add Keyframe button on the Effect Editor toolbar.

n If the Add Keyframe Mode menu or the Delete Keyframe Mode menu does 
not appear, it is deselected on the Effect Editor shortcut menu. For more 
information, see “Options for Using Advanced Keyframes” on page 143.

n You can set a default command using the Effect Editor shortcut menu. For 
more information, see “Options for Using Advanced Keyframes” on 
page 143.

n The selection you make for the Add Keyframe mode is mirrored in the 
Delete Keyframe Mode menu, and vice versa. That is, when you change 
one, you change both.
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In the following descriptions, group refers to the parameter category. Each 
description first defines the term that appears in the Add Keyframe Mode 
menu and the Delete Keyframe Mode menu and then illustrates the result 
of using that command when adding or deleting a keyframe.

Parameter group 
(parameter category)
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• Active Parameter — The parameter that is currently active. For 
example, a slider that you clicked is pink.

Add To Active Parameter — The keyframe appears in the keyframe 
track or keyframe graph for the active parameter only.

Delete From Active Parameter — The system removes selected 
keyframes in the keyframe track or keyframe graph for the active 
parameter only.

Active parameter 
(pink)
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• Active Group — The group to which the active parameter belongs.

Add To Active Group — Keyframes appear in the keyframe tracks or 
keyframe graphs of all parameters that are in the same group as the 
active parameter. If the active group is part of a larger group (for 
example, Color is a subgroup or subcategory of Border), keyframes 
appear only in the active group and not in the larger group. 

Delete From Active Group — The system deletes selected keyframes 
from the keyframe tracks or keyframe graphs of all parameters that are 
in the same group as the active parameter.

Active parameter (pink)

Active group 
(contains active 
parameter)
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The following illustration is an example of selecting Add To Active Group.

Active parameter (pink)

New keyframes 
added to active 
group only
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• Open Groups — Groups that you opened by clicking the triangular 
opener next to the group name.

Add To Open Groups — Keyframes appear in the keyframe tracks or 
keyframe graphs of all parameters in groups that are currently open.

Delete From Open Groups — The system deletes selected keyframes 
from keyframe tracks or keyframe graphs of all parameters in groups 
that are currently open.

Open group

Open group

Open group
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The following illustration is an example of selecting Add To Open Groups.

• Enabled Groups — Avid Xpress DV does not use enabled groups. The 
system treats all groups as enabled at all times.

Add To Enabled Groups — Keyframes appear in all keyframe tracks. 
This is the same as Add To All Parameters.

Delete From Enabled Groups — The system deletes selected 
keyframes from all keyframe tracks. This is the same as Delete From 
All Parameters.

Open group

Open group

Open group

Add To Open Groups: 
New keyframes added to 
all open groups, even if 
the keyframe tracks are 
closed.



Working with Advanced Keyframes

117

• Open Graphs — Keyframe tracks that you opened by clicking the 
triangular opener next to the keyframe track.

Add To Open Graphs — Keyframes appear in the keyframe graphs of 
all parameters with open graphs.

Delete From Open Graphs — The system deletes selected keyframes 
from the keyframe graphs of all parameters with open graphs.

• All Parameters — Every parameter represented in the Effect Editor 
that has a keyframe track and is therefore keyframeable.

Add To All Parameters — Keyframes appear in all keyframe tracks.

Delete From All Parameters — The system deletes selected keyframes 
from all keyframe tracks.

Open graph

Open graph

Open graph
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Moving Keyframes in Keyframe Graphs

Once you create an advanced keyframe, you can move it to another 
location in the keyframe graph. The methods described here use the mouse 
to move a keyframe. You can also use commands on the keyframe graph 
shortcut menu. For more information, see “Align Keyframes and Slip 
Keyframes” on page 131.

To move a keyframe vertically, changing its value:

t With the keyframe graph open, click the keyframe indicator, and drag 
it to its new position.

The time at which the keyframe occurs does not change.

To move a keyframe horizontally, changing its time, do one of the 
following:

t With the keyframe graph open, Alt+Shift+click (Windows) or 
Option+Shift+click (Macintosh) the keyframe indicator, and drag it to 
its new position.

When you move a keyframe with the keyframe graph open, the Shift 
key constrains the movement to the horizontal (time) axis.

t With the keyframe graph closed, Alt+click (Windows) or Option+click 
(Macintosh) the keyframe indicator, and drag it to its new position.

n Alternatively, you can select keyframes and click the Trim Left 1 Frame and 
Trim Right 1 Frame buttons or the Trim Left 10 Frames and Trim Right 10 
Frames buttons.

The keyframe’s value does not change.

To move a keyframe in any direction:

t With the keyframe graph open, Alt+click (Windows) or Option+click 
(Macintosh) the keyframe indicator, and drag it to its new position. 

You can change both the keyframe’s value and the time at which the 
keyframe occurs.
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n You cannot move a keyframe past another keyframe. That is, keyframe 
movement is bounded by neighboring keyframes.

You can use these methods to move a keyframe outside the time 
boundaries of the keyframe graph. That is, you can make the effect behave 
as if parameter values are changing before the beginning or after the end of 
the effect. This works only for the time at which a keyframe occurs. You 
cannot set a keyframe value outside the maximum or minimum value for 
the parameter.

The following illustration shows an example of moving a keyframe before 
the beginning of an effect.

You can also move keyframes outside the time boundaries using Align 
Keyframes and Slip Keyframes. See “Align Keyframes and Slip 
Keyframes” on page 131.

Copying and Pasting Advanced Keyframe Parameters

You can copy and paste parameters from one advanced keyframe and apply 
them to another advanced keyframe. You can also copy advanced keyframe 
parameters from one effect to another effect.

To copy and paste advanced keyframe parameters:

1. Click one keyframe indicator in the parameter’s keyframe graph whose 
parameters you want to copy.

2. Choose Copy from the Edit menu.

Start of effect End of effect Keyframe moved before beginning of effect

Before After

Line representing 
maximum 
parameter value
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3. Select one or more keyframes:

t To copy the parameters to one keyframe, click the keyframe 
indicator.

t To copy the parameters to multiple frames, Ctrl+click (Windows) 
or Shift+click (Macintosh) multiple keyframe indicators.

t To copy the parameters to all keyframes, choose Select All from 
the Edit menu.

4. Choose Paste from the Edit menu.

The parameters that you copied from one keyframe are pasted to the 
keyframes you selected.

Selecting and Deselecting Advanced Keyframes

A keyframe graph does not have to be open when you select a keyframe. 
You can select keyframes in closed keyframe graphs.

To select a keyframe:

t Click the keyframe indicator.

The keyframe indicator changes to pink (activated).

When you select more than one keyframe in a single keyframe track, the 
system uses the most recently selected one as the reference keyframe for 
aligning and slipping keyframes. In addition, there are special 
considerations when you align keyframes in a track with both selected 
keyframes and deselected keyframes. See “Aligning Keyframes” on 
page 132.

To select more than one keyframe in a keyframe track:

1. Click the first keyframe indicator that you want to select.

The keyframe indicator changes to pink (activated).

2. Press and hold the Shift key, and click each additional keyframe 
indicator.

Each keyframe changes to pink (activated).
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To select keyframes in more than one keyframe track:

1. Click the first keyframe indicator that you want to select.

The keyframe indicator changes to pink (activated).

2. In each keyframe track that you want to add to your selection, click the 
keyframe indicator.

3. (Option) If you want to select multiple keyframes in a keyframe track, 
Shift+click each additional keyframe indicator.

To select all keyframes in a keyframe track:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) a keyframe 
track, and choose Select All Keyframes from the shortcut menu.

To select all keyframes in a parameter group:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the parameter 
group title track, and choose Select All Keyframes from the shortcut 
menu.

To select all keyframes in the effect:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the effect title 
track, and choose Select All Keyframes from the shortcut menu.

To deselect a keyframe:

t Shift+click the keyframe indicator.

Occasionally, you might want to deselect all but one keyframe in a 
keyframe graph.

To deselect all keyframes but one in a track:

t Click the keyframe indicator of the keyframe you want to remain 
selected.

The keyframe indicator changes to pink (activated). All other 
keyframes in the track appear gray and are deselected.
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Elastic Keyframes and Fixed Keyframes

With standard keyframes, all keyframes are elastic. When you trim an 
effect, the Avid system scales the keyframes to fit the new duration. For 
example, suppose you want to have a PIP effect appear, be visible for 16 
frames, and then pop off the screen. If the original clip is 2 seconds long 
and you trim out the clip to 3 seconds, each event takes proportionally 
longer. After the trim, the PIP effect remains visible for 24 frames.

Same clip trimmed out to add 1 second at the head: 
time between keyframes stretches.

New material

01:00 01:27 02:21 03:29

2-second clip with elastic keyframes

02:00 02:18 03:04 03:29

Source Timecode 
Before Trim Event

Source Timecode 
After Trim

02:00 Start of clip 01:00

02:18 PIP effect on 01:27

3:04 PIP effect off 2:21

3:29 End of clip 3:29
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With fixed keyframes, when you trim out a clip, your Avid system extends 
the first or last keyframe by duplicating parameters in the trimmed-out 
area. When you trim out a clip, the keyframes remain fixed at their original 
timecodes. Fixed keyframes allow you to “pin” a parameter change to a 
particular timecode. Using the previous example, if before the trim the PIP 
appears for 16 frames at 02:18, after the trim the PIP appears for 16 frames 
at 02:18.

2-second clip with fixed keyframes

Same clip trimmed out to add 1 second at the head: 
timing of events does not change.

New material

01:00 02:00 02:18 03:04 03:29

02:00 02:18 03:04 03:29

Source Timecode 
Before Trim Event

Source Timecode 
After Trim

02:00 Start of clip 01:00

02:18 PIP effect on 02:18

3:04 PIP effect off 3:04

3:29 End of clip 3:29
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Effect parameters default to elastic keyframes. You choose elastic 
keyframes or fixed keyframes from the shortcut menu for a parameter.

n You can select elastic keyframes or fixed keyframes for each parameter of 
an effect. That is, some parameters can have elastic keyframes and other 
parameters can have fixed keyframes.

n All keyframes for a parameter are either elastic or fixed. You cannot mix 
elastic keyframes and fixed keyframes within a single parameter.

To choose elastic keyframes or fixed keyframes for a parameter:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the keyframe 
graph or keyframe track for the parameter with which you are working, 
and choose Fixed or Elastic from the shortcut menu.

The keyframes for the parameter change to the selected keyframe type 
and the keyframe indicators for the parameter display the selected 
keyframe type. 

All subsequent keyframes you add to this parameter appear as the 
selected keyframe type.

To choose elastic keyframes or fixed keyframes for a parameter 
group:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the parameter 
group title track, and choose Fixed or Elastic from the shortcut menu.

The keyframes for all parameters in the parameter group change to the 
selected keyframe type. The keyframe indicators display the selected 
keyframe type. 

All subsequent keyframes you add to this parameter group appear as 
the selected keyframe type.

Parameter Changes at Keyframes

How an effect parameter changes at a keyframe is governed by which 
keyframe interpolation option you select. Interpolation refers to the 
method your system uses to calculate the rate of change and the relative 
smoothness of change.
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To select an interpolation option:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the keyframe 
graph or keyframe track for the parameter with which you are working, 
and choose one of the following from the shortcut menu:

- Shelf

- Linear

- Spline

- Bézier

Each option is described in the following section.

Options for Controlling Parameter Changes at Keyframes

You can select from the following options for controlling parameter 
changes at keyframes:

• Shelf — The parameter value does not change between keyframes and 
then changes abruptly to the new value. Some applications call this 
Hold.

Use Shelf to hold a parameter value for a fixed length of time. For 
example, you can use Shelf with the Position parameters to create a 
PIP that appears to “pop” to a new location at each keyframe.

• Linear — The parameter value ramps smoothly between keyframes 
but then changes abruptly at each keyframe. The change in parameter 
value at a keyframe happens with no ease-in or ease-out.
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Effects with standard keyframes make linear parameter changes (with 
the exception of Spline for motion paths and Acceleration for other 
parameters). With advanced keyframes, you can use the Linear 
interpolation option for some parameters and not for others, depending 
on the effect you want to achieve.

• Spline — The parameter value changes smoothly at each keyframe, 
creating a simple ease-in or ease-out effect. Spline is sometimes called 
Natural Spline or Cardinal Spline because the line representing the 
parameter value always goes precisely through each keyframe.

Using the Linear interpolation option, the PIP effect 
moves across the image for the entire effect.

Using the Shelf interpolation option, the PIP effect 
“pops” to a new location at each keyframe.

Position

Position

X

Y

X

Y
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With two keyframes, the system changes the parameter value slowly at 
the beginning of the effect, speeds up the rate of change, and then 
slows down to come to rest gently at the end of the effect. Use three 
keyframes to create an arc.

Use the Spline interpolation option (or the Bézier interpolation option) 
for any parameter for which you want to avoid abrupt changes, such as 
Scaling or Border width.

• Bézier — The Bézier interpolation option is similar to the Spline 
interpolation option, in that the parameter value changes smoothly at 
each keyframe. In addition, the Bézier interpolation option provides 
direction handles at each keyframe. You adjust the rate at which the 
parameter value changes by manipulating the direction handles.

Active keyframe

Direction handles

Active keyframe detail

Direction bar

Direction handles
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When you click a direction handle and drag it, you change the height 
and angle of the curve. The curve responds as if you were gently 
tugging it like a piece of string. The curve remains anchored to the 
keyframes on either side of the active keyframe.

Use the Bézier interpolation option (or the Spline interpolation option) 
for any parameter for which you want to avoid abrupt changes.

n You can use the Bézier interpolation option to create abrupt changes. 
“Break” the direction handles using modifier keys and adjust each side of 
the curve independently. For more information, see “Adjusting Parameter 
Values with the Bézier Interpolation Option” on page 128.

You can adjust Bézier curves in three distinct ways, as described in the 
following section.

Adjusting Parameter Values with the Bézier Interpolation Option

You can adjust Bézier curves in the following ways:

• Symmetrically — Dragging a direction handle changes the length and 
rotation of both direction handles symmetrically.

• Asymmetrically — Dragging a direction handle changes the length of 
the selected handle, but not the opposite handle. The rotation of both 
handles changes as you drag the selected handle.

Adjusting Bézier curves symmetrically

Before After
Dragging the left handle 
up and to the left causes 
both sides to rotate and 
increase in length.
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• Independently — Dragging a direction handle changes both the 
length and rotation of the selected handle. The opposite handle does 
not change. You do this by “breaking” the handle.

The default adjustment method is symmetrical. You change the adjustment 
method using the Alt key (Windows) or Option key (Macintosh).

Adjusting Bézier curves asymmetrically

Before After
Dragging the left handle 
up and to the left causes 
the left side to rotate and 
increase in length. The 
right side rotates but 
does not change in 
length.

Adjusting Bézier curves independently

Before

After dragging and rotating

Dragging the left handle 
up and to the left causes 
only the left side to rotate 
and increase in length. 
The right side does not 
change.

After dragging (no rotation)

Dragging the left handle 
to the left causes only the 
left side to increase in 
length. The right side 
does not change.
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To use the Bézier interpolation option for adjusting a parameter 
value:

1. Select the Bézier interpolation option. 

For more information, see “Parameter Changes at Keyframes” on 
page 124.

2. Click a keyframe indicator to activate it.

The keyframe indicator changes to pink, and a direction bar with 
direction handles appears.

3. Position the pointer over one of the direction handles.

The pointer changes to a hand pointer.

4. (Option) Alt+click (Windows) or Option+click (Macintosh) the 
direction handle to select an adjustment method.

Each time you do, the adjustment method cycles to the next adjustment 
method: symmetrical, asymmetrical, or independent.

5. Drag the mouse to move the direction handle.

The direction bar and the curve change to show the new interpolation 
motion.

6. Continue adjusting the direction handles to achieve the effect you 
want.

n When you make an adjustment to a direction handle, the system remembers 
which adjustment method you used. If you do not want to change the 
adjustment method, do not Alt+click (Windows) or Option+click 
(Macintosh) the direction handle before making another adjustment to the 
same handle. Instead, just click the direction handle, and drag it to its new 
location.

Changing the Adjustment Method for the Bézier Interpolation Option

To change the adjustment method for the Bézier interpolation option:

t Alt+click (Windows) or Option+click (Macintosh) the direction 
handle.

Each time you do, the adjustment method cycles to the next adjustment 
method: symmetrical, asymmetrical, and independent.
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For example, suppose you make an adjustment using independent direction 
handles, and then move the cursor away from the keyframe. To continue 
using independent direction handles, click the direction handle and make 
further adjustments. To change the adjustment method from independent to 
symmetrical, Alt+click (Windows) or Option+click (Macintosh) the 
direction handle.

Align Keyframes and Slip Keyframes

Align Keyframes and Slip Keyframes give you another way to adjust the 
position of advanced keyframes.

• Align Keyframes moves the selected keyframe to the position 
indicator. The other keyframes in the keyframe track do not move.

• Slip Keyframes moves all the keyframes of the parameter so the active 
keyframe aligns with the position indicator, and the rest of the 
keyframes maintain their relative location.

You do not have to select a keyframe from an open keyframe graph to use 
Align Keyframes and Slip Keyframes. You can select keyframes in any 
keyframe track.

n Disabling Set Position To Keyframe can make it easier for you to use Align 
Keyframes and Slip Keyframes. See “Options for Using Advanced 
Keyframes” on page 143.

You can use Align Keyframes and Slip Keyframes within a single 
keyframe track, by selecting a single active keyframe. You can also use 
Align Keyframes and Slip Keyframes to bring several parameters into 
alignment, by selecting an active keyframe in more than one parameter and 
then choosing where you invoke the shortcut menu. See “Selecting and 
Deselecting Advanced Keyframes” on page 120.

When you select more than one keyframe in a single keyframe track, the 
system uses the most recently selected one as the reference keyframe for 
aligning and slipping keyframes. In addition, there are special 
considerations when you align keyframes in a track with both selected 
keyframes and deselected keyframes. See “Aligning Keyframes” on 
page 132.
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Both Align Keyframes and Slip Keyframes can move keyframes outside 
the time boundaries of the keyframe graph. That is, you can make the 
effect behave as if parameter values are changing before the beginning or 
after the end of the effect.

Aligning Keyframes

In each of the procedures below, the reference keyframe of any keyframe 
graph is the keyframe you activated most recently in that keyframe graph.

To align the reference keyframe to the position indicator, in one 
keyframe track:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) a keyframe 
track, and choose Align Keyframes from the shortcut menu.

To align the reference keyframes to the position indicator, in one 
parameter group:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the parameter 
group title track, and choose Align Keyframes from the shortcut menu.

The reference keyframes move to the position indicator.

To align the reference keyframes to the position indicator, in the 
entire effect:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the effect’s 
title track, and choose Align Keyframes from the shortcut menu.

The reference keyframes of the entire effect move to the position 
indicator.

n In each keyframe track, Align Keyframes will not move the reference 
keyframe beyond an intervening keyframe; that is, a keyframe between the 
reference keyframe and the position indicator. If there is an intervening 
keyframe, the reference keyframe moves to within one frame or field of it.
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Align Keyframes exhibits more complex behavior when you have multiple 
keyframes selected in one keyframe graph.

If you select all keyframes in one keyframe graph, Align Keyframes is 
equivalent to Slip Keyframes. The reference keyframe moves to the 
position indicator, and all other keyframes maintain their position relative 
to the reference keyframe.

Deselected (gray) keyframes do not move. All selected keyframes do 
move, as close to the target position as possible, unless a deselected 
keyframe intervenes. The following illustration shows several examples.

Before 

After 

Before

After

Align Keyframes

One intervening keyframe

No intervening keyframe

Active keyframe

Active keyframe
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Slipping Keyframes

In each of the procedures below, the reference keyframe of any keyframe 
graph is the keyframe you activated most recently in that keyframe graph.

To slip keyframes to the position indicator, in one keyframe track:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the keyframe 
track, and choose Slip Keyframes from the shortcut menu.

All the keyframes move so that the reference keyframe aligns with the 
position indicator, and the other keyframes maintain their position 
relative to the reference keyframe.

Before 

After 

Align Keyframes — multiple keyframe examples

All keyframes selected

Reference 
keyframe

Before 

After 

One deselected keyframe

Reference 
keyframe

Two deselected keyframes
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To slip keyframes to the position indicator, in one parameter group:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the parameter 
group title track, and choose Slip Keyframes from the shortcut menu.

In the parameter category, in each keyframe track with a reference 
keyframe, all the keyframes move so that the reference keyframe 
aligns with the position indicator, and the other keyframes maintain 
their position relative to the reference keyframe.

If a keyframe track has no selected keyframes, no keyframes move.

To slip keyframes to the position indicator, in the entire effect:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the effect’s 
title track, and choose Slip Keyframes from the shortcut menu.

In the effect, in all keyframe tracks with a reference keyframe, all the 
keyframes move so that the reference keyframe aligns with the 
position indicator, and the other keyframes maintain their position 
relative to the reference keyframe.

Slip Keyframes

After 

Before 

Active keyframe
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Extrapolate and Hold

When you use standard keyframes, you always have a starting keyframe 
and an ending keyframe that are fixed at the start of the effect and the end 
of the effect. You cannot move or delete the starting keyframe and the 
ending keyframe. With advanced keyframes, you do not need to set a 
starting keyframe or an ending keyframe, and you can move or delete them 
if you want to.

n To keep your Avid system from creating starting and ending keyframes 
when you promote an effect, deselect Automatic Start and End Keyframes 
in the Effect Editor entry in the Settings scroll list.

In a keyframe graph, the first keyframe and the last keyframe are the 
bracketing keyframes for the parameter. Your Avid system determines 
parameter values beyond the bracketing keyframes using either Extrapolate 
or Hold. 

With Extrapolate enabled, your system extrapolates — that is, estimates 
more values for — the parameter values at the start and end of an effect 
using the values at the bracketing keyframes. Parameter values continue to 
change over time. The system calculates new values using the interpolation 
option in effect for that parameter.

In the previous illustration, the blue lines represent the parameter value 
before and after the bracketing keyframes and show the extrapolation of 
the parameter value.

Start of effect End of effect
Parameter values change 
before and after the 
bracketing keyframes.
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n If you are reading a hardcopy version of this document, you might find it 
useful to view the color images in the Help or in the online version of this 
document on the online publications CD-ROM.

For example, if the parameter value between the last two keyframes 
increases as the end of the effect approaches, the parameter value continues 
to increase until the end of the effect. Similarly, if the first keyframe is not 
at the very beginning of the clip, the system extrapolates the parameter 
value from the start of the effect up to the first keyframe.

With Hold enabled, your system uses only the parameter values at the 
bracketing keyframes to set values at the start and end of the effect. The 
parameter values hold steady — that is, are the same — from the start of 
the effect to the first keyframe, and again from the last keyframe to the end 
of the effect.

In the previous illustration, the horizontal blue lines indicate the parameter 
value before the first keyframe and after the last keyframe.

Extrapolate and Hold are useful any time you slip keyframes or align 
keyframes in such a way that a bracketing keyframe falls within the effect, 
or if you are using fixed keyframes for a parameter and you trim in or trim 
out the effect so that a bracketing keyframe falls within the effect. 

n The Extrapolate or Hold setting remains in effect if you trim in or trim out 
the effect.

Start of effect End of effect
Parameter values hold 
steady before and after 
the bracketing keyframes.
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In either case, you do not have an explicitly defined value outside the 
bracketing keyframes. Extrapolate and Hold can save you the trouble of 
individually setting new values for each parameter whenever you make 
changes to the position of keyframes or the length of the effect.

When you select Extrapolate, your Avid system estimates more values for 
the parameter before and after the bracketing keyframes using the values at 
the bracketing keyframes. Parameter values continue to change over time. 
The system calculates new values using the interpolation option in effect 
for that parameter.

When you select Hold, your Avid system uses only the parameter values at 
the bracketing keyframes to set values before and after the bracketing 
keyframes. The parameter values are the same from the start of the effect to 
the first keyframe, and again from the last keyframe to the end of the effect.

Start of effect End of effect
Bracketing keyframes

Keyframe graph before Slip Keyframes

Start of effect End of effect
Parameter value changes 
before the bracketing 
keyframe.

Keyframe graph after Slip Keyframes: 
Extrapolate example
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n As a result of slipping the keyframes in the previous examples, the last 
keyframe indicator has moved out of the keyframe graph view but is still 
present and is still the bracketing keyframe. The keyframe indicator visible 
at the right edge of the keyframe graph (the third keyframe indicator) is not 
a bracketing keyframe. Therefore, the parameter values in effect from the 
third keyframe to the end of the effect are calculated along the curve 
between the third keyframe and the last (bracketing) keyframe.

n You set Extrapolate and Hold independently for each parameter in an 
effect. The default condition is Hold.

To set Extrapolate or Hold for a parameter:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the keyframe 
track, and choose Extrapolate or Hold from the shortcut menu.

The display changes to reflect the new setting.

Adjusting the View in Keyframe Graphs

You adjust the view in a keyframe graph in the following ways:

• Zoom and scroll the view in a keyframe graph using the zoom slider 
and the scroll thumbwheel at the bottom of the Effect Editor.

• Resize a keyframe graph by manipulating the size of the Effect Editor 
and by expanding or contracting the vertical size of the keyframe 
graph.

• Scroll the view vertically in a keyframe graph by dragging the view.

Start of effect End of effect
Parameter value does not 
change before the 
bracketing keyframe.

Keyframe graph after Slip Keyframes: 
Hold example
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Zooming and Scrolling Keyframe Graphs

You zoom and scroll the view in a keyframe graph using the zoom slider 
and the scroll thumbwheel at the bottom of the Effect Editor.

The zoom slider in the scale bar stretches and contracts the view in a 
keyframe graph centered around the position indicator. This allows you to 
either zoom in to focus on a specific area of your keyframe graph or zoom 
out to display the entire keyframe graph.

To zoom in on a section of a keyframe graph at the position indicator 
and then zoom out:

1. Click the zoom slider, and drag it to the right.

The view in the keyframe graph expands horizontally and shows more 
detail.

Zoom slider Scroll thumbwheel Scale bar
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2. Click the zoom slider, and drag it to the left.

The view in the keyframe graph shrinks to its original size.

The scroll thumbwheel scrolls the view in a keyframe graph left or right.

To scroll the view in a keyframe graph left or right:

1. Click the scroll thumbwheel, and drag it to the left.

The view in the keyframe graph scrolls to the right; that is, as part of 
the view disappears on the right, more comes into view on the left.

2. Click the scroll thumbwheel, and drag it to the right.

The view in the keyframe graph scrolls to the left; that is, as part of the 
view disappears on the left, more comes into view on the right.
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Resizing Keyframe Graphs

Resize the keyframe graph by manipulating the size of the Effect Editor 
and by expanding or contracting the vertical size of the keyframe graph.

To change the width of a keyframe graph:

t Click a corner of the Effect Editor, and drag it to resize the window.

To change the height of a keyframe graph:

1. Position the pointer over the lower edge of the keyframe graph that you 
want to change.

The pointer changes to a vertical resizing pointer.

2. Click the edge of the graph, and drag it up or down.

The height of the keyframe graph gets smaller or larger.

Moving Keyframe Graph Views Up or Down

Scroll the view in a keyframe graph up or down by dragging the view.

n Use the scroll thumbwheel to move the view left or right.

To scroll the view in a keyframe graph up or down:

1. Alt+click (Windows) or Option+click (Macintosh) the keyframe 
graph.

The pointer changes to a hand.

2. Drag the hand up or down to reposition the view within the keyframe 
graph.
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Resetting Keyframe Graph Views

If you move the view in a keyframe graph so that you can no longer see the 
keyframes, you can use the shortcut menu to vertically recenter the 
keyframes in the keyframe graph.

To reset the view in a keyframe graph:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the keyframe 
graph, and choose Reset Graph View from the shortcut menu.

The keyframes appear centered in the keyframe graph.

n Depending on how you have scaled and zoomed your keyframe graph, you 
might not see any keyframes. Try scrolling the keyframe graph left or right, 
or zoom out until keyframes appear.

Options for Using Advanced Keyframes

The Effect Editor shortcut menu gives you options for adjusting the Effect 
Editor display, for controlling the playback of effects with advanced 
keyframes, and for setting a default command for the Add Keyframe 
button.

n The Effect Editor shortcut menu appears only in effects with advanced 
keyframes.

To display the Effect Editor shortcut menu:

t Right-click (Windows) or Ctrl+Shift+click (Macintosh) the Effect 
Editor outside the keyframe track area.

The Effect Editor shortcut menu appears.
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Table 5 describes the shortcut menu options for the Effect Editor.

Table 5 Effect Editor Options

Option Description

Indent Rows When this option is selected, parameter rows are indented from the parameter 
category row, and any parameter subgroups are indented again. When deselected, 
the left edges of parameter rows line up with the parameter category row.

Large Text When this option is selected, text in the Effect Editor appears in 12-point size. 
When deselected, text in the Effect Editor appears in the default size, 10 points 
(Windows) or 9 points (Macintosh).

Indented parameter rows Non-indented parameter rows

Normal text size Large text
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Thumbwheels When this option is deselected, variable controls in the Effect Editor appear as 
the default slider control. When selected, variable controls appear as 
thumbwheels. For information on using thumbwheels, see “Using Parameter 
Sliders” on page 92.

Real-Time Update When this option is selected, your system updates the rendered effect image in 
real time. Because the update can be slow for complex effects, you have the 
option to deselect updating in real time.

Set Position To 
Keyframe

With Set Position To Keyframe selected, when you click a keyframe, your system 
moves the position indicator to the keyframe. With Set Position To Keyframe 
deselected, when you click a keyframe, the position indicator does not move. 
Deselecting Set Position To Keyframe allows you to align a keyframe to the 
position indicator. See “Align Keyframes and Slip Keyframes” on page 131.

Update Position While 
Playing

When this option is selected, the position indicator in the Effect Editor moves 
while you play the effect. Because using Update Position While Playing can 
cause video underrun problems in complex real-time effects, the option is 
deselected by default.

Table 5 Effect Editor Options (Continued)

Option Description

Sliders Thumbwheels
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Show Add Keyframe 
Mode Menu

When this option is selected, the Add Keyframe Mode menu (or the Delete 
Keyframe Mode menu) appears when you use the Add Keyframe button to add 
(or delete) keyframes. See “Using the Add Keyframe Mode Menu and the Delete 
Keyframe Mode Menu” on page 110.

With Show Add Keyframe Mode Menu deselected, using the Add Keyframe 
button performs the default command from the list below (Add Keyframe button 
options), without displaying the Add Keyframe Mode menu or the Delete 
Keyframe Mode menu.

Add Keyframe button 
options:

Select one as the default command for the Add Keyframe button.

• When you deselect Show Add Keyframe Mode Menu, clicking the Add 
Keyframe button once performs the default command.

• When you select Show Add Keyframe Mode Menu, clicking the Add 
Keyframe button twice performs the default command. (The first click 
displays the Add Keyframe Mode menu, at which point you can select 
another command.)

n The selection you make for the Add Keyframe mode is mirrored in the 
Delete Keyframe Mode menu, and vice versa. For example, when you 
change your selection to Add Keyframe To Enabled Groups, the Delete 
Keyframe mode changes to Delete Keyframe From Enabled Groups.

For a description of each command, see “Using the Add Keyframe Mode Menu 
and the Delete Keyframe Mode Menu” on page 110.

• Add Keyframe To 
Active Parameter

• Add Keyframes To 
Active Group

• Add Keyframes To 
Open Groups

• Add Keyframes To 
Enabled Groups

• Add Keyframes To 
Open Graphs

• Add Keyframes To 
All Parameters

Table 5 Effect Editor Options (Continued)

Option Description
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Manipulating Effects Directly

In addition to defining effects by using parameter controls, you can make 
some adjustments to effects by manipulating them directly in the Effect 
Preview monitor. These adjustments use handles and wire-frame outlines 
that you can display in the monitor.

You can create a motion path that defines how the foreground image moves 
across the background video. You can also resize a foreground image such 
as a picture-in-picture.

Defining Motion Paths

You can define how the foreground image of a multilayer effect moves 
across the background video by building a motion path, or string of 
keyframes.

You can define a motion path on multilayer video effects, such as Picture-
in-Picture effects. Use the wire-frame preview feature when you want to 
see the path an image takes on the screen. 

When you are creating a motion path that moves beyond the viewing 
screen, you can use the Reduce button to view an outline of the image at a 
reduced scale. The reduced scale view shows the area outside the 
background image and allows you to extend the motion path into that area. 
The Enlarge button returns the screen to full view.

To define a motion path for the foreground image, do one of the 
following:

t Move the image directly and automatically add keyframes. For more 
information, see “Moving the Image Directly” on page 148.

t Add keyframes and adjust the parameter sliders. For more information, 
see “Understanding Keyframes” on page 98.
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Moving the Image Directly

To add a motion path to the foreground image by moving the image 
directly:

1. Create a sequence with two video layers (foreground video on track 
V2, background video on track V1). For information about creating a 
sequence, see the chapter “First Edits” in the user’s guide.

2. Apply a multilayer effect to the foreground segment on track V2.

3. Select the foreground effect segment on track V2.

4. Choose Effect Editor from the Tools menu.

The Effect Editor opens, and the Composer monitor becomes the 
Effect Preview monitor. The foreground image is outlined, and both 
the starting and ending keyframe indicators are highlighted (pink) in 
the effect’s position bar.

Starting keyframe indicator Ending keyframe indicatorEffect’s position bar

Wire frame outlining 
foreground image 
on track V2

Background image 
on track V1
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By default, the wire frame is active in the Effect Preview monitor. If 
the wire frame is not displayed, click the Outline/Path button in the 
Effect Editor to activate the wire frame.

5. Drag the wire frame to the start point of the motion path you are 
creating. The starting keyframe indicator represents the start point.

6. Click the ending keyframe indicator to select it. Make sure the ending 
keyframe indicator is the only indicator selected (pink).

7. Drag the wire frame to the end point of the motion path. 

A path line from the center of the starting position to the center of the 
ending position appears.

8. Drag the position indicator in the position bar below the Effect Preview 
monitor to a new location. 

The wire frame moves with the position indicator; notice the path line 
does not change.

9. Click inside the wire frame, and drag or stretch the wire frame to add a 
keyframe at the new location. 

A handle appears in the center of the wire frame, indicating the path 
position of the new keyframe.

10. Drag the wire frame to change the effect’s path.

11. Repeat steps 8, 9, and 10 to add more variation to the path.

Resizing a Foreground Image by Dragging Handles

To resize the foreground image by dragging wire-frame handles:

1. Create a sequence with two video layers (foreground video on track 
V2, background video on track V1). For information about creating a 
sequence, see the chapter “First Edits” in the user’s guide.

2. Apply a multilayer effect to the foreground segment on track V2.

3. Select the foreground effect segment on track V2.

4. Choose Effect Editor from the Tools menu. 

The Effect Editor opens, and the Composer monitor becomes the 
Effect Preview monitor. By default, the wire frame is active in the 
Effect Preview monitor. 
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If the wire frame is not displayed, click the Outline/Path button in the 
Effect Editor to activate the wire frame.

5. Drag one of the handles to resize the image:

t Drag the top center handle to adjust the image’s height.

t Drag the right center handle to adjust the image’s width.

t Drag the top right corner handle to equally change the image’s 
height and width. This option maintains the aspect ratio while 
resizing the image.

Using an Effect Template

The complete set of parameter values for an effect is called the effect 
template. You can reuse an effect template in multiple places in a sequence 
by saving the template in a bin and later applying the template to other 
effects or video clips in the sequence.

Wire-frame resize handles
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Saving an Effect Template

You can save the parameters from an effect in the Effect Editor and reuse 
them for another effect. You can also save a segment effect with its source 
media, which is useful when you want to save an imported PICT file or 
Matte Key clip for future editing into a sequence.

To save the parameters from an effect as an effect template:

1. Drag the effect icon from the Effect Editor to a bin.

Effect icons for open 
bins are also displayed 
in the Effect Palette.

This creates a new effect template in the bin, containing the parameter 
setting information for the effect. The new effect template is identified 
in the bin by its effect icon.

2. To rename the template, click the template name and type a new name.

To save a segment effect with its source media:

1. Press and hold the Alt key (Windows) or Option key (Macintosh), and 
then drag the effect icon from the Effect Editor to a bin.

2. To rename the template, click the template name and type a new name.

Effect icon
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n Avid Xpress DV saves title effects with source by default. If you press and 
hold the Alt key (Windows) or Option key (Macintosh) while dragging the 
icon, you will get a keyframe-only template. This template retains the 
movement of the title without the source.

Applying an Effect Template

You can take an effect template that has been saved in a bin and apply the 
template and its parameters to other transitions or segments in your 
sequence. Effect templates saved in open bins appear in the Effect Palette 
as well as in the bin itself.

You can also apply specific parameters from the template.

c Do not drag an effect template through the Timeline because this 
deselects the effect.

To apply an effect template with all its parameters directly to a 
segment or transition:

t Drag the effect template icon from the bin or from the Effect Palette, 
and drop it on the segment or transition in the Timeline.

Effect template example: In this example, a 3D PIP Effect 
template was saved and then applied repeatedly to a 
series of segments to achieve the same cropping and 
positioning of foreground footage.
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To apply a specific parameter from an effect template:

1. Select an effect transition or segment in the Timeline.

2. Choose Effect Editor from the Tools menu.

3. Open the parameter category you want to change. For example, the 
following illustration shows the Position parameter category.

4. Click the effect template icon in the bin or in the Effect Palette, and 
drag it to the specific parameter category in the Effect Editor.

The effect template is applied only to the effect parameter category 
you selected.

New position parameters
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Chapter 4

Playing, Previewing, and 
Rendering Effects

This chapter explains how to play, preview, and render effects. It also 
describes how to manage media effect files on your system.

• Playing an Effect

• Real-Time Preview of Video Effects

• Rendering Effects

• Managing Effect Media Files
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Playing an Effect

You can play an individual effect in a variety of ways while the Effect 
Editor is open, as described in this section. Depending on the capabilities 
of your system and the complexity of your sequences, various effects 
might require rendering before you can play them back in real time. For 
more information, see “Real-Time Preview of Video Effects” on page 159 
and “Rendering Effects” on page 167.

You can preview effects before rendering them. See “Playing a Preview of 
an Effect” on page 157.

Basic Playback

You can play all or part of an individual effect while the Effect Editor is 
open by using the Play button.

To play an effect:

1. Move the position indicator in the Timeline to the effect you want to 
play.

2. Click the Play button in the Effect Editor or in the Effect Preview 
Monitor toolbar.

To stop playing an effect, do one of the following:

t Click the Play button.

t Press the space bar.



Playing an Effect

157

Playing an Effect in a Continuous Loop

You can play an effect repeatedly in a continuous loop while the Effect 
Editor is open by using the Play Loop button.

To play the effect in a continuous loop while the Effect Editor is open:

1. Move the position indicator in the Timeline to the effect you want to 
play.

2. Click the Play Loop button in the Effect Editor or in the Effect Preview 
Monitor toolbar.

To stop playing an effect, do one of the following:

t Click the Play Loop button.

t Press the space bar.

Playing a Preview of an Effect

You might want to play an outline version of an effect to check its 
appearance and operation. An effect’s outline is a wire-frame 
representation of the effect’s position, scale, and path of motion.

To play an effect’s outline:

t Click the Play Preview button in the Effect Editor.

The effect’s outline plays from the current position.

To stop playing the effect preview, do one of the following:

t Click the mouse button.

t Press the space bar.

t Click the Play Preview button.
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Previewing Effect Frames with Render On-the-Fly

When you want to preview effects in a sequence, you can use the Render 
On-the-Fly feature to control how your system displays a monitored frame 
to which one or more effects have been applied. When Render On-the-Fly 
is selected, you can step through your sequence and preview any frame to 
check the look of the effects applied to it, regardless of the type or number 
of those effects.

When Render On-the-Fly is selected, whenever you change the frame you 
are monitoring, the system updates to show the image that results from any 
effects applied to that frame. Depending on the number and complexity of 
effects, there might be a perceptible delay before the image updates in the 
Composer monitor.

When Render On-the-Fly is deselected, the system shows the monitored 
frame as if no effects had been applied to it. You can deselect Render On-
the-Fly to avoid delays in image updating when you are not concerned 
about the look of effects.

Render On-the-Fly controls how your system displays a frame only when 
the position indicator is stationary at that frame. During playback (that is, 
while the position indicator is in motion), the system’s ability to display 
effects depends on whether Real-time Effects is enabled and on other 
associated factors. For more information, see “Real-Time Preview of Video 
Effects” on page 159.

To display effects immediately during effects editing:

t Choose Render On-the-Fly from the Clip menu.

Interrupting Render On-the-Fly

Using Render On-the-Fly can slow down your editing of a sequence. If you 
are compositing and then change the frame you are monitoring, you must 
wait for the system to render the single frame.

Instead of waiting for rendering to finish, you can interrupt Render 
On-the-Fly. Interrupting Render On-the-Fly interrupts only the rendering 
of non-real-time effects.
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To interrupt Render On-the-Fly, do one of the following:

t Drag the position indicator in the Timeline.

While you are dragging, the sequence appears in the Composer 
monitor as it would if Render On-the-Fly were not selected from the 
Clip menu.

t If you click in the Timeline and the system begins to render, quickly 
move to another location in the Timeline. This interrupts the rendering 
process until you release the mouse button.

Real-Time Preview of Video Effects

You can preview video effects available in Avid Xpress DV in real time. 
This allows you to play back sequences to which you have applied effects 
and to review the appearance of those effects. Real-time preview of video 
effects is available for all effects except motion effects.

Real-time effects preview has no effect on the methods you use when you 
apply and modify the effects themselves.

Understanding Real-Time Effects Processing

To display a frame from a sequence that has a video effect applied, your 
system must calculate the result of the effect at that frame. For example, to 
display the midpoint frame from a dissolve between two clips, the system 
must calculate, for each pixel in the frame, a 50 percent blend between the 
color and luminance values in the outgoing clip and those in the incoming 
clip. To display frames in real time, your system must be able to perform 
enough of these effect calculations per second to maintain the appropriate 
display rate for your project, for example 30 frames per second (fps) for 
NTSC video.

Because your computer’s processor and memory capabilities are finite, 
your system’s ability to play back effects in real time is limited. Effect 
calculations are more complex for some effects than for others, and still 
more complex when many effect options have been adjusted or when 
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multiple effects apply to the same frame in a sequence. Even the fastest and 
most powerful system might eventually reach a point where it can no 
longer maintain real-time playback.

When Avid Xpress DV is unable to maintain real-time playback, it 
continues to play at the correct rate but does not display frames that it 
cannot process quickly enough. If the system is having only a small 
amount of difficulty with the complexity of the sequence, you will 
probably perceive a short stutter in the video playback, but you might still 
be able to get a useful sense of how your effects will look once they are 
rendered. If the system is having more difficulty, it is less likely that you 
will be able to judge the look of the effects.

You have a number of options for controlling how real-time effects preview 
operates, including the ability to selectively render effects when the system 
is having difficulties previewing in real time and the ability to switch 
between a High Quality mode that emphasizes image quality over effect 
processing capability and a High Performance mode that reduces image 
quality in order to process more complex effects successfully. For more 
information, see “Controlling Real-Time Effects Playback” on page 165.

Understanding Monitor Options for Real-Time Effects Preview

You can play back video effects in real time in the following monitors:

• The Composer monitor within Avid Xpress DV, while you are not 
outputting a DV signal.

• A Client monitor, if the monitor receives its video signal directly from 
analog output hardware in your computer such as can be found on 
some graphics boards.

n If your analog output hardware is not capable of resizing the video image, 
you cannot use the “High Performance (more simultaneous effects)” 
option in the Video Display Settings dialog box. The system automatically 
switches to the “High Quality (fewer simultaneous effects)” option. This 
might result in the system being less able to play back complex effect 
sequences successfully. For more information, see “Using Video Display 
Settings for Real-Time Effects Preview” on page 166.
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Your system is not able to sustain DV output and real-time playback of 
video effects at the same time. You can enable or disable real-time effects 
as necessary for the current stage of your workflow, instructing the system 
to channel its processing resources either to DV output or to real-time 
effects processing. For more information, see “Enabling Real-Time 
Effects” on page 161. 

Because real-time effects preview and DV output cannot take place at the 
same time, it is not possible to preview effects in real time for the 
following monitors and situations:

• The Composer monitor within Avid Xpress DV, if you are also 
outputting a DV signal.

• A Client monitor, if the monitor receives its video signal from a DV 
device, for example, a camera or digital deck that is connected to your 
computer by means of a FireWire connection. 

For more information on the Client monitor options for your system, see 
“Playing Video to the Client Monitor” in the chapter “Viewing and 
Marking Footage” in the user’s guide.

It is not possible to output effects in real time, for example, when you 
perform a digital cut to DV tape. You must always render effects to include 
them in final output. Depending on the nature and complexity of the 
material you want to output, you might not need to render every effect. You 
can use the ExpertRender™ feature to determine which effects you need to 
render for successful output. For more information, see “ExpertRender” on 
page 177.

Enabling Real-Time Effects

By default, your system is set to generate DV output, and real-time effects 
are disabled. Since your system cannot sustain DV output and real-time 
effects playback at the same time, you must enable real-time effects if you 
want to preview effects at full speed.

When real-time effects are disabled, effect icons have no colored dot in the 
Effect Palette and display a blue dot in the Timeline, indicating that they 
must be rendered before they will play in real time. When real-time effects 
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are enabled, most effect icons have a green dot in both the Effect Palette 
and in the Timeline, indicating that they might play in real time, depending 
on the complexity of the effects and the sequence.

To enable real-time effects:

t In the upper right corner of the Timeline, click the Real-Time Effects 
button.

To disable real-time effects:

t In the upper right corner of the Timeline, click the Real-Time Effects 
button again.

Blend effect category in the Effect Palette when 
real-time effects are disabled. No dots indicates 
that the effects will not preview in real time.

Blend effect category in the Effect Palette when 
real-time effects are enabled. Green dots indicate 
that the effects might preview in real time.

Effect icons in the Timeline when real-time effects 
are disabled. Blue dots indicate that the effects 
will not preview in real time.

Effect icons in the Timeline when real-time effects 
are enabled. Green dots indicate that the effects 
might preview in real time.

Real-Time Effects button
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The following illustration shows the two button states.

Understanding Real-Time Playback Information in the Timeline

When your system is unable to maintain real-time playback of an effects 
sequence, colored bars appear in the timecode track of the Timeline when 
playback ends. The following illustration shows a typical set of colored 
bars.

These bars provide you with information about the difficulties the system 
had during playback. You can use this information to help you render only 
those parts of the sequence necessary to achieve real-time playback.

• Red bars mark the ranges where the system was unable to display 
frames.

• Yellow bars mark the ranges that caused difficulty for the system 
during playback.

The ranges marked by yellow bars are ranges that the system 
recommends for rendering to achieve successful real-time playback. If 
you mark IN and OUT points around these ranges, use the 
ExpertRender In/Out command, and then render the recommended 
ranges, the system will be able to preview your material successfully in 
real time. For more information, see “ExpertRender” on page 177.

When the Real-Time Effects button is 
blue, real-time effects are disabled.

When the Real-Time Effects button is 
green, real-time effects are enabled.

Colored bars

Timecode 
track
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• Blue bars mark the location of frames that caused difficulty for the 
system because of disk speed limitations.

If you find that your playback information often includes blue bars, it 
is likely that replacing your media disks with faster drives will improve 
your system’s ability to play back effects in real time.

You can control whether real-time playback information bars appear in the 
Timeline from the Timeline Settings dialog box.

To turn real-time playback information bars on or off:

1. In the Settings scroll list of the Project window, double-click Timeline.

2. If it is not already highlighted, click the Display tab.

3. Select or deselect Highlight Suggested Render Areas After Playback.

Real-time playback information bars appear when this option is 
selected. This option is selected by default.
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Controlling Real-Time Effects Playback

When your system is unable to maintain real-time playback of an effects 
sequence, there are a number of ways you can attempt to ensure that the 
sequence plays back successfully in real time.

• If possible, start playback earlier in the sequence, before the effects 
that are causing difficulties begin.

This allows the system to begin processing some of the effects frames 
before it must display them, decreasing the chance of difficulties with 
playback.

• In the Video Display Settings dialog box, increase the number of 
seconds of video to prefill.

For more information, see “Using Video Display Settings for Real-
Time Effects Preview” on page 166.

• Use the Expert Render command on those parts of the sequence where 
the system had difficulties during playback.

The system marks these parts of the sequence in the Timeline. For 
more information, see “Understanding Real-Time Playback 
Information in the Timeline” on page 163 and “ExpertRender” on 
page 177.

• Select the “High Performance (more simultaneous effects)” option in 
the Video Display Settings dialog box.

This increases the system’s ability to process effects at the expense of 
reducing image quality. For more information, see “Using Video 
Display Settings for Real-Time Effects Preview” on page 166.
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Using Video Display Settings for Real-Time Effects Preview

You can use settings in the Video Display Settings dialog box to control 
some aspects of the performance of real-time effects preview. You can:

• Select either the “High Quality (fewer simultaneous effects)” or the 
“High Performance (more simultaneous effects)” option for real-time 
effects.

The “High Quality (fewer simultaneous effects)” option uses full 
image resolution but can handle only relatively limited effect 
complexity before the system begins to have difficulties with real-time 
playback. The “High Performance (more simultaneous effects)” option 
reduces image resolution and can handle greater effect complexity.

• Specify a number of seconds of video to prefill.

This setting instructs the system to delay the beginning of playback by 
the number of seconds you specify. During this time, the system 
processes frames in advance and stores them in memory. When 
playback begins, the system starts to display the preprocessed frames 
while it continues to process new ones. The system will continue to 
play back the sequence successfully in real time unless it exhausts its 
supply of preprocessed frames. By accepting a delay at the beginning 
of playback, you increase the likelihood that the system will play the 
material successfully. The maximum delay you can specify is 
10 seconds.

n If the amount of memory available is limited, the system might not be able 
to prefill the full number of seconds that you specify. As a result, the delay 
you experience before playback begins might be less than the number of 
seconds you specify. It cannot be more than that number.

To modify Video Display settings:

1. Click the Settings tab in the Project window.

The Settings scroll list appears.

2. Double-click Video Display.

The Video Display Settings dialog box appears.
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3. Select the options you want, and then click OK.

Rendering Effects

You can play back most Avid Xpress DV effects in real time within your 
system to preview how they will look when rendered, but you must render 
effects before you can output a finished sequence. You can use the 
ExpertRender feature to determine which effects need to be rendered. For 
more information on real-time preview of effects, see “Real-Time Preview 
of Video Effects” on page 159. For more information on the ExpertRender 
feature, see “ExpertRender” on page 177.

n In the Timeline, effect icons have a blue dot or a green dot before 
rendering. Rendering removes the dot.



 Chapter 4 Playing, Previewing, and Rendering Effects

168

When Avid Xpress DV renders an effect, it stores the effect and its media 
file as a precomputed master clip (often referred to as a precompute). 
Avid Xpress DV uses the precompute the next time to play the effect at its 
normal speed.

You can render a single effect after you have created it, or you can choose 
to render a group of effects at the same time. You can also interrupt a 
render in progress and choose to save or discard the completed portion. 
You can finish the render later by resubmitting the effect for rendering. 

The key to rendering quickly is to render only those effects that require it. 
With vertical and nested effects, for example, you do not have to render 
every layer to play the effect in real time. If the top track covers the entire 
duration of the tracks below, Avid Xpress DV renders the composite result 
of all tracks into the top track.

One useful way to minimize rendering time is to use the Submaster effect 
by applying it to a track above layered effects and rendering only the 
Submaster effect. The Submaster effect icon has a green dot, both in the 
Effect Palette and in the Timeline before rendering. If you have applied the 
Submaster effect over other effects, it must be rendered before 
Avid Xpress DV can play it in real time. For more information, see 
“Submaster Editing” on page 231.

Creating and Using Render Settings

You can create one or more sets of render parameters and save them as a 
custom Render setting. You can then activate the setting that you need at 
each stage of your project.

Creating a New Render Setting

To create a new Render setting:

1. Click the Settings tab in the Project window.

The Settings scroll list appears.

2. Click Render.
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3. Choose Duplicate from the Edit menu.

4. Name the setting:

a. Click the custom name column (in between the setting name and 
the setting type identifier).

b. Type a name.

c. Press Enter (Windows) or Return (Macintosh).

5. Adjust the options for the setting as described in the following 
procedure.

Adjusting Render Settings Options

To adjust the options in the Render Setting dialog box:

1. Double-click a Render setting in the Settings scroll list of the Project 
window. 

The Render Setting dialog box appears.
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2. Select the appropriate options, based on the descriptions in Table 6, 
and then click OK.

Table 6 Render Settings Options

Option Suboption Description

Render Completion Sound Sets a sound for Avid Xpress DV to activate once the rendering process 
is complete. This is useful when you are rendering multiple effects.

None Disables the rendering completion sound. This is the default.

Render Sound Sets the rendering completion sound to a customized sound.

System Beep Sets the rendering completion sound to match the sound set for your 
operating system.

Motion Effects Render Using Determines the processing method when existing motion effects are 
rendered or rerendered.

Original 
Preference

Causes effects to be rendered as whatever type they were when 
originally created.

Duplicated Field Displays a single field in the effect. For two-field media, this reduces 
the information stored by half because it drops one field of the image, 
resulting in a lower quality image. For single-field media, this is 
usually the best choice because of its speed (the other options do not 
improve effect quality for single-field media). The effects render in the 
shortest amount of time when you use this option.

Both Fields Displays both fields in the effect. For example, the first two frames of a 
half-speed (50%) slow-motion effect repeat the original Frame 1 (both 
fields) twice. This option is good for shots without inter-field motion, 
NTSC or PAL film-to-tape transfers, and still shots. With footage that 
includes inter-field motion, this method might result in minor shifting 
or bumping of the image because it disturbs the original order of fields: 
a Field 1 will appear both before and after the corresponding Field 2. 
The effect renders relatively quickly. For best results, you should use 
evenly divisible frame rates with this option.
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Activating a Render Setting

To activate a Render setting:

t Click in the column to the left of the setting name in the Settings scroll 
list of the Project window.

A check mark appears beside the setting that is currently active.

Partial Render

If you interrupt a render that is not complete, Avid Xpress DV allows you 
to save the completed portion of the render.

You can finish the render later by resubmitting the effect for rendering. 
Avid Xpress DV then renders only the part of the effect that has not been 
rendered previously and will save that part as a separate precompute. 

VTR-Style Creates a second field for the effect by shifting selected video fields of 
the original media by a full scan line. This technique is similar to that 
used by high-quality professional video decks when playing footage at 
less than normal speed. This option also creates the motion effect at the 
field level rather than the frame level; however, because pixels are not 
filtered, the final image is sharper than that created by the Interpolated 
Field option. The image might display some slight jitter at certain 
speeds. 

The time needed to render effects created with this option is longer 
than the time for effects created using either Duplicated Field or Both 
Fields but similar to the time needed for Interpolated Field.

Interpolated 
Field

Creates a second field for the effect by combining scan line pairs from 
the first field in the original media. This option calculates the motion 
effect at the field level rather than the frame level. Because 
Avid Xpress DV considers all fields and does not disturb the original 
order of fields, the smoothest effect results. Effects created using this 
option take the longest amount of time to render.

Table 6 Render Settings Options (Continued)

Option Suboption Description



 Chapter 4 Playing, Previewing, and Rendering Effects

172

This feature is especially useful if you have to interrupt a long render of a 
single effect, such as a Submaster effect.

You can also use the Render Ranges command in the Timeline Fast menu 
to customize the Timeline so that it indicates which parts of an effect 
Avid Xpress DV has rendered.

Interrupting a Render

To interrupt a render:

1. Press Ctrl+period (Windows) or k+period (Macintosh) to interrupt 
the render.

A message box appears.

2. Do one of the following:

t Click Keep to save the material already rendered.

t Click Discard to end the render without saving the material already 
rendered.

Customizing Render Ranges Display

To customize the display of render ranges in the Timeline:

1. In the Timeline Fast menu, click and point to Render Ranges.
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2. Choose one of the following from the submenu:

- None — Turns off the display of render ranges.

- Partial Only — Displays a red line on the portion of any partially 
rendered effect that is currently unrendered (but does not mark 
completely unrendered effects). This is the default option.

- All — Displays a red line on the portion of any partially rendered 
effect that is currently unrendered and on all completely 
unrendered effects.

n Render Ranges indicator lines do not display if Show Effect Contents is 
selected in the Timeline Settings dialog box.

n The All option of the Render Ranges display provides a simple visual 
indication of which effects are unrendered. It is not an indication of which 
effects might need to be rendered to achieve successful playback.

n The playback behavior of a partially rendered effect depends on the frame 
at which playback begins. If playback begins at a rendered frame, 
Avid Xpress DV attempts to play the entire effect in real time. You see the 
rendered portion in real time but cannot see the unrendered portion. If 
playback begins at a non-rendered frame, Avid Xpress DV plays the entire 
effect using Render On-the-Fly.

Rendering a Single Effect

After you have adjusted an effect’s parameters, you can render the effect.

To render a single effect:

1. Move the position indicator to the effect in the Timeline. 

Make sure the track containing the effect is selected.

2. Click the Render Effect button in the Tool palette, Effect Editor, or 
Effect Preview Monitor toolbar, or choose Render at Position from the 
Clip menu.
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The Render Effect dialog box appears.

n To prevent this dialog box from appearing, press and hold the Alt key 
(Windows) or Option key (Macintosh) when you click the Render Effect 
button. Avid Xpress DV will use the last drive selected.

3. Select a drive for the rendered media from the pop-up menu.

The Effect Source Drive is the drive where the media on the outgoing 
shot of a transition resides.

4. Click OK.

If there is not enough room on the drive, Avid Xpress DV displays a 
message box that gives you the following choices:

- Stop — Stop the rendering process and return to the Render Effect 
dialog box, and then choose another drive before continuing.

- Continue — Attempt to render the effect anyway, in case there 
might be enough room on the drive.

The effect is rendered, and a precompute master clip is stored on the 
drive you selected.

n To display the estimated render time during rendering, press the T key on 
the keyboard. Press the T key again to clear the display. Press the P key to 
view percent rendered.
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Rendering Effects at Position

When you have more than one effect at a particular point in the Timeline 
(for example, effects on several stacked video tracks), you can render them 
as a group.

To render multiple effects at position:

1. Move the position indicator to the effects in the Timeline.

2. Select all tracks that contain effects you want to render.

3. Choose Render at Position from the Clip menu.

The Render Effects dialog box appears.

4. Select a drive from the pop-up menu on which to store the rendered 
effects.

The Effect Source Drive is the drive where the media on the outgoing 
shot of a transition resides.

5. If you do not want to render the real-time effects in the selected group 
of effects, select Skip Real-Time Effects.

6. Click OK.

If there is not enough room on the drive, Avid Xpress DV displays a 
message box that gives you the following choices:

- Stop — Stop the rendering process and return to the Render 
Effects dialog box, and then choose another drive before 
continuing.
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- Continue — Attempt to render the effects anyway, in case there 
might be enough room on the drive.

Avid Xpress DV renders all effects at the position in the Timeline.

n To display the estimated render time during rendering, press the T key on 
the keyboard. Press the T key again to clear the display. Press the P key to 
view percent rendered.

Rendering Effects Between IN and OUT Points

When you have multiple effects to render for a whole sequence or a portion 
of a sequence, you can render them as a group by marking IN and OUT 
points.

n Save your sequence before you use this feature. Depending on the number, 
type, and complexity of the effects, the batch process can take a long time.

To render multiple effects by using IN and OUT points:

1. Select all tracks that contain effects you want to render.

2. Mark an IN point before the start of the first effect to be rendered in 
your sequence; mark an OUT point after the last effect to be rendered.

3. Choose Render In/Out from the Clip menu.

The Render Effects dialog box appears.

4. Select a drive from the pop-up menu on which to store the rendered 
effect.

The Effect Source Drive is the drive where the media on the outgoing 
shot of a transition resides.

5. If you do not want to render the real-time effects in the selected group 
of effects, select Skip Real-Time Effects.

6. Click OK.

Avid Xpress DV renders all effects between the IN and OUT points.
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n If the drive is near capacity, a message box appears and warns you that 
there might not be enough space to store the rendered effect. You can click 
Stop to stop the rendering process and return to the Render Effects dialog 
box, and then choose another drive before continuing. Alternatively, you 
can click Continue to attempt to render the effects anyway, in case there 
might be enough space on the drive.

n To display the estimated render time during rendering, press the T key on 
the keyboard. Press the T key again to clear the display. Press the P key to 
view percent rendered.

n Another way to speed up rendering is to use the Submaster effect. See 
“Submaster Editing” on page 231.

ExpertRender

Avid Xpress DV systems include the ExpertRender feature. ExpertRender 
determines which effects need to be rendered to achieve successful 
playback of a sequence.

Understanding ExpertRender

When you render effects by using the Render at Position or Render In/Out 
command, the system renders all effects in the selected material — all 
effects on the enabled tracks at the position or all effects on the enabled 
tracks between the marked IN and OUT points. In most cases, the system 
renders some effects that do not require rendering for successful playback, 
increasing the time to render and creating more precomputes than 
necessary.

For example, the following sequence includes seven effects on two tracks. 
If you use the Render In/Out command on this material, you render all 
seven effects. If you use the ExpertRender In/Out command on the 
material, the ExpertRender analysis recommends rendering only the three 
effects on the top track.
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The ExpertRender option available for Avid Xpress DV helps to solve the 
problem of unnecessary rendering by analyzing all the effects in selected 
material and by determining which effects need to be rendered to achieve 
successful playback. You can then choose to render the effects identified 
by ExpertRender or to modify the selections before submitting them for 
rendering.

ExpertRender attempts to generate a minimum set of effects to render for 
successful playback. If you render the effects recommended by 
ExpertRender, your material will usually play successfully in real time.

ExpertRender is particularly useful in the following circumstances:

• If you have attempted to preview a sequence with effects and the 
system has not been able to maintain real-time playback, you can use 
ExpertRender to help you render the minimum amount of material 
necessary to achieve successful playback for previewing. 
ExpertRender includes an option that allows you to render effects only 
in the regions recommended by the system for rendering after a 
playback attempt. These are the regions marked by yellow bars in the 
timecode track of the Timeline. For more information, see 
“Understanding Real-Time Playback Information in the Timeline” on 
page 163.

Sequence with seven effects.

Results of an ExpertRender analysis of this 
sequence. Only the three effects on the top 
track are highlighted, and these are the only 
effects that must be rendered for successful 
output.
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• If you are ready to output your sequence, for example, by performing a 
digital cut to tape, you can use the ExpertRender In/Out command to 
determine which effects need to be rendered for successful output. In 
particular, when there are overlapping effects on multiple tracks, 
ExpertRender can calculate when the rendering of an effect on an 
upper track will incorporate picture information from lower tracks. In 
this situation, effects on the lower tracks do not need to be rendered 
separately. Depending on the complexity of your sequence, 
ExpertRender might save you both time and storage space by 
eliminating unnecessary rendering and precomputes.

If you have already rendered recommended ranges in a sequence to 
achieve successful real-time preview, you can usually achieve analog 
output of that sequence without further rendering. For DV output, 
however, you should always use the ExpertRender In/Out command 
across the entire sequence since you will usually need to render some 
additional effects beyond those rendered in recommended ranges.

In most circumstances, ExpertRender enables you to render material 
quickly, easily, and with a high degree of storage efficiency. However, 
experienced Avid users might achieve an even quicker render of a complex 
sequence than that offered by ExpertRender — for example, by using 
Submaster editing. For more information, see “Considerations When 
Using ExpertRender” on page 187 and “Submaster Editing” on page 231.

Using ExpertRender to Render Effects

You can use the ExpertRender feature in the same way that you use the 
standard Render commands. You can use the ExpertRender at Position 
command or you can mark IN and OUT points and then use the 
ExpertRender In/Out command.

If your system has had difficulty previewing effects in real time and has 
displayed colored bar information in the timecode track of the Timeline, 
the steps you take when you use the ExpertRender In/Out command are 
somewhat different from the steps you take when you use one of the 
ExpertRender commands in other circumstances.
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Using the ExpertRender Command

Use the following procedure when there are no colored real-time playback 
information bars displayed in the timecode track of the Timeline. You 
generally use this method to render a sequence so that it will play back 
successfully for output.

For information on using the ExpertRender command when colored real-
time playback information bars appear in the Timeline following a real-
time playback attempt, see “Using the ExpertRender Command After a 
Real-Time Playback Attempt” on page 182.

To render effects by using the ExpertRender command: 

1. Select all tracks in the Timeline that contain effects you want 
ExpertRender to analyze.

2. Do one of the following:

t To render at position, move the position indicator to the effects in 
the Timeline.

t To render between IN and OUT points, mark IN and OUT points 
around the effects.

3. Choose ExpertRender at Position or ExpertRender In/Out from the 
Clip menu.

ExpertRender analyzes the selected effects and highlights the effects 
that require rendering in the Timeline.

The Expert Render dialog box appears and indicates how many of the 
effects submitted to ExpertRender require rendering.
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4. Choose a drive on which to store the rendered effects from the Drive 
pop-up menu.

The Effect Source Drive is the drive where the media for the outgoing 
shot of the first transition resides.

5. Do one of the following:

t Click Cancel.

The system removes all ExpertRender highlighting and cancels the 
ExpertRender process without rendering any effects.

t Click Modify Selection.

The effects identified for rendering remain highlighted, and you 
can modify the set of effects to render. For more information, see 
“Modifying ExpertRender Results” on page 185.

t Click OK.

The system renders the highlighted effects.

n If the drive is near capacity, a message box appears and warns you that 
there might not be enough space to store the rendered effect. You can click 
Stop to stop the rendering process and return to the Expert Render dialog 
box, and then choose another drive before continuing. Alternatively, you 
can click Continue to attempt to render the effects anyway, in case there 
might be enough space on the drive.

n To display the estimated processing time during rendering, press the T key 
on the keyboard. Press the T key again to clear the display. Press the P key 
to view percent rendered.
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Using the ExpertRender Command After a Real-Time Playback 
Attempt

Use the following steps when the system has had difficulty with real-time 
preview of effects and has displayed information bars in the timecode track 
of the Timeline.

n When you render recommended ranges in material by following this 
procedure, you can usually achieve analog output of the same material 
without further rendering. For DV output, however, you should use the 
ExpertRender command again for the duration of the material since you 
usually need to render additional effects.

For information on using the ExpertRender command under other 
circumstances, see “Using the ExpertRender Command” on page 180.

To render effects after a real-time playback attempt by using 
ExpertRender:

1. Select all tracks in the Timeline that contain effects you want 
ExpertRender to analyze.

2. Mark IN and OUT points around the material you want ExpertRender 
to analyze.

The IN and OUT points you mark should include parts of the Timeline 
marked by yellow bars in the timecode track. For more information, 
see “Understanding Real-Time Playback Information in the Timeline” 
on page 163.

3. Choose ExpertRender In/Out from the Clip menu.

The Expert Render dialog box appears and indicates the number of 
yellow bar ranges that need to be rendered to achieve real-time preview 
of effects.
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4. Do one of the following:

t To render only the effects necessary to achieve successful real-
time effects preview, select “Render recommended ranges,” and 
then click OK.

The Expert Render dialog box updates to indicate the number of 
effects that ExpertRender has identified for rendering within the 
recommended ranges.

t To render all the effects that ExpertRender has identified for 
rendering within your marked selection, select “Render entire 
selection.”
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The message in the Expert Render dialog box changes to indicate 
the number of effects that ExpertRender has identified for 
rendering across the entire selection. Using this option renders all 
the effects necessary for successful output of the marked region of 
the Timeline.

5. Choose a drive on which to store the rendered effects from the Drive 
pop-up menu.

The Effect Source Drive is the drive where the media for the outgoing 
shot of the first transition resides.

6. Do one of the following:

t Click Cancel.

The system removes all ExpertRender highlighting and cancels the 
ExpertRender process without rendering any effects.

t Click Modify Selection.

The effects identified for rendering remain highlighted, and you 
can modify the set of effects to render. For more information, see 
“Modifying ExpertRender Results” on page 185.

t Click OK.

The system renders the highlighted effects.
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n If the drive is near capacity, a message box appears and warns you that 
there might not be enough space to store the rendered effect. You can click 
Stop to stop the rendering process and return to the Expert Render dialog 
box, and then choose another drive before continuing. Alternatively, you 
can click Continue to attempt to render the effects anyway, in case there 
might be enough space on the drive.

n To display the estimated processing time during rendering, press the T key 
on the keyboard. Press the T key again to clear the display. Press the P key 
to view percent rendered.

Modifying ExpertRender Results

You can modify the results of an ExpertRender analysis, removing effects 
that you do not want to render and adding others that you do want to 
render.

In most cases, the results of an ExpertRender analysis will offer the fastest 
rendering necessary for successful playback. You should modify the results 
of an ExpertRender analysis only if you are confident that your 
modifications are useful. For examples of situations where you might want 
to modify the results of an ExpertRender analysis, see “Considerations 
When Using ExpertRender” on page 187.

If you render the results of an ExpertRender analysis without making any 
modifications, the material you submitted to ExpertRender will usually 
play back successfully in real time. If you render recommended ranges, the 
material will play back successfully for preview purposes; if you render the 
entire selection, the material will play back successfully for output.

To modify the results of an ExpertRender analysis:

1. Perform an ExpertRender by following steps 1 through 3 in “Using 
ExpertRender to Render Effects” on page 179.

2. In the Expert Render dialog box, click Modify Selection.

3. Shift+click effects in the Timeline to add them or remove them from 
the set of effects to render.

Effects currently selected are highlighted.



 Chapter 4 Playing, Previewing, and Rendering Effects

186

4. When you are satisfied with your selections, click the Render Effect 
button in the Effect Editor or in the Tool palette.

For information on opening the Tool palette, see “Using the Tool 
Palette” in the chapter “Viewing and Marking Footage” in the user’s 
guide.

The Render Effect dialog box appears.

n To prevent this dialog box from appearing, press and hold the Alt key 
(Windows) or Option key (Macintosh) when you click the Render Effect 
button. The system will use the last drive selected.

5. Select a drive for the rendered media from the pop-up menu. 

The Effect Source Drive is the drive where the media on the outgoing 
shot of a transition resides.

6. Click OK.

Avid Xpress DV renders the highlighted effects.

n If the drive is near capacity, a message box appears and warns you that 
there might not be enough space to store the rendered effect. You can click 
Stop to stop the rendering process and return to the Render Effect dialog 
box, and then choose another drive before continuing. Alternatively, you 
can click Continue to attempt to render the effects anyway, in case there 
might be enough space on the drive.

n To display the estimated render time during rendering, press the T key on 
the keyboard. Press the T key again to clear the display. Press the P key to 
view percent rendered.
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To cancel ExpertRender during the modification process, do one of 
the following:

t Click in the timecode track to move the position indicator.

t Double-click one of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline.

t Choose an ExpertRender command from the Clip menu, and then click 
Cancel in the Expert Render dialog box.

ExpertRender removes all its highlighting and cancels the 
ExpertRender process without rendering any effects.

Considerations When Using ExpertRender

When you work with ExpertRender, you should be aware of the following 
aspects of its operation:

• ExpertRender operates on all selected tracks in the Timeline, including 
any enabled tracks that might be above the currently monitored track. 
To view the material that you are submitting to ExpertRender 
accurately in the Composer monitor, make sure that you are 
monitoring the topmost selected track in the sequence.

• ExpertRender takes account of all tracks at or below the topmost 
selected track when determining what to render on the selected tracks 
to achieve successful playback. For example, if you have a sequence 
with tracks V1 to V4, and select tracks V3 and V4 when using 
ExpertRender, the system considers tracks V1 and V2 when 
determining playback possibilities but highlights effects to render only 
from tracks V3 and V4.

• If the material you submit to ExpertRender includes an effect in a 
segment that also contains nested effects, ExpertRender always renders 
the effect on the top (outside) track rather than the effect inside the 
nest. In certain circumstances, this might limit your workflow 
flexibility. For example, you might anticipate the need to readjust the 
parameters of the effect outside the nest and the effect would then 
require rerendering. You can use the procedure described in 
“Modifying ExpertRender Results” on page 185 to select the effect 
within the nest for rendering and deselect the effect outside the nest.
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• In some circumstances where segment effects and transition effects are 
adjacent in a sequence, ExpertRender might recommend the segment 
effects for rendering when rendering the transition effects might be 
quicker or more convenient and still allow for successful playback. 
You can use the procedure described in “Modifying ExpertRender 
Results” on page 185 to modify the combination of effects for 
rendering.

Managing Effect Media Files

Avid Xpress DV allows you to view effect media files and select them for 
deletion. You can quickly find or delete an effect media file from a bin, or 
you can use the Media tool to view all the files that relate to your project 
and select those you want to delete.

When you render an effect, Avid Xpress DV creates two elements: a 
rendered effect clip (also known as a precompute clip) and an associated 
media file. When you create a title or an imported matte key clip, 
Avid Xpress DV creates several elements: an effect clip, a precompute clip, 
and associated media files.

Your system overwrites or automatically deletes a media file from your 
drive only if you:

• Render an effect two or more times with the Render Effect button.

• Close the project before either an Auto Save or a manual save occurs.

In this case, Avid Xpress DV automatically saves the last-rendered effect 
and deletes the earlier, unreferenced versions. This autodeletion applies 
only to effects rendered since the last save or project close.

This prevents you from deleting media that might be necessary to play 
other versions of the sequence. If you want to remove media files from 
your drive to save space, you have to manually delete the files.

For complete information on Avid Xpress DV media management features 
and on the use of the Media tool, see the chapter “Managing Media Files” 
in the user’s guide.
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Revealing Effect Media Files

You can reveal the media files associated with effect clips (titles and matte 
keys), rendered effect clips (precompute clips), and motion effects so that 
they are visible in their folders on the desktop. You can then verify 
information about the media files, delete them directly from the folder, or 
perform other standard file management operations.

To reveal effect clip, rendered effect clip, or motion effect media 
(Windows):

1. (Option) If you want to reveal effect media for rendered effect clips 
(precompute clips), display those clips in the bin by doing the 
following:

a. Choose Set Bin Display from the Bin menu.

The Set Bin Display dialog box appears.

b. Select Rendered Effects and “Show reference clips,” and then click 
OK.

Any rendered effect clips appear in the bin.

2. Select an effect item in the bin.

In this example, a Title Effect clip is selected.

Rendered effect 
(precompute) 
clips
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n You can reveal media files for only one item in a bin at a time.

3. Choose Reveal File from the File menu.

Avid Xpress DV searches all available drives, opens the folder in 
Windows Explorer, and highlights a related media file.
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4. (Option) If more than one media file is associated with the clip, 
Avid Xpress DV displays a message box prompting you to reveal the 
next file. Do one of the following:

t Click OK to reveal the next file.

If the Explorer window disappears from view, bring it forward by 
pressing and holding the Alt key and pressing the Tab key until 
you select the Explorer window containing the OMFI MediaFiles 
folder information.

t Click Cancel to end the Reveal File operation.

To reveal effect clip, rendered effect clip, or motion effect media 
(Macintosh):

1. (Option) If you want to reveal effect media for rendered effect clips 
(precompute clips), display those clips in the bin by doing the 
following:

a. Choose Set Bin Display from the Bin menu.

The Set Bin Display dialog box appears.

b. Select Rendered Effects and “Show reference clips,” and then click 
OK.

Any rendered effect clips appear in the bin.

2. Select an effect item in the bin.

In this example, a Title Effect clip is selected.

n You can reveal media files for only one item in a bin at a time.
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3. Choose Reveal File from the File menu.

Avid Xpress DV searches all available drives, opens the folder, and 
highlights related media files.

Deleting Effect Media Files from a Bin

You can delete effect media files (for titles, matte key clips, and rendered 
effects) and motion effect media from a bin by using the Delete dialog box.

To delete effect media files and motion effect media:

1. (Option) If you want to delete effect media for rendered effect clips 
(precompute clips), display those clips in the bin by doing the 
following:

a. Choose Set Bin Display from the Bin menu.

The Set Bin Display dialog box appears.

b. Select Rendered Effects and “Show reference clips,” and then click 
OK.

Any rendered effect clips appear in the bin.

2. In the bin, select the clip or clips whose media you want to delete.

In this example, two items are selected: a title and a motion effect.
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3. Press the Delete key.

The Delete dialog box appears.

4. Select the appropriate check boxes for the material you want to delete, 
and then click OK.

For example, to delete only effect media files, select “delete n 
associated media file(s)” beneath each of the appropriate effect clip 
types and deselect all other check boxes. Make sure that you select 
only those file types you want to delete.
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Chapter 5

Creating Motion Effects

This chapter describes how to create and customize effects that alter 
motion in a clip either by changing the speed at which the video plays or 
by creating a strobe motion effect. It also describes how to stabilize a clip 
that exhibits unwanted motion, such as motion from an unstable camera.

• Understanding Motion Effects

• Creating Motion Effects

• Stabilizing an Image
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Understanding Motion Effects

You create motion effects by generating a new clip with specific motion 
characteristics from an original clip that you open in the Source pop-up 
monitor. You then edit the Motion Effect clip into your sequence.

The three main types of motion effects are:

• Freeze Frame — Creates a clip that repeats a single frame from the 
original clip.

• Variable Speed — Changes the speed at which movement takes place 
in the clip. For example, if you begin with a 3-second clip and create a 
Variable Speed motion effect from that clip with the speed set to 50%, 
the result is a new 6-second clip in which movement takes place at half 
the speed of the original clip.

• Strobe Motion — Creates a stuttering effect in the playback of the clip 
by repeating certain frames from the original clip several times. 

You can also combine Variable Speed and Strobe Motion effects in a single 
clip.

Creating Motion Effects

A motion effect, applied to a clip in the Source pop-up monitor, allows you 
to alter the playback characteristics of the clip.

Avid Xpress DV creates a motion effect by creating a new clip in a bin. 
You then edit the clip into your sequence using standard editing 
techniques.
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Rendering Considerations When Creating Motion Effects

Avid Xpress DV creates motion effects using one of four different types — 
Duplicated Field, Both Fields, Interpolated Field, and VTR-Style. You 
choose motion effect types based on the quality you need for the final 
motion effect, the rendering time that each type requires, and the media 
with which you are working (some types are useful only when you are 
working with two-field media).

Motion effect clips must be rendered before they can be played.

Information about the type and render status of motion effects appears in 
the Timeline in the same form as that used for other effects. Each motion 
effect type has a distinct effect icon, as shown in the following illustration.

 The following illustration shows typical examples of Motion Effect icons 
in the Timeline.

n In the Timeline, Motion Effect icons have a blue dot before rendering. 
Rendering removes the dot.

Duplicated Field Motion Effect icon

Both Fields Motion Effect icon

Interpolated Field Motion Effect icon

VTR-Style Motion Effect icon

Rendered VTR-Style 
motion effect (no dot)

Unrendered Both Fields 
motion effect (orange dot 
— plays in real time)

Unrendered Interpolated Field
motion effect (blue dot — 
plays as a Duplicated Field 
motion effect until rendered)
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When you render motion effects, Avid Xpress DV checks the Motion 
Effects Render Using option in the active Render setting. If the Motion 
Effects Render Using option is set to Original Preference (the default 
setting), Avid Xpress DV makes no change to the type of motion effects 
when it renders them. If the Motion Effects Render Using option is set to a 
specific motion effect type, Avid Xpress DV changes all motion effects to 
that type when it renders them. This option is particularly important for 
controlling the look of motion effects when you are working with two-field 
media. 

Whenever Avid Xpress DV changes the motion effect type during a 
rendering operation, a message appears in the Console window, providing 
information about the change. For more information, see “Creating and 
Using Render Settings” on page 168 and “Displaying Information About 
Motion Effect Type Changes” on page 198.

n You need to render any motion effect if you did not render that effect at the 
time you created it.

Displaying Information About Motion Effect Type Changes

Whenever motion effects in the Timeline are rendered or rerendered, 
Avid Xpress DV uses the Motion Effects Render Using option in the active 
Render setting to define the motion effect type for the new versions of the 
motion effects. For example, you might start a project using single-field 
media and the Duplicated Field type for motion effects. Later, you might 
rerecord the media at a two-field resolution, set the Motion Effects Render 
Using option in the active Render setting to VTR-Style, and submit the 
whole sequence for rendering. By doing this, you create new motion 
effects that are higher quality and that can play with the two-field media.

n Changes to motion effect types are permanent changes to both the Motion 
Effect clip and its associated media. You can return to the old motion effect 
type only by rerendering. To avoid unnecessary rerendering, make sure 
that the Motion Effects Render Using option in the active Render setting is 
set to the motion effect type you need.
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Avid Xpress DV writes a message in the Console window whenever it 
changes the type of motion effect during rendering. You can check these 
messages to verify the changes that Avid Xpress DV has made to your 
motion effects. Motion Effect icons in the Timeline also change to reflect 
the new motion effect type.

To display information about motion effect type changes in the 
Console:

1. Choose Console from the Tools menu.

The Console window opens.

2. Render one or more motion effects by using one of the procedures 
described in “Rendering Effects” on page 167.

For each motion effect whose type is changed by rendering, a message 
appears in the Console window.

The following illustration shows a typical message. In this example, 
the Motion Effects Render Using option in the active Render settings is 
set to Interpolated Field.

3. (Option) If the new motion effect type is not the one you want, change 
the Motion Effects Render Using option in the active Render settings, 
and then rerender the motion effects.

Freeze Frame Effects

A Freeze Frame effect is a still image, based on a chosen frame from a clip, 
that continues to display for the duration that you choose. When combined 
with the original clip, the footage plays and then “freezes” and holds on the 
frame that you specified.
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Creating a Freeze Frame

To create a Freeze Frame effect:

1. Open a clip in the Source pop-up monitor.

2. Cue the clip to the frame that you want to freeze.

3. Choose Freeze Frame from the Clip menu.

4. Choose Two Field Freeze Frames, and then choose one of the 
following:

- Using Duplicated Field — Avid Xpress DV creates the effect 
using a single field. While this reduces the vertical resolution of 
the image by one-half, it is often the best option if the source 
footage contains rapid motion.

- Using Both Fields — Avid Xpress DV uses both fields to create 
the effect. This option is especially useful when there is little or no 
motion in the footage since it preserves all vertical resolution.

- Using Interpolated Field — Avid Xpress DV creates a second 
field for the effect by combining scan line pairs from the first field 
in the original media. This might result in a slightly softer look to 
the freeze frame.



Creating Motion Effects

201

n For more information on these options, see “Motion Effect Parameters” on 
page 338.

The chosen option becomes the default until you choose another 
option.

5. If you made a Two Field Freeze Frames choice in step 4, choose 
Freeze Frame from the Clip menu again.

6. Do one of the following:

t Choose a preconfigured duration.

t Choose Other and type a custom duration in the dialog box; then 
click OK to enter the new duration.

A dialog box appears, prompting you to choose a target drive for the 
freeze frame media.

7. Choose a drive from the pop-up menu, and click OK.

A new clip appears in the Source pop-up monitor and in the current bin 
preceded by a Motion Effect icon. The new clip has the original clip 
name followed by the letters FF.

Controlling a Freeze Frame with a Single Button or Key

You can map the Freeze Frame command to a button or key. Avid Xpress 
DV remembers the duration of the freeze frame and the option for two-
field media if appropriate. After you have mapped the command, you can 
create a freeze frame of the same type and duration simply by clicking the 
button or pressing the key.
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To map the Freeze Frame command to a button or key:

1. Choose Freeze Frame from the Clip menu, choose Two Field Freeze 
Frames, and then choose one of the following:

- Using Duplicated Field — Avid Xpress DV creates the effect 
using a single field. While this reduces the vertical resolution of 
the image by one-half, it is often the best option if the source 
footage contains rapid motion.

- Using Both Fields — Avid Xpress DV uses both fields to create 
the effect. This option is especially useful when there is little or no 
motion in the footage since it preserves all vertical resolution.

- Using Interpolated Field — Avid Xpress DV creates a second 
field for the effect by combining scan line pairs from the first field 
in the original media. This might result in a slightly softer look to 
the freeze frame.

n For more information on these options, see “Motion Effect Parameters” on 
page 338.

2. Do one of the following:

t To map to a button, open the Tool palette.

For information on opening the Tool palette, see “Using the Tool 
Palette” in the chapter “Viewing and Marking Footage” in the 
user’s guide.

t To map to a key, open the Keyboard palette by double-clicking 
Keyboard in the Settings scroll list of the Project window.

3. Choose Command Palette from the Tools menu.

The Command palette opens.

4. Select Menu to Button Reassignment.

5. Do one of the following:

t To map to a button, click a blank button in the Tool palette.

t To map to a key, click a blank key in the Keyboard palette.

6. Choose Freeze Frame from the Clip menu.
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7. Do one of the following:

t Choose a preconfigured duration.

t If you want to type a custom duration when you create a freeze 
frame using the button or key, choose Other.

Avid Xpress DV maps the Freeze Frame menu command to the button 
or key.

8. Close the Command palette.

Creating a Rolling Clip That Freezes

One common use for freeze frames is to create a segment that plays 
normally and then freezes, either to superimpose text information or to add 
emphasis to the end of a sequence before fading.

To create a rolling clip that freezes:

1. Edit the clip into the sequence.

2. Mark an IN point in the sequence at the frame where you want the 
freeze frame to occur.

3. Create the Freeze Frame effect from the source footage as described in 
“Creating a Freeze Frame” on page 200. 

4. Click either the Splice-in button or the Overwrite button in the Tool 
palette to edit the freeze frame into the sequence at the previously 
marked IN point.

For information on opening the Tool palette, see “Using the Tool 
Palette” in the chapter “Viewing and Marking Footage” in the user’s 
guide.

When you play the sequence, the footage plays full-motion and then 
freezes at the chosen frame.
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Creating a Variable Speed Effect

Variable Speed effects involve changing the rate of playback to achieve 
fast-motion or slow-motion effects. Avid Xpress DV creates slow-motion 
effects by duplicating frames in the original media. It creates fast-motion 
effects by eliminating frames from the original media.

To create a Variable Speed effect:

1. (Option) If you require a fixed duration for the clip based on a segment 
in the sequence, mark the segment in the Timeline with IN and OUT 
points.

2. (Option) If you want to use only part of the source clip for the motion 
effect, mark IN and OUT points in the Source pop-up monitor.

3. Click the Motion Effect button in the Source pop-up monitor.

The Motion Effect dialog box appears.

Variable Speed 
option 
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4. Select the Variable Speed option.

5. Specify the play speed for the Variable Speed motion effect by doing 
one of the following: 

t Type a number of frames in the Frames text box.

t Type a frame rate in the FPS text box. To indicate reverse motion, 
enter a negative number for the play rate.

t Type a percentage of the current play rate in the % Speed text box. 
To indicate reverse motion, enter a negative number for the 
percentage.

t Select Fit To Fill to automatically set the Variable Speed 
parameters so that the duration of the motion effect will match the 
IN to OUT duration marked in the Composer monitor.

When you set one of these, all values change to reflect the specified 
play rate.

6. (Option) If Original Preference is set as the Motion Effects Render 
Using option in the active Render setting, select one of the following 
four available options:

- Duplicated Field — Avid Xpress DV creates the effect using one 
field.

- Both Fields — Avid Xpress DV creates the effect using both 
fields.

- Interpolated Field — Avid Xpress DV creates a second field for 
the effect by combining scan line pairs from the first field in the 
original media.

- VTR-Style — Avid Xpress DV creates a second field for the effect 
by shifting selected video fields of the original media by a full scan 
line. This technique is similar to that used by high-quality 
professional video decks when playing footage at less than normal 
speed.

n For more information on these options, see “Motion Effect Parameters” on 
page 338.
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7. (Option) If a specific motion effect type is set as the Motion Effects 
Render Using option in the active Render setting, Avid Xpress DV 
automatically selects that type in the Motion Effect dialog box, makes 
all other types unavailable, and displays the Ignore Render Setting 
check box. If you want to override the Render setting, click the Ignore 
Render Setting check box, and then select one of the four options 
described in step 6.

8. Complete the effect by doing one of the following:

t Click Create to create the new clip and close the dialog box. 
Another dialog box asks you to choose the bin for the effect.

t Click Create and Render to render the clip — creating new media 
files — and close the dialog box. Another dialog box asks you to 
choose the bin for the effect.

A new clip appears in the Source pop-up monitor and in the current 
bin. The clip has the original clip name followed by the frame rate in 
parentheses. You can then edit this clip into your sequence as you 
would any other clip.
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Using the Fit to Fill Button

You can create a Variable Speed effect that is automatically sized to fit a 
marked IN to OUT duration in a sequence by clicking the Fit to Fill button.

The Fit to Fill button is located on the Edit tab of the Command palette. 
This button performs an overwrite edit and uses a motion effect to fill the 
marked record duration. When you click the Fit to Fill button, the system 
automatically selects variable-speed parameters so that the duration of the 
motion effect matches the IN to OUT duration marked in the Composer 
monitor. The system then overwrites the motion effect into the sequence.

The motion effect you create with the Fit to Fill button uses the parameters 
you set in the Render Settings and Media Creation dialog boxes. If the 
Render preference is set to Original Preference, the new motion effect is 
rendered with duplicated fields.

n To create an unrendered motion effect, press the Alt key (Windows) or the 
Option key (Macintosh) when you click the Fit to Fill button.

Creating a Strobe Motion Effect

Strobe motion results in a stuttering effect during playback of a clip. You 
determine the degree of the “stutter” when you create the effect.

n You can also combine the Strobe Motion effect with the Variable Speed 
effect. For more information on the Variable Speed effect, see “Creating a 
Variable Speed Effect” on page 204.

To create a Strobe Motion effect:

1. (Option) If you want to use only part of the source clip for the effect, 
mark IN and OUT points in the Source pop-up monitor.

2. Click the Motion Effect button in the Source pop-up monitor.

The Motion Effect dialog box appears. 
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3. Select the Strobe Motion option.

4. Specify the update rate in frames for the Strobe Motion effect. For 
example, a rate of 5 causes every fifth frame to be held for five frames 
before updating in the Strobe Motion effect. 

5. (Option) If Original Preference is set as the Motion Effects Render 
Using option in the active Render setting, select one of the following 
four available options:

- Duplicated Field — Avid Xpress DV creates the effect using one 
field.

- Both Fields — Avid Xpress DV creates the effect using both 
fields.

- Interpolated Field — Avid Xpress DV creates a second field for 
the effect by combining scan line pairs from the first field in the 
original media.

Strobe Motion option 
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- VTR-Style — Avid Xpress DV creates a second field for the effect 
by shifting selected video fields of the original media by a full scan 
line. This technique is similar to that used by high-quality 
professional video decks when playing footage at less than normal 
speed.

n For more information on these options, see “Motion Effect Parameters” on 
page 338.

6. (Option) If a specific motion effect type is set as the Motion Effects 
Render Using option in the active Render setting, Avid Xpress DV 
automatically selects that type in the Motion Effect dialog box, makes 
all other types unavailable, and displays the Ignore Render Setting 
check box. If you want to override the Render setting, click the Ignore 
Render Setting check box, and then select one of the four options 
described in step 5.

7. Complete the effect by doing one of the following:

t Click Create to create the new clip and close the dialog box. 
Another dialog box asks you to choose the bin for the effect.

t Click Create and Render to render the clip — creating new media 
files — and close the dialog box. Another dialog box asks you to 
choose the bin for the effect.

n If you do not render a Strobe Motion effect when you first create it, the 
effect will play back as filler until you render it.

A new clip appears in the Source pop-up monitor and in the current bin 
preceded by a Motion Effect icon. The new clip has the original clip 
name followed by the word Strobe and the number of update frames in 
parentheses.
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Stabilizing an Image

The Region Stabilize effect eliminates unwanted motion in a video clip, 
such as motion from an unstable camera.

n The Region Stabilize effect is available as part of the Avid Xpress DV 
PowerPack and installs from the PowerPack CD-ROM. For more 
information on this installation, see the Avid Xpress DV Getting Started 
Guide.

Region Stabilize allows you to select an area of the image that you want to 
remain stationary and then uses the information to reposition each frame in 
the clip to keep the region steady.

Stabilization exposes black around the edges of the repositioned frames. 
You can resize (and, if necessary, reposition) the rendered clip to remove 
the exposed edges. Auto Zoom, in the Options parameter category, does 
this automatically.

The following illustration shows the Region Stabilize parameters.

To stabilize a segment:

1. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

2. Click the Image category.
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3. Drag the Region Stabilize Effect icon to the segment you want to 
stabilize.

4. Choose Effect Editor from the Tools menu.

A wire frame appears in the Effect Preview monitor to indicate the 
region of interest. This is the area you want to use in stabilizing the 
image.

5. Reposition and resize the wire frame by doing one of the following:

t Use the sliders in the Region of Interest parameter category.

t Click the wire frame, and drag it in the Effect Preview monitor.

Select a region that contains one or more features that do not change 
much from frame to frame, for example, objects such as buildings or 
rocks. Another approach is to shoot the scene with stabilization in 
mind: include an object, such as a reflective sticker, that you intend to 
use as your region of interest.
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6. Select the type of stabilization from the Model Fast menu:

- Translational keeps the region of interest steady along both the 
horizontal and the vertical axis.

- Horizontal constrains horizontal motion in the region of interest. 
Features in the region of interest can move vertically but not 
horizontally.

- Vertical constrains vertical motion in the region of interest. 
Features in the region of interest can move horizontally but not 
vertically.

7. (Option) To turn on Auto Zoom, open the Options parameter category 
and click the Auto Zoom button.

Stabilization exposes black around the edges of the repositioned 
frames. Auto Zoom compensates by resizing and, if necessary, 
repositioning the clip to remove the exposed edges.

8. (Option) If your footage was captured or converted to progressive 
footage (is not interlaced), open the Options parameter category and 
click the Progressive Source button.

If your sources are progressive, enabling this button produces 
smoother results.

9. Render and review the effect.

If the rendered clip does not perform as expected, see “Making 
Adjustments to the Region of Interest” on page 213.

10. (Option) Add keyframes to further refine the motion of the stabilized 
clip.

For more information, see “Understanding Keyframes” on page 98.

11. Continue to review and refine the effect until you achieve the results 
you want.

12. (Option) Resize and, if necessary, reposition the clip to eliminate black 
edges.
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Making Adjustments to the Region of Interest

If the Region Stabilize effect does not perform as expected, it might be due 
to one of the following:

• Large motion. If an object in your region of interest moves too far 
away from the region from one frame to the next, the rendered clip 
might display unexpected results.

• Extraneous motion. Something in your region of interest might move 
over the course of the clip in a way that unpredictably affects the 
stabilization.

• Insufficient texture. The region of interest might not have enough 
features to allow Region Stabilize to track it effectively.

When you encounter unexpected results in a rendered Region Stabilize 
effect clip, experiment with the following adjustments:

• Increase the size of the region of interest, or reposition it, to encompass 
large motion.

• Decrease the size of the region of interest to eliminate extraneous 
motion that is affecting the stabilization.

• Choose a new region of interest.

• Add keyframes to reestablish or refine the region of interest over the 
course of the clip.
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Chapter 6

Creating Layered and 
Nested Effects

This chapter describes how to apply multilayer effects to your sequence. 
Layered effects consist of two or more layers of video built up vertically in 
the Timeline that play back simultaneously with effects such as Picture-in-
Picture, Superimpose, or Submaster applied to the tracks. Nested effects 
consist of one or more effect layers that are contained within another effect 
on the same video layer. 

The methods and concepts for creating multilayer effects — described in 
the following sections — build on the procedures for creating single-layer 
effects described in Chapter 2.

• Creating Key Effects

• Working with Imported Graphics and Animation

• Nesting Effects

• Submaster Editing

• Performing a Video Mixdown
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Creating Key Effects

Avid Xpress DV supports the following key effects:

• Chroma Key — Replaces one part of the video image with another 
video image based on color

• Luma Key — Replaces one part of the video image with another 
video image based on luminance (brightness)

• Matte Key — Replaces one part of the video image with another 
video image or graphic based on the location of a high-contrast image 
known as a matte

Creating a Chroma Key Effect

The Chroma Key effect is used most frequently with a foreground image 
shot in front of a highly saturated color screen that is keyed against a 
background image. The following sections describe the process of creating 
these effects.

The Chroma Key effect includes several standard digital video effect 
(DVE) parameters such as scaling, position, and crop in addition to key 
parameters.

Chroma Key Effect Example

Before After
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To create a Chroma Key effect:

1. Create a sequence with two video layers.

For information on creating and editing a sequence, see the chapters 
“First Edits” and “Using the Timeline” in the user’s guide.

2. Edit the background image onto track V1.

3. Edit the foreground image onto track V2.

4. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

5. Click the Key category.

6. Drag the Chroma Key Effect icon from the Effect Palette to the clip on 
track V2.

Avid Xpress DV adds the Chroma Key effect. Ultimatte blue is the 
default key color.

7. Move the position indicator to the segment containing the effect in the 
Timeline, and choose Effect Editor from the Tools menu.

The Effect Editor opens and displays parameters for adjusting the 
chroma key.

8. Open the Key parameter category. 

Ultimatte blue is the default chroma key color. To match the key color 
more closely to the color of the background screen used in the footage, 
proceed with the following step.

Chroma key footage on V2 Chroma Key effect applied to V2 Background footage on V1
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9. (Option) Click the Color Preview window in the Key parameter 
category to display the eyedropper icon, and then drag the eyedropper 
to a representative region of the background screen in the Composer 
monitor.

Avid Xpress DV keys off the primary key color, and the key takes 
effect.

10. Fine-tune the key by enabling additional parameter categories and 
adjusting sliders as necessary.

For more information, including descriptions of Secondary Key and 
Spill Suppression parameters, see “Key Parameters” on page 334.

Creating a Luma Key Effect

Use a Luma Key effect to replace portions of the foreground video with the 
background video based on brightness or luminance. 

To create a Luma Key effect:

1. Create a sequence with two video layers.

For information on creating and editing a sequence, see the chapters 
“First Edits” and “Using the Timeline” of the user’s guide.

2. Edit the background image onto track V1.

3. Edit the foreground image onto track V2.

4. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

5. Click the Key category.

6. Drag the Luma Key Effect icon from the Effect Palette to the segment 
on track V2.

Color Preview window
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7. Use the eyedropper or the Luma Key sliders to select a brightness 
value in the foreground video.

Avid Xpress DV replaces the corresponding portions of the foreground 
video with background video. For an example, see “Luma Key” on 
page 402.

Creating a Matte Key Effect

The Matte Key effect uses three layers of video to create the effect. The 
bottom layer is the background image, the middle layer is the foreground 
image, and the top layer contains the matte or alpha channel.

To create a Matte Key effect:

1. Create a sequence with three video layers.

For information on creating and editing a sequence, see the chapters 
“First Edits” and “Using the Timeline” in the user’s guide.

2. Edit the background image onto track V1.

3. Edit the foreground image onto track V2.

4. Load a high-contrast image into the Source pop-up monitor, and edit it 
onto track V3. The high-contrast image can be an imported graphic or 
a clip that you adjust within Avid Xpress DV. 

n If the image does not have an alpha channel for keying the graphic over 
video, use the procedure described in “Editing with Imported Master 
Clips” on page 223 to edit the image onto track V3.

n If the image is not high enough in contrast, you can adjust the contrast by 
applying the Color Effect and adjusting its parameters in Effect mode. For 
more information, see “Using the Color Effect to Prepare a High-Contrast 
Image” on page 220.

5. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

6. Click the Key category.
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7. Apply the Matte Key effect as follows:

t If your high-contrast image was created with the Color Effect, 
press and hold the Alt key (Windows) or Option key (Macintosh) 
and drag the Matte Key Effect icon from the Effect Palette onto the 
segment on track V3 to nest the Color Effect within the Matte Key 
effect.

t If your high-contrast image on track V3 does not include a Color 
Effect, drag the Matte Key Effect icon from the Effect Palette onto 
the segment on track V3.

8. Click the Record Track Monitor button for track V3 in the Track 
Selector panel. You should see tracks V2 and V1 through the high-
contrast image on track V3.

9. Move the position indicator to the Matte Key effect, and render the 
effect.

n For an example of a Matte Key effect, see “Matte Key” on page 403.

Using the Color Effect to Prepare a High-Contrast Image

This section describes how to enhance high-contrast images for use in 
creating Matte Key effects.

To create a high-contrast image from available footage:

1. Apply the Color Effect to the clip, and open the Effect Editor.

The Color Effect is in the Image category in the Effect Palette.

2. Drag the Clip slider under Luma Adjust to 255.

3. Drag the Sat (saturation) slider under Chroma Adjust to –100 to 
remove all color saturation from the image.

4. Adjust the Cont (contrast) and Bright (brightness) sliders under Luma 
Adjust until you achieve the right degree of contrast.

The high-contrast image can now be used as a matte for the key effect, 
as described in “Creating a Matte Key Effect” on page 219.
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Black portions of the high-contrast image will be transparent, and white 
portions will be opaque. To switch the order, click Invert Key in the 
Foreground parameter category of the Matte Key effect. For more 
information, see “Foreground” on page 332.

n You can also import a graphic image with an alpha channel and use it as a 
Matte Key effect. See “Editing with Imported Matte Key Clips” on 
page 222.

Working with Imported Graphics and Animation

This section describes two different approaches to editing with imported 
graphic images, depending upon whether:

• The image was imported as a Matte Key clip with an alpha channel (a 
keyable graphic element for video overlay).

• The image was imported as a master clip with no alpha channel (an 
opaque graphic element).

These alternatives apply to both single-frame graphic images and 
animation. In addition, you can edit imported images into sequences by 
using standard Avid Xpress DV effects.

n (Windows only) AVI files cannot be imported with an alpha channel. To 
import animation with an alpha channel, you must use another supported 
format. For more information on importing graphic and animation clips, 
see the chapter “Importing Files” in the user’s guide.

Matte Key clip with 
alpha channel

Graphic master clip 
with no alpha channel
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Editing with Imported Matte Key Clips

When an imported clip includes an alpha channel for keying the graphic 
over video, it appears in the bin with a key effect icon.

Both single-frame graphic images (such as a single JPEG file) and 
multiple-frame animation sequences (such as a JPEG file sequence) appear 
in the bin in the same form after import, and you use the same editing 
techniques for both. You can edit this type of clip into a sequence as a 
standard matte key overlay.

To edit a Matte Key clip into the sequence:

1. Edit the main video sequence.

2. Add a new track above the tracks in the sequence by choosing New 
Video Track from the Clip menu.

n You must edit Matte Key clips onto an upper track to achieve the keying 
effect. If you edit a Matte Key clip onto track V1, for example, the image is 
keyed over black unless track V1 contains nested tracks.

3. Play the sequence, and mark an IN point and an OUT point where you 
want to overlay the graphic.

4. Load a Matte Key clip into the Source pop-up monitor. Mark an IN 
point toward the center of the clip if it is a still.

5. Drag the Matte Key clip from the Source pop-up monitor onto the 
upper track (V3 in this example).

Avid Xpress DV keys the graphic over the video on the lower tracks.

In the following example, the graphic appears on track V3 above the 
main video sequence edited onto tracks V1 and V2.

Matte Key graphic keyed over video
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6. Adjust effect parameters in the Effect Editor, if necessary, using 
procedures described in “Using the Effect Editor” on page 86.

n If the keyed portions of the images are the reverse of the intended effect, 
click Invert Key in the Foreground parameter category. For more 
information, see “Foreground” on page 332.

7. Use the standard effect editing procedures to preview, render, or play 
the Matte Key clip.

n Make sure the Record Track Monitor button for the topmost track is 
selected in the Track Selector panel to see the complete effect.

Editing with Imported Master Clips

When an imported clip does not include an alpha channel for keying the 
graphic over video, its icon is the standard master clip icon. This is true for 
both single-image graphics and animation sequences. You can edit this 
type of clip into a sequence as an opaque image or animation (in other 
words, as a single layer) by using basic editing techniques described in this 
section.

To edit an imported master clip into the sequence:

1. Double-click the graphic clip icon to open a Source pop-up monitor.

2. Create a sequence in the Timeline.

3. In the Source pop-up monitor, mark an IN point at the start of the clip 
and mark an OUT point to specify the duration of the graphic.

4. In the Composer monitor, mark an IN point where you want to edit the 
graphic clip into the sequence.

5. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline.

6. Drag the clip to the Timeline to add the opaque graphic to the 
sequence.

The opaque image appears in the sequence. In the Timeline, the 
graphic looks like a standard video clip edited into the sequence.

7. Play the clip, using the standard playback procedures.
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Nesting Effects

You can use Avid Xpress DV to place effect tracks inside one another to 
better combine multiple images and digital video effects (DVEs). This 
involves a process known as nesting, which allows you to use the Timeline 
to step into a track, perform a series of editing operations, and then step out 
to view and render the effect as one segment on the track.

You can edit up to four video track layers. Into each layer of video, you can 
nest (stack inside) up to four additional video tracks. You can also step into 
each video track indefinitely, constrained only by your system’s memory.

n Nested effects must be rendered in order to play back correctly.

You can use nesting when you want to create layered effects. In this case, 
the nested layers are treated as one element during the transition. Since 
transition effects, such as dissolves, fades, and wipes, are not multilayered, 
nesting is not applicable to these types of effects; nor are nesting effects 
applicable to audio tracks.

n Some effects do not work well with each other when nesting. For example, 
the Box Wipe effect and Edge Wipe effect cannot be used together in a 
nested segment because the two effects are competing to establish the 
shape of the wipe.

Another use of nesting is to constrain one effect using another effect. For 
example, you can use the Circle Wipe effect to constrain an image 
posterization inside a region.

Effects nested 
inside a 
Submaster effect

Additional nested 
layers inside the 
first nest
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Expanding Nested Effects in the Timeline

You can expand an existing nested effect for editing within the Timeline. 
You can then add new tracks, edit source material into the tracks, apply 
effects, and adjust effects on the nested tracks. Any segment with a 
segment effect applied can be expanded in this way.

To expand a nested effect, do one of the following:

t Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline, and then double-click the nested 
effect to expand the effect within the Timeline.

t With the Effect Editor open, double-click the nested effect.

The nested tracks appear in the Timeline above the track you double-
clicked. Editing and patching features are available for changing the 
content of the track’s effect.

To step out of the nested effect

t Double-click the effect’s icon in the Timeline.

Stepping Into and Out of Nested Effects

You can step into an existing nested effect for editing. When you step into 
the effect, Avid Xpress DV replaces the full sequence in the Timeline with 
just the tracks that make up the nested effect. You can then add new tracks, 
monitor individual tracks, edit source material into the tracks, apply 
effects, and adjust effects on the nested tracks. You can step into any 
segment effect in this way.

n You can also expand nested effects while leaving the rest of the sequence 
visible in the Timeline. See “Expanding Nested Effects in the Timeline” on 
page 225.
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To step into a nested effect:

t Click the Step In button.

To step out of a nested effect:

t Click the Step Out button.

n The Step In and Step Out buttons appear by default in the Timeline toolbar, 
and are also available in the Command palette. For more information, see 
“Customizing Timeline Views” in the chapter “Using the Timeline” and 
“Using the Command Palette” in the chapter “Using Basic Tools” in the 
user’s guide.

Creating a Simple Nested Effect

This example involves nesting a sequence of clips with dissolves inside 
another segment effect.

To create the nest:

1. Create a sequence, and add a segment effect.

2. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline, and then double-click the 
segment.

The segment opens to reveal the nested tracks.
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3. Edit new footage into the nested tracks, and apply additional effects as 
necessary.

In this example, a series of clips is edited onto nested track 1.2, with 
dissolves applied between the shots. The Picture-in-Picture effect 
applies to the entire nested dissolve sequence.

4. Double-click the main track for the nested effect (V2 in this example) 
to close the nested tracks again.
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Changing the Order of Nested Effects

When you use advanced keyframes with nested effects, you can change the 
order of nested effects by manipulating the Nesting Priority icons that 
appear in the Effect Editor.

If the effect you are editing has nested tracks, the effect icon and name of 
each nested effect appears in the Effect Editor. A Nesting Priority icon 
appears in line with each effect name. Click this icon, and drag it to a new 
position to reorder the effects.

To change the order of nested effects:

1. Click the Nesting Priority icon of the effect you want to move.

The pointer changes to a hand, and a white outline appears around the 
selected effect.

2. Drag the outline above the effect you want to have nested inside the 
selected effect, or below the effect inside which you want the selected 
effect to nest.

Nesting Priority icon
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3. Release the mouse button.

The effects move to their new locations, and the Effect Editor display 
changes to reflect the new nesting.

Note the following considerations about the display and manipulation of 
nested effects:

• You can change the nesting order only when the nested effects have the 
same number of internal tracks.

• The Effect Editor does not display layered components of a nested 
effect.

• If there is no effect on the foreground track (V1.2, for example), then 
the Effect Editor looks for a nested effect on the next track stepping in 
(V1.3, V1.4, and so forth). The Effect Editor identifies the first track 
with an effect as the foreground track. Effects on subsequent tracks are 
identified as part of the nested effect.

• The Effect Editor does not display nested effects when the foreground 
track has an add edit.

Nesting a Matte Key Effect

A Matte Key effect uses three layers of video to create the effect.

To nest a Matte Key effect:

1. Create a sequence with the background video on track V1.

2. Load a high-contrast image into the Source pop-up monitor, and edit it 
onto track V2 as described in “Editing with Imported Master Clips” on 
page 223. For an example of a high-contrast image, see “Matte Key” 
on page 403.
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3. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

4. Click the Key category.

5. Drag the Matte Key Effect icon from the Effect Palette to the segment 
on track V2.

6. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline.

7. Double-click the Matte Key Effect icon in the segment. 

The Timeline expands to display three nested tracks (1.1, 1.2, and 1.3). 

By default, nested track 1.3 contains the same image segment as track 
V2. Nested track 1.2 is empty (foreground filler track). Nested track 
1.1 (background video) is also empty.

8. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) again to leave Segment mode.

You can now edit the nested tracks.

9. Edit the foreground image onto nested track 1.1.
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10. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline, and then double-click track V2 to 
collapse the nested tracks.

11. Click the Record Track Monitor button for track V2 in the Track 
Selector panel.

You should see tracks V1 and nested track 1.1 through the high-
contrast image on track 1.3.

For an example of a Matte Key effect, see “Matte Key” on page 403.

Submaster Editing

The Submaster effect is in the Image category of the Effect Palette. When 
you render this effect, Avid Xpress DV creates a single media file from 
several clips or effects in a sequence.

Rendering a Submaster effect saves the new Submaster clip to the drive as 
a single media file. However, Avid Xpress DV leaves untouched each 
element that makes up the composite, so you can still manipulate any 
element. 

The Submaster effect is useful when you want to play back bandwidth-
limited sequences, such as sequences composed of several seconds of 
single-frame clips. It is much faster to use the Submaster effect than to use 
methods such as applying a graphic, Picture-in-Picture, Mask, or Resize 
effect. Normally, Submaster effects render at about the same rate as motion 
effects.
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n You can nest up to four tracks inside a Submaster effect.

n An edit decision list (EDL) for a sequence that contains a Submaster effect 
represents the contents of the Submaster as a single cut. To work around 
this, you can create a new sequence with the contents of the Submaster and 
generate a separate EDL for that sequence.

Applying the Submaster Effect to a Multilayered Sequence

You can use the Submaster effect to speed the rendering process by 
applying it to a track above layered or nested effects and then rendering 
only the Submaster. Avid Xpress DV renders the composite result of all 
tracks into the top track.

n The Submaster effect maintains links to the original media files, so you 
should not delete the original media files. If you want to combine tracks to 
create a sequence that is independent from the original media files, 
perform a video mixdown.

n The Submaster effect does not render each track separately, so you cannot 
play each track individually, and the blue dot remains in the effect icon. In 
addition, you cannot delete or modify a track below a Submaster effect or it 
becomes unrendered.

To apply the Submaster effect to a multilayered sequence:

1. Choose New Video Track from the Clip menu.

2. On the new video track (V5 in this example), use the Add Edit button 
in the Tool palette to create one add edit before and another after the 
group of clips to be submastered.
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For information on opening the Tool palette, see “Using the Tool 
Palette” in the chapter “Viewing and Marking Footage” in the user’s 
guide.

3. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

4. Click the Image category.

5. Drag the Submaster Effect icon to the space between the add edits you 
added on the new track (V5 in this example).

Avid Xpress DV applies the effect above the layers.

Add edit marks on new track V5; bracket clips on track V4
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6. Render the Submaster effect, as described in “Rendering Effects” on 
page 167.

Using the Submaster Effect with a Series of Short Clips

The Submaster effect is useful when you want to play back bandwidth-
limited sequences, such as a sequence composed of a series of short clips 
(a few frames each). You can apply and render the Submaster effect above 
the clips to improve playback.

To apply the Submaster effect to multiple clips:

1. Choose New Video Track from the Clip menu.

2. On the new video track, use the Add Edit button in the Tool palette to 
create one add edit before and another after the group of clips.

For information on opening the Tool palette, see “Using the Tool 
Palette” in the chapter “Viewing and Marking Footage” in the user’s 
guide.

3. Open the Effect Palette by doing one of the following:

t In the Project window, click the Effects tab.

t From the Tools menu, choose Effect Palette.

Submaster effect on track V5
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4. Click the Image category.

5. Drag the Submaster Effect icon to the space between the add edits you 
added on the new track.

6. Render the Submaster effect, as described in “Rendering Effects” on 
page 167.

n If you alter or move either the Submaster segment or the clips below it, the 
effect becomes unrendered. You must render it again.

Collapsing Layers into One Submaster Effect

You can use the Collapse feature to build a multilayer effect and then nest 
the effect within a single Submaster effect in one step.

The Collapse feature allows you to build your effect at the topmost level 
and, when you are finished, collapse the layers automatically into one 
Submaster effect. This feature is useful for simplifying a sequence with 
complex compositing. Once you have collapsed a complex composite, you 
can easily add transition effects to the start and end of the newly created 
Submaster composite effect.

n You can also use the Collapse feature to simplify the deletion of multilayer 
segment effects. After collapsing the effects, you can select the resulting 
segment and press the Delete key twice to delete the effect and all the 
layers.

After the tracks are collapsed into a Submaster effect, Avid Xpress DV 
recognizes a Submaster effect as a multilayer effect instead of a single-
layer effect. This allows you to add chroma keys and other multilayer 
effects to the nested tracks within a Submaster effect.

n You can drag “two-channel” effects (such as chroma key) onto Submaster 
effects if the Submaster segment contains two or more nested tracks. This is 
useful after performing a Collapse operation to composite the newly 
created Submaster over another background.
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To collapse multiple layers into one Submaster effect:

1. Select all the tracks you want to collapse. The tracks must be adjacent.

2. Mark an IN point and an OUT point around the area to be collapsed.

3. Click the Collapse button in the Tool palette.

For information on opening the Tool palette, see “Using the Tool 
Palette” in the chapter “Viewing and Marking Footage” in the user’s 
guide.

Avid Xpress DV collapses the tracks into a Submaster effect on a 
single track.

To open the nested tracks again:

1. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline.

2. Double-click the Submaster effect.

Selected tracks
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To collapse a sequence (alternative procedure):

1. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline.

2. Select the segments you want to collapse. 

3. Click the Collapse button.

Performing a Video Mixdown

Video mixdown allows you to combine several tracks into a new master 
clip.

You can use video mixdown after you have finished building your 
sequence and want to make it into one piece (for example, a standard 
opening to a program). It can be useful for a complex sequence you need to 
use repeatedly or if you want to add a motion effect to an entire sequence. 

Video mixdown is similar to the Collapse feature; the difference is the end 
result. 

• With the Collapse feature, you collapse the tracks into a Submaster 
effect. After you collapse the tracks, you are still able to step in to the 
Submaster and work on the individual elements. 

• With video mixdown, your end result is a new master clip made up of 
all the tracks you built on different layers. Those tracks become one 
clip; you cannot step into the sequence or separate the tracks to work 
on them.

To perform a video mixdown:

1. Select the Record Track Monitor button in the Track Selector panel for 
the highest track you want to include in the video mixdown.

2. Mark an IN point and an OUT point around the area to mix down.
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3. Choose Video Mixdown from the Clip menu.

The Video Mixdown dialog box appears.

4. Choose a target bin and a target drive for storing the new master clip, 
and then click OK.

A progress indicator appears, showing the progress of the video 
mixdown. When the video mixdown is completed, a new clip appears 
in the bin along with the sequence, and a new media file is created on 
the target drive.



Chapter 7

Creating Titles and 
Graphic Objects

The Title tool enables you to create titles that incorporate text, graphic 
objects, imported graphics, and video. This chapter explains how to create 
titles, including graphic objects. Throughout this chapter, the term “title” 
refers to both text and graphics.

• Workflow for Creating Titles

• Opening the Title Tool

• Understanding the Title Tool

• Using the Selection Tool

• Setting Up the Drawing Environment

• Working with Text

• Creating Graphic Objects

• Selecting Colors and Setting Transparency

• Working with Shadows

• Manipulating Objects

• Saving Titles, Title Styles, and Title Templates

• Exporting a Title as a Graphics File
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Workflow for Creating Titles

The following is an overview of the tasks you perform to create a title:

• Set up the drawing environment. After you open the Title tool, you 
choose whether to display a color background or a frame of video from 
your sequence. You can also use safe colors or safe title and action 
guidelines or apply a grid for the placement of objects.

• Create a new title with the Title tool. You create the title by working 
with text and graphic objects and then applying and adjusting borders, 
colors, transparency, and shadows.

• Save the title and exit the Title tool. When you save a new title, you 
select a target drive and a target bin for the title media. You can also 
save just the styles for the title for future use. When you close the Title 
tool, the new title appears in the bin and in the Source pop-up monitor, 
ready for editing.

These basic procedures are described throughout this chapter. For 
information on editing a title into a sequence, see Chapter 8.

Opening the Title Tool

To open the Title tool:

1. In the Composer monitor, move the position indicator to the video 
frame that you want to use as a reference. 

If you are not using video as the background, you can skip this step. 
For more information, see “Selecting a Background” on page 248.

2. Do one of the following:

t Choose New Title from the Clip menu

t Choose Title Tool from the Tools menu.

The Title tool opens. The Text tool is automatically selected, and the 
pointer becomes an I-beam, ready for entering text.
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Understanding the Title Tool

The following illustration shows a title over a video background.

The Title tool has several major components:

• A video background based on a sequence or a color background that 
you create. For more information, see “Selecting a Background” on 
page 248.

• The title or graphic in the foreground that you create. For more 
information, see “Working with Text” on page 251 and “Creating 
Graphic Objects” on page 261.

• The safe title and safe action area guidelines. For more information, 
see “Displaying Safe Title or Safe Action Guidelines” on page 247.

• The toolbar at the bottom of the screen. For more information, see 
“Understanding the Toolbar” on page 242.

Toolbar

Safe action 
area

Video 
background

Title objects

Safe title 
area
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• In addition, title-related menu items are on the File, Edit, Object, and 
Alignment menus. These menu items are described throughout this 
chapter.

Understanding the Toolbar

At the bottom of the Title tool are tools and pop-up menus you can use for 
creating and editing text and objects. They work much like similar tools in 
other draw and paint programs.

Table 7 briefly describes each section of the toolbar.

Text formatting tools

Line attribute 
tools

Shadow tools

Background 
Selection tools

Transparency Selection 
boxes

Color Selection 
boxes

Drawing tools

Video Placement tool

Text tool

Selection tool
Color and Transparency 
Blend tools

Styles button and 
Save Style Parameter button

Templates 
button

Table 7 Title Toolbar Elements

Tool Description

Selection tool Changes the pointer to an arrow and allows you to select text or 
objects for operations. See “Using the Selection Tool” on 
page 244.

Text tool Changes the pointer to an I-beam and allows you to enter text. 
See “Working with Text” on page 251.

Video Placement 
tool

Changes the pointer to a hand and allows you to pan around the 
entire video clip within the Title tool. 
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Drawing tools Allow you to draw boxes, circles, ovals, and lines. See “Creating 
Graphic Objects” on page 261.

Styles button Displays examples of the styles you defined and allows you to 
select one. See “Recalling a Title Style” on page 291.

Save Style 
Parameter button

Displays examples of the styles you defined and allows you to 
select one. See “Saving a Title Style” on page 290.

Templates button Allows you to create a standard format for text and graphics that 
you use regularly. The template prevents you from changing the 
position, colors, shadows, or graphics, which ensures 
consistency. See “Creating and Using Title Templates” on 
page 294.

Line attribute 
tools

Allow you to change the corners of boxes, line and border 
thickness, and arrowhead styles. See “Selecting Line Attributes” 
on page 263.

Background 
Selection tools

Allow you to switch between a video and opaque background 
and change the color of opaque backgrounds. See “Selecting a 
Background” on page 248.

Text formatting 
tools

Allow you to set various text attributes such as font, font size, 
kerning, and leading. See “Formatting the Text” on page 254.

Color Selection 
boxes

Allow you to change the color of text and objects. See “Selecting 
Colors and Setting Transparency” on page 267.

Transparency 
Level boxes

Allow you to change the transparency levels of text and objects. 
See “Adjusting the Transparency” on page 271.

Table 7 Title Toolbar Elements (Continued)

Tool Description
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Using the Selection Tool

The Selection tool is one of the most frequently used tools. You use the 
Selection tool when performing certain operations on objects you create, 
such as moving, formatting, resizing, or applying color.

To select an object:

t Click the Selection tool, and click an object.

Selection handles appear around the object.

To select multiple objects, do one of the following:

t Shift+click with the Selection tool.

t Click outside the objects, and drag to surround the objects with a lasso.

Color and 
Transparency 
Blend tools

Allow you to create a blend between two colors or two 
transparency values. See “Blending Two Colors in an Object” on 
page 268.

Shadow tools Allow you to create drop shadows and depth shadows for text and 
objects and to preview the degree of softness set for shadows. See 
“Working with Shadows” on page 273.

Table 7 Title Toolbar Elements (Continued)

Tool Description

Selection tool

Selection handle for width
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To switch between the Selection tool and the Text tool:

t Alt+click (Windows) or Option+click (Macintosh) anywhere in the 
Title tool.

n After you use a tool in the toolbar, Avid Xpress DV reverts to the Selection 
tool, and the pointer becomes an arrow. To prevent a tool from 
automatically reverting to the Selection tool, double-click the tool’s icon.

Setting Up the Drawing Environment

This section describes some aspects of the Title tool that you can use to set 
up your titling or drawing session.

n You can set or change these features at any time during your work on a 
title. These settings are stored with User settings and will appear each time 
a particular user opens the Title tool.

Installing Fonts

You can apply any font that is installed on your system when creating titles 
in the Title tool. For more information on installing fonts, see your system 
documentation.

When installing and using fonts, consider the following:

• If you want to apply a special font that is not currently on your 
Avid Xpress DV system, you must install the font first before creating 
titles. 

• If you are bringing a project from another system, check to make sure 
you have installed any fonts used in titles contained in the project. 
These fonts must match exactly (you cannot use variations of the font 
in the same font family). If your system does not recognize a font 
contained in a title, the Font Replacement dialog box appears to enable 
you to substitute an alternate font. For more information on font 
replacement, see the Avid Products Collaboration Guide.
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• If you are bringing a project from a system on one platform (Windows 
or Macintosh) to another on a different platform, you might need to 
substitute a new font for an existing font in the project. Windows and 
Macintosh fonts sometimes differ even when they have the same name. 
If your system does not recognize a font contained in a title, the Font 
Replacement dialog box appears to enable you to substitute an 
alternate font. For more information on font replacement, see the Avid 
Products Collaboration Guide.

• If you intend to create titles with font sizes of 128 points or larger, use 
TrueType® fonts. Some non-TrueType fonts cannot display 
consistently at sizes of 128 points or higher.

Previewing Titles

Avid Xpress DV uses anti-aliasing with an 8-bit alpha channel to create 
text and objects in titles. Anti-aliasing ensures that text, lines, and object 
edges appear smooth, regardless of size.

You can preview a title to see the title drawn with anti-aliasing, just as 
Avid Xpress DV would save it. Titles are always saved in anti-aliased 
format.

The display behavior for title objects in Preview mode is as follows:

• You can alter the graphics characteristics of title objects (including 
colors, shadows, borders, and transparency) without losing the anti-
aliased preview.

• You can select text objects and apply text styles from the Styles pop-up 
menu without losing the anti-aliased preview.

• When you click a text object for editing with the Text tool, the text 
displays without anti-aliasing. When you finish editing the text and 
click outside the object to deselect it, the anti-aliased preview is 
restored.
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To display anti-aliased titles:

t Choose Preview from the Object menu.

When you choose Preview, a check mark appears next to the Preview 
command and titles appear with anti-aliasing. When you deselect 
Preview, no check mark appears next to the Preview command and 
titles appear without anti-aliasing.

Displaying Safe Title or Safe Action Guidelines

By default, Avid Xpress DV displays two outlined boxes in the Title tool to 
use as guidelines (see the illustration at the beginning of “Understanding 
the Title Tool” on page 241). The inner box is the safe title area. All text 
for television broadcast should remain within this inner box. The outer box 
is the safe action area for video display. These guidelines are self-adjusting 
for PAL and NTSC projects.

To display the safe title area or safe action area guidelines:

t Choose Safe Title Area/Global Grid from the Object menu.

Using Safe Colors

If you plan to use your title for television broadcast, you can choose the 
Safe Colors command from the Object menu. This command displays only 
low saturation colors for use in text, objects, and background. Colors with 
low saturation look best when combined with video. By default, Safe 
Colors is on.

To display only safe colors:

t Choose Safe Colors from the Object menu.
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Selecting a Background

Use the Video Background button to switch between a video background 
and an opaque color background.

Switching Between Video and Color Backgrounds

If you have a sequence in the Composer monitor, the Title tool opens with 
a video background. The location of the position indicator in the Timeline 
at the time you open the Title tool determines the initial video frame that 
displays. If you have no sequence in the Composer monitor, the Title tool 
opens with no video showing (the background appears black).

The Video Background button is green while you create a title for display 
over a video background.

Use the background video frame as a reference. It does not become part of 
the title you create. You can edit the title anywhere else in the current 
sequence or in another sequence.

To switch between a video background and an opaque color 
background:

t Click the Video Background button.

The V on the button appears green when video background is selected 
and black when an opaque color background is selected.

Background Color window Video Background button
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Updating the Video Background

You can update the video background at any time while creating titles 
within the Title tool.

To update the video background:

1. Click the Video Background (V) button to activate the video 
background if you have not already done so.

The Video Background button changes to green.

2. Move the position indicator in the Timeline or Composer monitor to 
display the new frame.

3. Click again in the Title tool video background to select it.

Avid Xpress DV updates the background to reflect the current contents 
of the Composer monitor.

Creating a Color Background

To create a title that appears over an opaque color background:

1. Click the Video Background (V) button to switch off the video 
background if it is on.

The Video Background button changes to black.

2. Click and hold on the Background Color (Bg) window.

The Title Tool Color Picker opens.

3. Use the Title Tool Color Picker, the eyedropper, the Windows Color 
dialog box, or the Macintosh Color Picker to select a color. For more 
information, see “Selecting Colors and Setting Transparency” on 
page 267. The default background color is black.

n When you create a title with a color background, it is opaque and it cannot 
be used to key over video. 
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Using the Alignment and Snap Grids

You can display an alignment grid to help you position text and objects. 
The visible grid is not part of the title, and Avid Xpress DV does not store 
it when you save the title.

You can also snap text and objects to the snap grid. The snap grid is an 
invisible grid that helps position and connect objects. The snap grid has 
four lines for each line in the visible grid. Each square in the grid is 
subdivided by four invisible vertical and horizontal grid lines. Text and 
objects can snap to these lines.

To display a grid:

t Choose Show Alignment Grid from the Alignment menu.

To snap to a grid:

t Choose Align to Grid from the Alignment menu.

When you create or drag an object in the Title tool, the object snaps to 
the nearest grid line.

Bringing the Title Tool to the Foreground

If the Title tool becomes obscured by another window, you can instruct 
Avid Xpress DV to redisplay the tool. 

To bring the Title tool to the foreground:

t Choose Title Tool from the Windows menu.
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Working with Text

The Text tool is active when you open the Title tool, and you can begin 
entering text as soon as you click in the Title tool.

To use the Text tool at any other time:

t Click the Text tool, click anywhere within the text object, and begin 
typing. 

An I-beam pointer indicates your position within the text. The Text 
tool remains selected until you select another tool.

To switch between the Selection tool and the Text tool:

t Alt+click (Windows) or Option+click (Macintosh) anywhere in the 
Title tool.

n For information on previewing smooth text, see “Previewing Titles” on 
page 246.

Creating Text

To create text:

1. Click the Text tool.

The pointer changes to an I-beam.

2. Click the position in the frame where you want to add text.

An insertion point appears.

3. Type the text. To insert a line return, press Enter (Windows) or Return 
(Macintosh).

n Text is word-wrapped automatically as you type. You can adjust the 
wrapping by changing the width of the text object. For more information, 
see “Resizing Text Objects” on page 253.

4. When you have finished typing, click the Selection tool to deselect the 
text object.

Text tool



 Chapter 7 Creating Titles and Graphic Objects

252

n By default, text is left-justified. To change text justification, see “Justifying 
the Text” on page 258.

After you create a new text object, it may have unused space to the right of 
the text (or to the left, if the text is right-justified). You may want to 
eliminate the unused space, especially if you want to use the Alignment 
menu commands.

To eliminate unused space in a text object:

t Click the middle selection handle on the right side of the text box, and 
drag it to the left until it is closer to the text.

(If the text is right-justified and there is unused space to the left of the 
text, click the middle selection handle on the left side of the text box 
and drag it to the right.)

Copying and Pasting Text

You can copy and paste text into the Title tool directly from a word 
processing or text editing application.

c Avid Xpress DV limits the size of text objects you can create in the 
Title tool. Avoid pasting large blocks of text (numerous pages in a 
word processor) into the Title tool. Instead, consider pasting smaller 
blocks of text into separate text objects.

To copy and paste text into the Title tool:

1. Click the Text tool.

The pointer changes to an I-beam.

2. Click the position in the frame where you want to add text.

An insertion point appears.

3. Open the text file in a word processor or text editor.

4. Select the text in the word processor or text editor, and then choose 
Copy from the Edit menu or press Ctrl+C (Windows) or k+C 
(Macintosh).
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5. Click the Title tool again to activate it. 

6. Press Ctrl+V (Windows) or k+V (Macintosh) to paste the text into 
place at the insertion point.

The pasted text takes on the attributes currently set in the Title tool 
toolbar.

Resizing Text Objects

When you resize a text object, the text remains the same size but rewraps to 
fill the reshaped area.

To resize a text object:

1. Click the Selection tool, and click the text object.

2. Click one of the object selection handles for width, and drag to resize.

n You can resize only the width of a text object. The height of a text object is 
automatically determined by the number of words and the size of text.

Repositioning Text Objects

To reposition a text object:

1. Click the Selection tool, and click the text object.

2. Move the text by doing one or more of the following:

t Click in the middle of the object, and drag it to a new position.

t Use the arrow keys to move the object one pixel at a time.

t Use commands in the Alignment menu to position the text. For 
more information, see “Aligning Objects” on page 281.
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Editing a Text String

To edit an existing text string:

1. Click the Text tool.

2. Click anywhere in the text. 

3. Perform one or more of the following editing tasks as necessary:

t Use the arrow keys to move around within the text string.

t Type additional characters.

t Press Enter (Windows) or Return (Macintosh) to insert a line 
return.

t Drag to select characters.

t Use the Cut, Copy, and Paste commands from the Edit menu.

t Use the Delete key.

t Change the formatting of the selected text, as described in 
“Formatting the Text” on page 254.

Formatting the Text

The text formatting tools control the appearance of text.

You can modify the following text attributes for either a text object or a 
selected text string: 

• Current font

• Point size

• Bold and italic

Text formatting tools
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• Kerning

• Leading

You can modify the following attributes for an entire text object only:

• Color (see “Adjusting the Color” on page 268)

• Transparency (see “Adjusting the Transparency” on page 271)

• Drop and depth shadows (see “Working with Shadows” on page 273)

• Outlined text (see “Selecting a Line or Border Width” on page 264)

• Justification (see “Justifying the Text” on page 258)

While you type text, only the text color is apparent. Shadows, outlines, and 
other color attributes appear when you finish typing the text and click the 
Selection tool.

n If you want to create text elements in the title with different appearances, 
create a separate text object for each set of attributes.

Selecting Text for Formatting

To select all the text within a text object:

t Click the Selection tool, and click the text object.

To select a string of text within a text object to format individual 
characters or words:

t Click the Text tool, and then drag across the text you want to highlight.

Setting the Default Text Attributes

When you start the application and open the Title tool, Avid Xpress DV 
uses default text attributes. You can change the defaults at any time. 
Changes you make to the default text attributes apply until you quit the 
application.
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To change the default text attributes:

1. Click the Selection tool.

2. Click in the Title tool but do not select any text.

3. Change any of the text attributes.

Now whenever you start typing a new text string, Avid Xpress DV uses 
your new defaults.

Changing the Font

The Font Selection menu shows the current font for a text selection and 
allows you to change the font.

When you first open the Title tool, the font listed is the preferred system 
font. If you select an existing text object, the Font Selection menu displays 
the font of the text object.

The Font Selection menu displays all fonts currently installed on your 
system.

To change the font:

t Click the Font Selection button, and choose a font from the menu. 

The system displays the name in the Font Selection menu and uses this 
font for text until you change it during the editing session.

When you select a text object, the Font Selection menu displays the font of 
the text object.

Font Selection button
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Changing the Point Size

The point size controls the size of the selected text. A point is a 
typographical unit of measure. There are 12 points to the pica and 
72 points to the inch. 

You can enter a point size either before or after you type text.

To change the point size, do one of the following:

t Click the Point Size button, and choose a standard point size from the 
pop-up menu.

t Double-click in the Point Size text box, and type a point size between 
5 and 999; then press Enter (Windows) or Return (Macintosh).

t Click in the text box, and use the Up Arrow and Down Arrow keys to 
change the value incrementally.

Making Text Bold or Italic

The Bold and Italic buttons are located under the Point Size text box. 

In addition, the Object menu contains commands for bold and italic.

Point Size buttonPoint Size text box

Point size pop-
up menu

Bold button Italic button
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To change the text style:

t Select the text you want to change and click the Bold button or the 
Italic button, or choose the appropriate command from the Object 
menu.

You can work with Bold and Italic turned on at the same time to make 
text both bold and italic.

Justifying the Text

Below the Font Selection menu are the buttons for text justification. Text 
justification controls the alignment of text in an existing text object and 
also when you type text in a new text object.

To justify the text, do one of the following:

t Click the left button to left justify the text.

t Click the center button to center the text. 

t Click the right button to right justify the text.

Adjusting Text Kerning

Kerning improves the appearance of titles by controlling the amount of 
space between characters. You can expand or condense the character 
spacing to make text more readable or to create special effects, such as 
dramatically expanded spacing in a title.

The text kerning controls are located beneath the text justification buttons.

Text justification buttons
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You can kern the text for an entire text object, or you can manually kern 
individual character pairs or character strings. For example, if you mix 
italic and plain versions of a font in a title, you might want to adjust the 
spacing between characters.

n You can adjust kerning for individual characters or selected groups of 
characters by using the arrow keys only.

You can use the menu options to select predefined kerning options or 
specify your own custom kerning value. Positive numbers increase the 
spacing; negative numbers decrease the spacing. You can also use the 
arrow keys to make incremental adjustments.

Adjusting Kerning Manually

To adjust kerning manually with the arrow keys:

1. Click the Text tool.

2. Click between a character pair, or select a group of characters to be 
kerned.

Kerning text box and Kerning selection button

 Loose kerning

 Normal kerning

 Tight kerning
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3. Press and hold the Alt key (Windows) or Option key (Macintosh), and 
use the Left Arrow or Right Arrow key to increase or decrease the 
kerning.

Using the Predefined Kerning Sizes

To adjust kerning with the predefined sizes in the menu:

You can choose the 
kerning value before 
you type text.

1. Select the text.

2. (Option) Click the Kerning selection button, and choose Pair Kerning 
to eliminate excessive space between some character pairs. Note that 
pair kerning works only on fonts that support kerning tables (for 
example, Palatino).

3. Choose a kerning option from the Kerning pop-up menu:

- Loose adds space between letters.

- Normal leaves spacing unchanged.

- Tight closes up the spacing between letters.

Avid Xpress DV applies the kerning to the entire text object.

Using the Kerning Text Box

To adjust kerning with the text box, do one of the following:

t Click in the Kerning text box, and type a positive or negative numerical 
value. Values are a percentage of the point size.

t Click in the Kerning text box, and use the Up Arrow and Down Arrow 
keys to change the value incrementally.

Avid Xpress DV applies the kerning to the entire text object.
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Adjusting Leading

Use leading to adjust the line spacing between lines in a title object.

Leading is measured in points, from baseline to baseline of the lines of 
text. The Title tool uses the leading that is built into the font as the default. 
Positive leading values add space; negative values decrease space. You 
might want to add leading for sans serif, tall, or boldface fonts, and for 
fonts with a strong vertical emphasis.

To set leading:

1. Click in the Leading text box. 

2. Type the number of points by which to increase (positive) or decrease 
(negative) the font’s default leading.

Avid Xpress DV adjusts leading immediately.

Creating Graphic Objects

The drawing tools enable you to draw graphic objects such as squares, 
rectangles, circles, ovals, and lines. To use the drawing tools, select one of 
these shapes.

Leading text box

Drawing tools
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After creating graphic objects, you can change the following attributes:

• To round the corners of a box, adjust the width of lines and text 
borders, or add arrowheads to lines, see “Selecting Line Attributes” on 
page 263.

• To change or blend colors in a graphic object, see “Adjusting the 
Color” on page 268.

• To apply a drop or depth shadow, see “Working with Shadows” on 
page 273.

• To add transparency to an object or an object’s shadow, see “Adjusting 
the Transparency” on page 271.

n By default, when you use a drawing tool and deselect the created object, 
the pointer reverts to the Selection tool. To avoid this, double-click the 
drawing tool when you select it in the Title tool toolbar.

Drawing a Square or Rectangle

To draw a square or a rectangle:

1. Click the Square and Rectangle tool.

The pointer changes to a crosshair pointer.

2. Click in the Title tool, and drag to create an object.

n Pressing the Shift key while you drag constrains the Square and Rectangle 
tool to create a square.

Rectangle 
drawn over 
video 
background
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Drawing a Circle or Oval

To draw a circle or an oval:

1. Click the Oval tool.

The pointer becomes a crosshair pointer.

2. Click in the Title tool, and drag to create an object.

n Pressing the Shift key while you drag constrains the Oval tool to create a 
circle.

Drawing a Line

To draw a line:

1. Click the Line tool.

The pointer changes to a crosshair pointer.

2. Click in the Title tool, and drag to create a line.

n Pressing the Shift key while you drag constrains the Line tool to create a 
horizontal or vertical line.

Selecting Line Attributes

Use the line attribute tools to round the corners of a box, select the width of 
lines and borders, and add arrowheads to line endpoints.

You can also change the following drawing attributes:

• Color (see “Adjusting the Color” on page 268)

• Transparency (see “Adjusting the Transparency” on page 271)

• Drop and depth shadows (see “Working with Shadows” on page 273)

If you do not select an object and you choose a line attribute, 
Avid Xpress DV makes that the default for any new objects that you create.

Line attribute tools
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Rounding Corners

To round box corners:

1. Select a box.

2. Click the Box Corner tool (the button on the left).

The Corner Selection pop-up menu appears.

3. Choose a rounding option from the pop-up menu, or choose the 
custom radius option to open a dialog box and enter a custom radius.

4. If you choose the Custom Radius option, in the dialog box type a 
whole number (in pixels) to specify a custom corner radius and click 
OK. The maximum radius is 200.

Selecting a Line or Border Width

You can use the Border Width tool to change the width of lines created 
with the drawing tools or to apply a border outline to text or graphic 
objects.

To select a line or border width:

1. Select an object (such as a line, shape, or text object).

2. Click the Border Width tool (the middle button).

The Border Width Selection pop-up menu appears.

Custom Radius option
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3. Choose from the standard width selections, or choose the Custom 
Width option to open a dialog box and enter a custom width.

4. If you choose the Custom Width option, in the dialog box type a whole 
number (in pixels) to specify a custom width and click OK. Use a 
width of 1 or greater for lines and 0 or greater for object outlines. The 
maximum width is 200.

If you selected a line for modification, the width of the line changes. If you 
selected an object for modification, the width of the outline changes.

Adding Arrowheads

To add arrowheads to a line:

1. Select a line.

2. Click the Arrowhead tool (the button on the right).

The Arrowhead Selection pop-up menu appears.

Custom Width option

Turns off border

Text with 
border
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3. Choose an arrowhead style from the pop-up menu, or choose the Edit 
Arrowhead option as described in the following section.

Changing Arrowhead Size

To change the arrowhead size:

1. Select a line.

2. Click the Arrowhead tool.

3. Choose the Edit Arrowhead option from the pop-up menu.

The Arrowhead Size dialog box appears. 

4. Click the handle on the arrowhead, and drag it vertically or 
horizontally to resize and reshape it.

n The shape of the arrowhead is in scale with the line width.

5. Click OK.

The line changes to show the arrowhead.

Edit Arrowhead option

Remove arrowhead

Handle
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Selecting Colors and Setting Transparency

You can select the color and transparency for text and graphic objects, their 
shadows and borders.

The following illustration shows the boxes associated with color and 
transparency.

• The Color Selection boxes control fill (Fill), shadow (Shad), and 
border (Bord) color, respectively. 

• The Transparency Level boxes control fill, shadow, and border 
transparency, respectively. 

• The Color and Transparency Blend tools appear when you select a Fill 
or Border Color Selection box or Transparency Level box. 

If you select a Color Selection box, the top boxes show the two colors that 
are used to create the blend. The bottom box shows the blended color and 
allows you to control the direction of the blend or transparency.

If you select a Transparency Level box, the top boxes show the two 
transparency values that are used to create the blend. The bottom box 
allows you to control the direction of the transparency blend.

Color and Transparency Blend tools

Transparency Level boxesColor Selection boxes
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Adjusting the Color

You can select a color to fill text or a graphic object, a color for the shadow 
of an object, or a color for the border of an object.

To select a color:

1. Click the Selection tool, and click a text or graphic object. If you do 
not select an object, the color will be applied to the next object you 
create.

2. Click and hold one of the Color Selection boxes in the toolbar: 

- Fill (Fill) applies the color to the selected object.

- Shadow (Shad) applies the color to the selected object’s shadow.

- Border (Bord) applies the color to the selected object’s outline or 
border.

The Title Tool Color Picker opens.

3. Choose a color by using one of the controls in the Title Tool Color 
Picker. For more information, see “Using the Title Tool Color Picker” 
on page 270.

Blending Two Colors in an Object

Avid Xpress DV lets you blend two colors in a text or graphic object or in a 
border. You can also specify the direction of the blend.

n You can blend the fill and border, but you cannot blend a shadow.

To blend two colors:

1. Select text or another object.

2. Click the Color Selection box for either fill or border.

The Color Blend Selection boxes appear. 
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3. Click and hold one of the Color Blend Selection boxes.

The Title Tool Color Picker opens.

4. Choose a color by using one of the controls in the Title Tool Color 
Picker. For more information, see “Using the Title Tool Color Picker” 
on page 270.

The Blend Direction box appears. This box displays the blend and 
allows you to specify the direction of the blend (for example, left to 
right).

5. Click the other Color Blend Selection box, and choose the second 
color for your blend.

Color Selection boxes

Color Blend Selection boxes

Blend Direction box

Color blend tools apply a gradient blend to the selected object.
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6. Click the Blend Direction box, and drag clockwise or 
counterclockwise to define the blend direction that you want.

As you rotate the pointer, the position of the two colors rotates. 
Release the mouse button to apply the blend to your selection.

Using the Title Tool Color Picker

The Title Tool Color Picker opens when you click one of the Color 
Selection boxes or Color Blend Selection boxes. You can choose a color by 
using controls in the Title Tool Color Picker or you can use it to access a 
color selection eyedropper or the Windows Color dialog box or Macintosh 
Color Picker.

n You can drag the Color Picker from the toolbar to create a floating palette.

To choose a grayscale 
value, click in the 
grayscale selection bar.

To choose from the Title Tool Color Picker:

1. Drag the pointer along the color selection bar to the color you want. 

2. While continuing to press and hold the mouse button, move the pointer 
down into the shade selection palette to choose a shade.

3. Release the mouse button to apply the color.

Color selection bar

Shade selection palette

New Color window

Grayscale selection bar

Eyedropper

Click to open the Macintosh Color Picker or 
the Windows Color dialog box.

Original Color window
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To use the eyedropper:

1. Drag the pointer to the eyedropper icon, and release the mouse button.

The pointer changes to the eyedropper.

2. Move the eyedropper to the color you want anywhere in the window, 
and then click the mouse button to apply the color to the selected 
object.

To use the Windows Color dialog box or Macintosh Color Picker:

t Drag the pointer to the round button icon under the eyedropper, and 
release the mouse button.

The Windows Color dialog box or Macintosh Color Picker appears. 
For more information, see “Using the Windows Color Dialog Box” on 
page 95 and “Using the Macintosh Color Picker” on page 96.

Adjusting the Transparency

After you select a color, you can select the color transparency.

To select the color transparency:

1. Click and hold the appropriate Transparency Level box, depending on 
whether the transparency will apply to the fill color of an object (Fill) 
or will adjust a shadow (Shad) or border (Bord) around the selected 
object.

2. In the pop-up control that appears, drag the slider to change the 
transparency value.

The number in the Transparency Value box updates as you drag. 
Values range from 0 (fully opaque) to 100 (fully transparent).

The Transparency Level box and the pop-up control both display the 
text “Hi” with a background that changes from black to white. This 
allows you to see the effect of your transparency adjustments as you 
work. A completely white background represents a fully transparent 
object or portion of an object. The following illustration shows an 
example.
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n You might find it useful to turn off the shadow and shadow softness for an 
object while experimenting with transparency. Set the shadow value to 0 in 
the Shadow Depth text box and the softness value to 0 in the Soft Shadow 
dialog box, as described in “Working with Shadows” on page 273.

Blending Transparency

You can blend the transparency of fills and borders by using a technique 
similar to blending colors. Use the Transparency Blend Selection boxes to 
set the blend values. Use the Blend Direction box to set the direction of the 
blend.

Transparency Level 
boxes

Transparency Blend 
Selection boxes

Blend Direction 
box

Transparency 
Value box

Transparency blend tools apply a gradient 
transparency to the selected object.
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n For more information on creating a blend, see “Blending Two Colors in an 
Object” on page 268.

Working with Shadows

You can add a drop shadow or depth shadow to text and objects.

A drop shadow is offset from the title itself, as though cast by a light 
source. A depth shadow extends from the edges of the title, as though the 
title were three-dimensional. The following illustration shows an example 
of drop and depth shadows.

You can select the color, width, direction, and transparency for the shadow. 
You can also soften (blur) shadows or create a glow effect behind title text. 
You can place the shadow anywhere within the title without restriction. 
The following illustration shows the tools used to create and modify 
shadows.

Text with depth 
shadow

Text with drop 
shadow

Shadow Depth text box Drop and Depth Shadow button

Shadow Depth and Direction buttonShadow Color and 
Transparency boxes
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Applying Shadows

To apply shadows to objects:

1. Select text or an object.

2. Click the Drop and Depth Shadow button to switch between a drop or 
depth shadow.

3. Adjust the depth or direction of the shadow as follows:

t Click the Shadow Depth and Direction button, and drag the 
shadow displayed to any position.

t Press the Shift key; then click the shadow in the Shadow Depth 
and Direction button and drag to restrict shadow placement to 
45-degree angles around the title.

t Press the Shift key, and use the arrow keys to move the shadow to 
any position around the title.

t Type a value in the Shadow Depth text box to change the shadow 
depth by increments.

Avid Xpress DV automatically orients the shadow to the selected object. 
You can continue to follow these procedures to adjust the shadow until you 
achieve the effect you want.

Adjusting Shadow Color and Transparency

You can adjust the color and transparency properties of a shadow by using 
the procedures described in “Selecting Colors and Setting Transparency” 
on page 267.

Setting Shadow Softness

You can set a value for the degree of softening or blurring that applies to 
the shadows you create in the Title tool. The value that you set applies 
immediately to any selected title. Avid Xpress DV saves the value as the 
new default setting and applies it to any new title objects you create. To 
change the degree of softening that applies to objects in the Title tool, you 
must set a new value.
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The following illustration shows a title shadow with a Shadow Softness 
setting of 15.

To set a degree of softening or blurring for shadows:

1. Choose Soften Shadow from the Object menu.

The Soft Shadow dialog box appears.

2. Type a number in the Shadow Softness text box to represent the degree 
of softening you want.

Shadow softness values must fall between 4 and 40. The higher the 
value, the more blurred the shadows will be. If you set the value to 
zero, shadows on title objects will have no softening (hard edges).

3. Click OK to close the Soft Shadow dialog box.

Adjusting Shadow Softness On-the-Fly

You can adjust the shadow softness value of a title object on-the-fly either 
by entering different values in the Soft Shadow dialog box or by using the 
Up Arrow and Down Arrow keys.

To adjust shadow softness on-the-fly by using the Soft Shadow 
dialog box:

1. Select one or more objects in the Title tool.

2. Choose Soften Shadow from the Object menu.
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3. Type a number in the Shadow Softness text box to represent a degree 
of softening.

4. Click Apply.

Avid Xpress DV applies the softness value to the selected title object.

5. Repeat steps 3 and 4 until you are satisfied with the effect.

6. Click OK.

To adjust shadow softness on-the-fly by using the Up Arrow and 
Down Arrow keys:

1. Select one or more objects in the Title tool.

2. While pressing and holding the Shift and Alt keys (Windows) or Shift 
and Option keys (Macintosh), press the Up Arrow and Down Arrow 
keys to adjust the softness value incrementally until you are satisfied 
with the effect. 

Each press of the Up Arrow key adds 1 to the shadow softness value. 
Each press of the Down Arrow key subtracts 1 from the shadow 
softness value.

Viewing Shadow Softness

The current degree of softness is always represented visually on the 
shadow display of the Shadow Depth and Direction button. The following 
illustration shows this representation for a Shadow Softness setting of 10.

To confirm the numerical value you have currently set for shadow 
softness:

t Choose Soften Shadow from the Object menu, and check the number 
in the text box.
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Creating a Glow Effect

You can use the shadow tools to create a glow or halo effect around a title 
object.

To create a glow or halo around a title object:

1. Set Shadow Depth for the object to zero in the Title tool.

2. Set Shadow Softness for the object to a non-zero value.

The higher the Shadow Softness value, the softer the glow effect. In the 
following illustration, Shadow Softness is set to 10.

n To create titles that do not have either softened shadows or glows, you 
must set the Shadow Softness to zero.

Manipulating Objects

This section describes how to manipulate objects after you have created 
them. For a description of how to select objects, see “Using the Selection 
Tool” on page 244.

Basic Manipulation Operations

You can use commands from the Edit menu to manipulate objects.

To perform basic operations:

1. Click the Selection tool, and click an object.

2. Do one of the following:

t Choose Cut from the Edit menu to cut an object and move it to the 
Clipboard.

t Choose Copy from the Edit menu to copy an object to the 
Clipboard.
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t Choose Paste from the Edit menu to paste an object from the 
Clipboard.

t Choose Select All from the Edit menu to select all objects.

t Choose Delete from the Edit menu to delete selected objects.

n You cannot delete locked objects. Unlock objects you want to delete.

t Choose Duplicate from the Edit menu to duplicate an object.

Layering Text and Objects

You can use commands on the upper portion of the Object menu to layer 
text and objects to create complex graphics. 

The last object created occupies the top layer, but you can move objects 
forward or backward within the screen area.

To adjust the layering of objects in a title:

1. Click the Selection tool, and click an object.

2. Choose one of the following commands from the Object menu:

t Choose Bring to Front to bring an object to the top layer.

t Choose Send to Back to send an object to the bottom layer.

t Choose Bring Forward to move an object forward one layer.

t Choose Send Backward to move an object back one layer.
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Grouping and Ungrouping Objects

After creating a number of text and graphic objects, you can use 
commands on the Object menu to group the objects and treat them as a 
single object. 

Combining the objects into a group means that actions, such as moving or 
applying color, affect all objects in the group.

To group objects:

1. Click the Selection tool, and Shift+click multiple objects.

2. Choose Group from the Object menu.

The selected objects are grouped together. Changes to any individual 
object in the group affect all objects in the group.

To ungroup objects:

1. Click the Selection tool, and click a grouped object.

2. Choose UnGroup from the Object menu.

Everything in the group becomes an individual object that you can 
move or change separately.

Grouping commands
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Locking and Unlocking Objects

You can lock objects by using commands on the Object menu so that 
changes to default settings, such as the font setting or object position, do 
not affect the locked objects.

You might also want to lock objects so that you do not inadvertently 
change them while working on other objects. You can lock an individual 
object or multiple objects.

To lock objects:

1. Click the Selection tool, and click an object.

2. Choose Lock from the Object menu.

The system locks the object, and you cannot change it until you unlock 
it. When you select a locked object, hollow selection handles indicate 
that it is locked.

Locking commands

Locked object with 
hollow selection handles
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To unlock objects:

1. Click the Selection tool, and click a locked object.

2. Choose Unlock from the Object menu.

The system unlocks the object, and you can change it.

Aligning Objects

You can use the Alignment menu commands to align text and objects to 
each other and to the frame. Aligning to the frame refers to the safe title 
area. For information about the safe title area, see “Saving Titles, Title 
Styles, and Title Templates” on page 283.

To align objects to the frame:

1. Click the Selection tool, and click an object or Shift+click multiple 
objects.

2. Choose a frame alignment direction from the upper portion of the 
Alignment menu.

The system aligns the objects within the safe title area.

To align objects to each other:

1. Click the Selection tool, and Shift+click or lasso multiple objects.

2. Choose an object alignment direction from the Alignment menu.

Frame alignment 
commands
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n For information on aligning objects to a grid, see “Using the Alignment 
and Snap Grids” on page 250.

Distributing Objects

You can use Alignment menu commands to distribute text and graphic 
objects evenly across the safe title area. For information about the safe title 
area, see “Displaying Safe Title or Safe Action Guidelines” on page 247.

To distribute objects:

1. Click the Selection tool, and Shift+click at least three objects.

2. Choose a distribute command from the Alignment menu:

t Choose Distribute Left to Right to distribute the objects evenly 
from left to right across the safe title area.

t Choose Distribute Top to Bottom to distribute the objects evenly 
from top to bottom across the safe title area.

t Choose Distribute First to Last to distribute the objects evenly 
between the position of the first object selected and the position of 
the last object selected. This option is especially useful for 
aligning objects diagonally or for roughly positioning a group of 
objects and then lining them up without spreading them out to the 
edges of the safe title area.

Object alignment commands
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Saving Titles, Title Styles, and Title Templates

After creating a new title, save your work in one of the following ways:

t Save the title and exit the Title tool.

t Save the title and continue creating additional titles.

t Save a title style that you can apply to additional titles you create.

t Save a title as a template that you can use to quickly create additional 
titles with the same attributes and behavior.

You can also reopen in the Title tool a previously saved title and make 
further changes, as described in this section.

n After editing a title into a sequence and adjusting effect parameters, you 
can also save a Title Effect template that contains only the effect 
information (without title media) for applying to other previously created 
titles. For more information, see “Saving an Effect Template” on page 151.

Distribute commands



 Chapter 7 Creating Titles and Graphic Objects

284

Saving a Title and Exiting the Title Tool

To save the title and exit the Title tool:

1. Choose Close from the File menu.

If the contents of the title have changed since the last time you saved it, 
a message box appears, asking if you want to save the existing title.

2. Click Save. 

The Save Title dialog box appears.

3. Type a name to identify the title in the bin. Then choose a bin and a 
drive from the pop-up menus.

4. Select or deselect Fast Save, depending on your needs. For more 
information, see “Using the Fast Save Option” on page 286.
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5. Click Save.

The Title tool closes, and the new title loads into the Source pop-up 
monitor. A 2-minute Title Effect clip that corresponds to the new title 
appears in the bin.

Saving Multiple Titles in a Session

To save multiple titles:

1. Choose Save Title from the File menu. 

The Save Title dialog box appears.

2. Type a name to identify the title in the bin. Then choose a bin and a 
drive from the pop-up menus.

3. Select or deselect Fast Save, depending on your needs. For more 
information, see “Using the Fast Save Option” on page 286.

4. Click Save.

The new Title Effect clip appears in the bin.

5. Create another title.

6. Choose Save Title as from the File menu, and repeat steps 2 through 4 
for each subsequent title that you create.
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When you close the Title tool, Avid Xpress DV loads the last title 
created into the Source pop-up monitor.

n If you keep the same name for the title when you choose Save Title as, 
Avid Xpress DV retains the first clip and creates a new one with the same 
name plus a two-digit extension that adds incremental numbering for each 
revised title.

Using the Fast Save Option

You can use the Fast Save option to work more quickly when creating and 
saving multiple titles in a Title tool session.

Fast Save skips the steps that create anti-aliased images from title objects. 
Instead, it saves just the raw title objects (text and graphics) in the bin, with 
the prefix “unrendered.” 

You can edit with the titles and then batch-render them at a more 
convenient time. Fast Save is ideal for working with titles with complex 
styles and shading.

n Fast-saved titles appear as black in the Source pop-up monitor or 
Composer monitor and are labeled as “media offline” during editing.

c Always render fast-saved titles before exporting a sequence as an 
OMFI file and before creating an EDL from the sequence.

Saving a Title with Fast Save

To use the Fast Save option:

t Select Fast Save (Unrendered) in the Save Title dialog box when 
saving the title. 

For complete procedures for saving titles, see “Saving a Title and 
Exiting the Title Tool” on page 284 or “Saving Multiple Titles in a 
Session” on page 285.

n Fast Save remains in effect until you either deselect it, load a title that was 
saved without Fast Save selected, or exit the Title tool.
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Viewing Fast-Saved Titles in a Bin

To quickly locate the unrendered fast-saved titles:

1. Open the bin containing the unrendered fast-saved titles.

2. Choose Select Unrendered Titles from the Bin menu.

The fast-saved titles are highlighted in the bin.

Rendering Fast-Saved Titles

To render fast-saved titles:

1. Open the bin containing the unrendered fast-saved titles.

2. Choose Select Unrendered Titles from the Bin menu to select only the 
unrendered titles, or press Ctrl+A (Windows) or k+A (Macintosh) to 
select all items in the bin.

3. Choose Create Unrendered Title Media from the Clip menu to create 
media for the unrendered Title effects only. (Avid Xpress DV ignores 
any clips in the selection that do not need rendering.)

The Create Unrendered Title Media dialog box appears.

4. Choose a drive on which to store the title media.

5. Click OK.

After generating the title media, Avid Xpress DV deletes the 
unrendered versions from the bin and replaces them with the newly 
rendered titles.
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Revising a Title in a Bin

If you want to revise a title that has not been edited into a sequence, you 
can reopen the title in the Title tool directly from the bin. 

n For information on revising a title that has been edited into a sequence, see 
“Revising a Title in a Sequence” on page 310.

To revise a Title effect in a bin:

1. Press the Ctrl key (Windows) or the k key (Macintosh), and double-
click the Title Effect icon in the bin. 

The title opens in the Title tool.

n If the Title tool is already open, you can drag a Title Effect clip from the bin 
directly into the Title tool.

2. Edit the title, using techniques described in Chapter 8.

3. Save the title, using one of the following options:

t Save Title: To save the title with the same name and media 
parameters (bin and drive), choose Save Title from the File menu.

The revised Title Effect clip replaces the previous clip in the bin. 

The Title tool remains open. You can continue creating additional 
titles, or choose Close from the File menu.

t Save Title as: To rename the title or change any of the media 
parameters (bin and drive):

a. Choose Save Title as from the File menu.

The Save Title dialog box appears.

b. Rename the title or choose other options from the Bin and Drive 
pop-up menus.

n If you keep the same name for the title when you choose Save Title as, the 
system retains the first clip and creates a new one with the same name plus 
a two-digit extension that adds incremental numbering for each revised 
title.
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c. Select or deselect Fast Save, depending on your needs. For more 
information, see “Using the Fast Save Option” on page 286.

d. Click Save to save the title and exit the Title tool.

Using a Keyboard Shortcut to Save a Title

You can use a keyboard shortcut that is equivalent to choosing “Save Title 
as” from the File menu. You can now quickly save the latest version of 
your title without replacing the original. 

To save a title by using a keyboard shortcut:

1. Press Ctrl+Shift+S (Windows) or k+Shift+S (Macintosh).

The Save Title dialog box appears.

2. Type a name for the new version of your title.

3. If you want to change the bin or drive settings for the new version of 
the title, choose new settings from the pop-up menus.

4. Click Save.

Saving and Recalling Title Styles

As you begin to work with a title, you can set up some basic title 
parameters you will use again for other titles. You can then save these 
parameters in the form of a title style.

You can save the following parameters as part of a title style.

• Font, style, size, justification, kerning, and leading

• Fill color and transparency

• Shadow color, transparency, depth, direction, softness, and type

• Border color, transparency, and width

You can also assign a title style to one of the function keys on your 
keyboard. You can then recall that style simply by pressing the appropriate 
function key.
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Title styles save only the parameters that control the appearance of text or 
graphic objects in the Title tool. If you want to save the entire contents and 
layout of a title, including specific title objects themselves, use a title 
template. For more information, see “Creating and Using Title Templates” 
on page 294.

The following illustration shows the location of the two buttons that allow 
you to choose and define title styles.

Saving a Title Style

To save title parameters to a style sheet:

1. Click the Selection tool, and click the object that you want to use as a 
basis for the title style.

2. Click the Save Style Parameter button.

A menu appears that allows you to choose either an existing title style 
name or Save As.

3. Choose Save As.

The Title Style Sheet dialog box appears. The following illustration 
shows an example.

Save Style Parameter buttonStyles button
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4. Select the parameters that you want to include in the style. 
Avid Xpress DV uses the values from the currently selected object or 
from the current defaults if no object is selected.

5. (Option) Type a function key number in the Function Key text box to 
assign the style to a function key.

For example, typing 5 assigns the style to the F5 function key.

6. Type a name in the Name text box, and click Done when you are ready 
to exit the dialog box and save the values.

Recalling a Title Style

After you have saved your title style, you can recall the style and use the 
attributes as the defaults in subsequent Title tool sessions. You can recall a 
title style by using the Title Styles tear-off menu or, if you have assigned 
the style to a function key, by pressing the appropriate key.

Name text box
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To recall title style attributes by using the Title Styles tear-off menu:

1. Click the Styles button to display the Title Styles tear-off menu.

The menu contains a scaled visual representation of each style.

2. Drag the pointer to the chosen style, and release the mouse button.

The style attributes appear in the Title tool toolbar.

To recall a title style attribute by using a function key:

t Press the appropriate function key.

The style attributes appear in the Title tool toolbar.

Confirming Function Key Mapping of Title Styles

To verify which function key is assigned to a particular title style, do 
one of the following:

t Open the Title Style Sheet dialog box for the style from the Settings 
scroll list in the Project window, and then check the function key 
number in the Function Key text box.

t In the Title tool, click the Styles button to display the Title Styles tear-
off menu, and then position the pointer over the style.

The ToolTip that appears indicates the function key assignment along 
with the name of the style.

Arrows on the right 
and left allow you to 
scroll back and forth.
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Applying Title Styles to Text Objects

To apply a title style directly to text objects:

1. Click the Selection tool, and click one or more text objects.

2. Do one of the following:

t Click the Styles button to display the Title Styles tear-off menu, 
and then choose a title style.

t If the style is assigned to a function key, press the appropriate 
function key.

Managing Title Styles

Avid Xpress DV lists the available title styles in the Project window.

To manage title styles in the Project window:

1. Click the Settings tab in the Project window.

The Settings scroll list appears.

2. Delete, duplicate, or rename styles as follows:

t To delete a style, select the style in the Project window and press 
the Delete key or choose Delete from the Edit menu.

t To copy a style, select the style in the Project window and choose 
Duplicate from the Edit menu. 

t To rename a style, either change the name in the Project window or 
perform a Save As operation as described in “Saving and 
Recalling Title Styles” on page 289 and change the name in the 
Style Sheet text box.

Sample title 
styles
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Creating and Using Title Templates

Title templates let you create a standard format for text and graphics that 
you use regularly. After you have set up your template, open the template, 
edit the text, and save the new title. The template prevents you from 
changing the position, colors, shadows, or graphics, which ensures 
consistency.

You can also use title styles to save and recall only the parameters that 
control the appearance of title objects. For more information, see “Saving 
and Recalling Title Styles” on page 289.

Creating Title Templates

To create a title template:

1. Do one of the following: 

t Choose New Title from the Clip menu.

t Choose Title Tool from the Tools menu.

The Title tool opens.

2. In the Title tool, create the text and graphic elements to include in the 
template.

3. Click the Templates button.

The Templates pop-up menu appears.

4. Choose Save Template.

The Save Template dialog box appears.
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5. Type a name for the template.

6. Click Save.

The default folder is the Title_Templates folder, but you can save it 
elsewhere if you prefer.

7. Close the Title tool, and click Don’t Save in the dialog box. 

Using Title Templates

To use a title template:

1. Do one of the following: 

t Choose New Title from the Clip menu.

t Choose Title Tool from the Tools menu.

The Title tool opens.

2. Click the Templates button.

The Templates pop-up menu appears.

3. Choose Include Template.

The Open dialog box appears.

4. Select the template you want to use, and click Open. 

The Title template opens.

5. Make any edits you want to the text.

6. Close the Title tool, and click Save in the dialog box.

The Save Title dialog box appears.

7. Type a name for your title, and click Save. 

The named title appears in the bin you specify. Now you can edit the 
title into the sequence. For more information, see Chapter 8.
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Exporting a Title as a Graphics File

To export a title as a PICT graphics file:

1. With the Title tool open, choose Export Title from the File menu.

The Export Pict As dialog box appears.

2. Navigate to the location where you want to export the file.

Windows

Macintosh
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3. Type a name for the file in the “File name” text box (Windows) or the 
Export Pict As text box (Macintosh), and click Save.

The system saves the title.

For more information on exporting from Avid Xpress DV, see the chapter 
“Exporting and Exchanging Material” in the user’s guide.
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Chapter 8

Editing with Titles

Editing with titles involves placing title clips in a sequence and then 
adjusting parameters or revising the title in the Title tool. The following 
sections provide guidelines for editing with title media.

• Workflow for Editing with Titles

• Restrictions on Title Playback

• Displaying Title Frames in the Bin

• Editing a Title into a Sequence

• Removing Titles

• Replacing Titles

• Fading a Title

• Adjusting Title Effect Parameters

• Revising a Title in a Sequence

• Replacing Fill Tracks

• Rendering Titles

• Re-creating Title Media
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Workflow for Editing with Titles

The following is an overview of the tasks you perform to edit a title into a 
sequence:

• Edit the title into the sequence. You can load a title into the Source 
pop-up monitor or drag the Title Effect icon from the bin to a segment 
in the Timeline. See “Editing a Title into a Sequence” on page 303.

• Adjust the title’s parameters. With a title edited into a sequence, you 
can use the Effect Editor to alter the appearance or position of the title. 
You can also open the title again in the Title tool at any time to revise 
the title elements. See “Adjusting Title Effect Parameters” on 
page 308.

• Revise the title. After editing the title and adjusting parameters, you 
can revise elements of the title in the Title tool or replace fill tracks to 
create various effects.

These basic procedures are described throughout this chapter. For 
information on creating titles, see Chapter 7.

Restrictions on Title Playback

Depending on the complexity of the title and the video over which you key 
it, not all titles can be played in real time. 

When you attempt to play too complex a title, the following conditions 
might occur:

• Background video might jitter.

• Title might flash.

• Title might display a gray slide.

• Video might shift left or right.

• Video might display a gray slide.

• Video underrun error might occur.

• Audio underrun error might occur.
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If you encounter any of these conditions, try one or both of the following:

• Render the title or underlying effects.

For more information, see “Rendering Effects” on page 167.

• Simplify the title by removing text or drop shadows or by selecting 
different colors.

It is possible for you to create a title and background video so complex that 
you can neither play it in real time nor render it.

Understanding Title Clips

When you save a title, Avid Xpress DV creates a title clip and saves it in 
the selected bin. One media object, referred to as a precompute, has 
references to the RGB and alpha channel information. Every time you 
make a change, Avid Xpress DV creates two additional media files. The 
original media files are left unchanged.

n By default, the bin display does not show rendered effects. You can view 
rendered effects in the bin by choosing Set Bin Display from the Bin menu 
and by selecting Rendered Effects and “Show reference clips” in the dialog 
box.

Title clipRendered effect media 
object (precompute)

Bin – Frame view
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For more information, see “Managing Effect Media Files” on page 188.

Displaying Title Frames in the Bin

With your bin in Frame view, you can display a frame from the title itself 
rather than the Title Effect icon for the clip. This is especially useful if you 
have many titles in the bin and want a quick visual reference.

To display a frame from the title:

t Select one or more title clips, and then press the Home key on the 
keyboard.

Bin – Text view

Rendered effect 
media object 
(precompute)

Title clip

Bin – Frame view showing sample frame



Editing a Title into a Sequence

303

Editing a Title into a Sequence

After preparing the sequence with a second track for the title, use one of 
the following methods for editing the title into place:

• Edit the title into the sequence, using standard editing methods. 
Mark edit points in the sequence and in the title clip, and then splice or 
overwrite the title into place. See “Splicing or Overwriting a Title into 
a Sequence” on page 303.

• Drag a marked title clip directly into the sequence from a bin. 
Mark IN and OUT points in the title clip, and then drag the clip 
directly into the sequence. See “Dragging a Marked Title into a 
Sequence” on page 305.

• Drag an unmarked title clip directly into the sequence from a bin. 
Drag the title clip directly from the bin to the location of the position 
indicator. See “Dragging an Unmarked Title into a Sequence” on 
page 306.

Splicing or Overwriting a Title into a Sequence

To splice or overwrite a title into a sequence:

1. Load the sequence into the Composer monitor.

n Titles must be placed a track above the video that forms the background. If 
an upper track already exists with an open region for the title, you can skip 
step 2.

2. (Option) Choose New Video Track from the Clip menu.

Avid Xpress DV adds the next video track for the sequence to the 
Timeline. For example, if the sequence includes only V1, the system 
adds V2.

3. Double-click the Title Effect icon for the clip in the bin to load the title 
into the Source pop-up monitor.
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4. Patch the title source to the video track in the sequence by clicking the 
V1 Source Track button in the Track Selector panel and dragging it to 
the V2 Record Track button.

n You can use any three-point editing method to edit a title into a sequence. 
The following steps are just one editing method. For other methods, see the 
chapters “First Edits” and “Working in the Timeline” in the user’s guide.

5. In the Source pop-up monitor, mark an IN point.

Mark the IN point toward the middle of a still title clip so you can trim 
the title, if necessary. 

6. In the Composer monitor, mark IN and OUT points.

7. Make sure all other Record Track buttons are deselected in the Track 
Selector panel.

8. Click either the Splice-in button or the Overwrite button in the Tool 
palette to edit the title into the sequence.

Avid Xpress DV adds the title segment to the top video track.

Source Track button

Record Track button

IN and OUT points
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Dragging a Marked Title into a Sequence

To mark a portion of a title clip and then drag the marked clip directly 
into the Timeline:

1. Load the sequence into the Composer monitor.

n Titles must be placed a track above the video that forms the background. If 
an upper track already exists with an open region for the title, you can skip 
step 2.

2. (Option) Choose New Video Track from the Clip menu.

The system adds the next video track for the sequence to the Timeline. 
For example, if the sequence includes only V1, the system adds V2.

3. Double-click the Title Effect icon for the clip in the bin to load the title 
into the Source pop-up monitor.

4. In the Source pop-up monitor, mark an IN point and an OUT point to 
establish the duration that you want for the title.

Mark the IN point toward the middle of a still title clip so you can trim 
the title, if necessary. 

5. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline, depending upon how you want to 
insert the title).

6. Drag the title from the Source pop-up monitor to the Timeline.

As you drag the title in the Timeline, a white outline of the clip 
indicates its location in the sequence.

Title segment outline
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7. When you find the right position for the title on the correct track, 
release the mouse button.

The title appears in place in the sequence.

Dragging an Unmarked Title into a Sequence

If you are not concerned about the OUT point for your title, or if you plan 
on trimming the title later, you can quickly drag the unmarked title directly 
into the Timeline.

To add a title to a sequence without adding marks:

1. Load the sequence into the Composer monitor.

n Titles must be placed a track above the video that forms the background. If 
an upper track already exists with an open region for the title, you can skip 
step 2.

2. (Option) Choose New Video Track from the Clip menu.

The system adds the next video track for the sequence to the Timeline. 
For example, if the sequence includes only V1, the system adds V2.

3. Move the position indicator to the location where you want the title to 
begin.

4. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline, depending upon how you want to 
insert the title).

5. Drag the Title Effect icon for the clip from the bin to the Timeline.

As you drag the title clip in the Timeline, a white outline of the clip 
indicates its location in the sequence.
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6. When you find the right position for the title on the correct track, 
release the mouse button.

The title appears in place in the sequence.

Removing Titles

To remove a title segment:

1. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline.

2. Select the title segment, and press the Delete key once to delete the 
title.

3. Select the title segment again, and press the Delete key to delete its 
alpha channel media file.

To remove only the title:

1. Click the Record Track button in the Track Selector panel for the track 
on which the title appears.

2. Move the position indicator to the title in the Timeline.

3. Click the Remove Effect button in the Tool palette.

Avid Xpress DV removes the title from the segment. The alpha 
channel media file remains.

n The title remains in the bin. To remove the title from the bin, click the Title 
Effect icon for the clip in the bin and press the Delete key.

Title clip outline
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Replacing Titles

To replace a title in a sequence:

1. Click the Lift/Overwrite Segment Mode button below the Timeline.

2. Click the title segment currently in the sequence to select it.

3. Click the Mark Clip button to mark an IN point at the beginning of the 
title segment and an OUT point at the end of the segment.

4. Drag the new title clip from the bin to the marked segment.

The new title replaces the old title.

Fading a Title

You can use the Fade Effect button to fade a title. A dialog box appears that 
allows you to enter the number of frames to fade up and fade down without 
opening the Effect Editor.

Rather than adding Dissolve effects that require rendering, you can use the 
Fade Effect button to quickly create keyframes in the title with the proper 
level settings for playback in real time. You can change the keyframes in 
the Effect Editor. For more information, see “Using the Fade Effect 
Button” on page 58.

Adjusting Title Effect Parameters

After editing a title into a sequence, you can open the Effect Editor and 
refine the title with keyframe control over effect parameters.

To display the effect parameters for a title:

1. Choose Effect Editor from the Tools menu.

The Effect Editor opens.

2. Click the title segment in the sequence to select it.

The Effect Editor displays the parameter controls.
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To work with the Title effect parameters:

• Adjust Title effect parameters by using basic techniques described in 
“Using the Effect Editor” on page 86.

• Use multiple keyframes to gradually change keyframeable parameters 
over time. For more information, see “Understanding Keyframes” on 
page 98.

• Save effect templates of Title effect parameter adjustments to a bin for 
use in other sequences or projects as described in “Using an Effect 
Template” on page 150.

n For information on specific Title effect parameters, see “2D Effects 
Parameters” on page 318.

Title Effect iconOther Options button
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Revising a Title in a Sequence

If you want to revise a title after you have edited it into a sequence and 
have adjusted parameters with the Effect Editor, you can reopen the title in 
the Title tool directly from the sequence.

c If you have already edited a title into a sequence or have made 
adjustments to the effect parameters for that title, you must revise the 
title in the sequence (not the title clip in the bin).

To change a title in a sequence:

1. Choose Effect Editor from the Tools menu. 

The Effect Editor opens.

2. Click the title segment in the sequence to select it.

3. Click the Other Options button in the Effect Editor.

The Title tool opens. 

4. Revise the title, using techniques described in Chapter 7. 

5. Save the title, using one of the following options:

t Save Title: To save the title with the same name (numbered 
incrementally) and media parameters (bin and drive):

a. Choose Save Title from the File menu.

A message box appears.
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b. Click Save.

The Title tool closes, and the revised title clip replaces the 
previous clip in the sequence. The new clip also appears in the bin 
and the Source pop-up monitor, with the name of the previous clip 
plus a two-digit extension that adds incremental numbering for 
each revised title. The previous title clip remains unchanged in the 
bin.

t Save Title as: To rename the title or change any of the media 
parameters (bin and drive):

a. Choose Save Title as from the File menu.

A message box appears.

b. Click Save.

The Save Title dialog box appears.
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c. Rename the title, or choose other options from the Bin and Drive 
pop-up menus.

d. Click Save to save the title and exit the Title tool.

The Title tool closes, and the revised title clip replaces the 
previous clip in the sequence. The new clip also appears in the bin 
and the Source pop-up monitor with the new name. The previous 
title clip remains unchanged in the bin.

n You cannot select Fast Save when revising a title in a sequence.

Replacing Fill Tracks

You can replace the fill track of titles with video or graphics. The video or 
graphic effect then appears inside the title itself, keyed over the 
background.
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To replace the fill track:

1. Click either of the Segment Mode buttons (Extract/Splice-in or 
Lift/Overwrite) below the Timeline, and then double-click the title 
segment to step into the effect.

2. Load the video you want to use as replacement filler into the Source 
pop-up monitor.

3. Drag the Source Track button to the Record Track button in the Track 
Selector panel to patch the new source video to the title fill track.

4. Using standard editing methods, edit the video from the Source pop-up 
monitor onto the fill track.

Fill track

Source Track button

Record Track button for fill track
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Rendering Titles

If you play a complex layered effect and encounter a message about audio 
or video underrun, you need to render any included titles. For more 
information on rendering Title effects, see “Rendering Effects” on 
page 167.

Re-creating Title Media

You can use the Re-create Title Media command to regenerate offline 
media.

c The Re-create Title Media command removes any nested edits made 
inside a title, replacing the edits with the new title’s graphic and alpha 
tracks.

To re-create title media:

1. Load the sequence containing the titles into the Composer monitor.

2. Mark the IN and OUT points in the sequence surrounding all the titles 
that you want to re-create.

3. Select the tracks where the title or titles are located.

Fill track replaced with video
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4. Choose Re-create Title Media from the Clip menu.

The Re-create Title Media dialog box appears.

n If you are re-creating title media that uses fonts not recognized by your 
system, a dialog box appears that allows you to substitute the font in the 
title for one that is installed on your system. This might happen when you 
transfer titles between systems, especially when moving between 
Macintosh-based and Windows-based systems. For more information on 
font replacement, see the Avid Products Collaboration Guide.

5. Choose a drive for the re-created title media.

6. Click OK to continue regenerating the title media files.

The title media file is regenerated, and a precompute master clip 
appears in the bin.
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Chapter 9

2D Effects Reference

This chapter describes all 2D effects parameters and then summarizes all 
2D effects in alphabetical order within each effect category. For 
information on effects editing, see Chapter 2.

• 2D Effects Parameters

• 2D Effects

• Comparison of Similar Effects
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2D Effects Parameters

This section provides a general description of all 2D parameters, in 
alphabetical order. Some parameters apply to a wide range of effects; 
others are specific to a small group of effects, such as keys or motion 
effects.

Effect parameters are grouped in the following categories:

• Acceleration

• Background

• Border 

• Color Effect Parameters

• Crop

• Foreground 

• Key Parameters

• Matrix Parameters

• Motion Effect Parameters

• Plug-in Effect Parameters

• Position 

• Region Stabilize Parameters

• Scaling

• Transition Parameters

For an explanation of how to change a parameter, see “Understanding 
Effect Parameters” on page 91.
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Global and Keyframeable Parameters

The effects parameters are divided into two logical groups:

• Global parameters: Changes apply to all keyframes. When you 
change a global parameter, the Avid Xpress DV system automatically 
sets the value for all keyframes in the effect.

• Keyframeable parameters: Changes can be applied to individual 
keyframes. You can use keyframe parameters to alter an effect over 
time.

This distinction is noted throughout this section for each parameter.

Acceleration

Parameter Type Global

Description Adjusts the effect’s speed over time by having the effect ease in and ease out of 
every keyframe. This gives the effect a more natural appearance. The overall 
speed of an effect is determined by the duration of the effect, which is determined 
by the length of the clip in the sequence. If you want to slow down or speed up 
the movement of an effect, you will need to change the length of your effect or 
use add edits to limit the portion of the clip affected by the effect.

Use of Control Drag the slider to control ease in and ease out motion. When the slider is to the 
left (value of 0), there is no ease in and ease out motion. The effect maintains a 
constant speed throughout its path. As the slider moves to the right (toward a 
maximum value of 100), ease in and ease out motion increases.
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Background

Parameter Type Global

Description Sets the color for the background in effects that display a background. For 
example, the background parameters determine the color to be used in a Fade to 
Color, Fade from Color, or Dip to Color effect.

Use of Controls Other Options 
button

Opens the Windows Color dialog box or Macintosh Color 
Picker for precise color selection. For more information, 
see “Using the Windows Color Dialog Box” on page 95 
and “Using the Macintosh Color Picker” on page 96.

Hue Identifies the background color. The Hue parameter is 
measured as values on a color wheel ranging from 0 to 
255. The start (0) and ending (255) values are both red.

Sat (saturation)

Specifies the amount or intensity of the color. Values 
range from 0 to 255, where 0 is no chrominance and 255 
is a fully saturated color.

Lum (luminance) Specifies the brightness of the color. Values range from 0 
to 255, where 0 is black and 255 is full brightness or 
white.
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Border

Parameter Type Keyframeable

Description Allows you to place a border on the inner or incoming picture in many effects. The 
Border parameters allow you to specify the color, softness, and width of the border. 
Some effects also include Blend Color parameters for blending border color.

Use of Controls Other Options 
button

Opens the Windows Color dialog box or Macintosh Color 
Picker for precise color selection. For more information, 
see “Using the Windows Color Dialog Box” on page 95 
and “Using the Macintosh Color Picker” on page 96.

Hue Identifies the border or blend color. The Hue parameter is 
measured as values on a color wheel ranging from 0 to 255. 
The start (0) and ending (255) values are both red.

Sat (saturation) Specifies the intensity of the color. Values range from 0 to 
255, where 0 is no chrominance and 255 is a fully saturated 
color.

Lum (luminance) Specifies the brightness of the color. Values range from 0 
to 255, where 0 is black and 255 is full brightness or white.

Width Specifies the width of the border. Values range from 0 (no 
border) to 63 (widest border).

Soft (softness) Blends the border with the background image. Values 
range from 0 (no softness) to 63 (maximum softness).
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Color Effect Parameters

The Color Effect parameters, which apply to the Color Effect only, allow 
you to perform color correction or to create certain colorization effects 
such as posterization or solarization.

Luma Adjust

Parameter Type Global

Description Allows you to adjust the luminance characteristics of the image.

Use of Controls Bright 
(brightness)

Changes the brightness of the image. The parameter ranges 
from –100 to +100, where a value of 0 indicates no change. A 
value of –100 darkens the image; a value of +100 brightens 
the image.

Cont (contrast) Controls the contrast of light and dark areas in the image. 
Values range from –100 to +100, where a value of 0 indicates 
the image is unchanged. A negative value is less contrast; a 
positive value is more contrast.

Invert Reverses the image’s brightness, such that the brightest parts 
become the darkest and the darkest parts become the lightest.
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Brightness Example

Contrast Example

Original – Brightness 0 Brightness –50 Brightness +50

Original – Contrast 0 Contrast –50 Contrast +50
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Luma Range

Parameter Type Global

Description Allows you to adjust the range of brightness of the image.

Use of Controls Fast menu: 
16 to 235

The default for video images.

Fast menu: 
0 to 255

Allows you to map normal video to alpha ranges. This is 
useful if you have a high-contrast image that you want to 
expand to the full dynamic range. For example, use this value 
when you want to convert video to alpha for Matte Key 
effects.

n When you change the Luma Range to 0 to 255, the 
system attempts to go from 0 to 255 but will be clipped 
by the Low Clip and High Clip values in the Luma Clip 
parameter category. If it is your intent to “open up” the 
image to the full dynamic range, you need to change the 
Low Clip and High Clip values to 0 and 255, 
respectively.

W Point (white 
point)

Allows you to set the white point in the image. All pixels with 
that value become white, and all pixels with higher values are 
also clipped to white. The default is 235 (the broadcast value 
for white).

Raising the black point and lowering the white point values 
increase the contrast by reducing the number of shades of gray 
in an image. The number of shades is reduced because you 
map some to extreme black and others to extreme white.
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B Point (black 
point)

Allows you to set the black point in the image. All pixels with 
that value become black, and all pixels with lower values are 
also clipped to black. 

For example, you could use the eyedropper to select a shadow 
on the floor and change it from gray to black, clipping 
everything below that shade to black. The default is 16 (the 
broadcast value for black).

Raising the black point and lowering the white point values 
increase the contrast by reducing the number of shades of gray 
in an image. The number of shades is reduced because you 
map some to extreme black and others to extreme white.

n Black point control does not change the Black setup 
level. To adjust the Black setup level, use the Video 
Output tool. For more information, see the chapter 
“Output Options” in the user’s guide.

Gamma Allows you to adjust the midtones in an image without 
affecting the extreme white or black values. Lowering the 
value darkens midtones and brings the image closer to black. 
Raising the value lightens the midtones and brings the image 
closer to white.

For example, a person shot in front of a window in daylight 
may be very dark, almost in silhouette. You can use gamma 
correction to increase the midtones without changing the 
blacks or whites. Values range from –100 to +100 with 0 
being no change. 

The W Point, B Point, and Luma Clip sliders determine the 
number of shades of gray. The Gamma point allows you to 
move the distribution of the shades closer to black or closer to 
white. Negative values move the distribution closer to black. 
Positive values move the distribution closer to white.
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Luma Clip

Parameter Type Global

Description Allows you to determine the levels at which Avid Xpress DV limits the brightness 
or darkness in the picture.

Use of Controls High Provides a simple clip function for brightness values. When 
you specify a value for High, no pixel in the image can be 
brighter than that value. The default is 235 (the broadcast 
value for white).

Low Provides a simple clip function for darkness values. When you 
specify a value for Low, no pixel in the image can be darker 
than that value. The default is 16 (the broadcast value for 
black).

When preparing video for broadcast, normally you do not 
adjust these values. They allow you to adjust the brightness 
and contrast (using other controls in the Color Effect) while 
still maintaining legal broadcast values for black and white.
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Chroma Adjust

Parameter Type Global

Description Allows you to adjust the chrominance characteristics of the entire image.

Use of Controls Invert Invert reverses the colors in both Hue and Saturation such that 
all colors display as their complement.

Hue Hue varies the tint of all colors in the image. The Hue 
parameter is measured as degrees on a color wheel from –180 
to +180, where 0 does not change the hue. Changing the value 
of the Hue causes all colors in the image to rotate around the 
color spectrum. For example, a Hue setting of –20 causes skin 
tones to look more red, while a Hue setting of +20 causes skin 
tones to look more green.

Sat (saturation) Saturation varies the amount of all colors in the image. The 
Saturation parameter has a value of –100 to +100. Zero is the 
default. A value of –100 displays as gray tones. Positive 
values display all colors with more saturation.
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Color Style

Parameter Type Global

Description Allows you to create effects by limiting or inverting the color values of the image.

Use of Controls Post 
(posterization)

Posterization allows you to limit the number of colors in the 
image by controlling the number of luminance steps that are 
displayed. This gives the image a graphic appearance. The 
range of values is 0 to 25, where 0 displays all colors and 25 
displays the least number of colors.

Solar 
(solarization)

Solarization allows you to make the lightest points in the 
image dark to achieve a partial inversion of the luminance. 
Values above the threshold set for the parameter will be 
inverted. Solarization can have a value of 0 to 255, where 0 is 
normal luminance and 255 inverts all luminance values in the 
picture. Values of 0 to 127 display the lightest points in the 
image as dark. Values of 128 to 255 display both the lightest 
points as dark and the darkest points as light, which gives the 
appearance of a film negative.
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Posterization Example

Solarization Example

Original image Posterization 10 Posterization 20

Original image Solarization 100 Solarization 200
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Color Gain

Parameter Type Global

Description Allows individual control of the Color Gain for each of the three color 
components: red, green, and blue.

Use of Controls Red Changes the amount of red in the whole image. The parameter 
value is a percentage of the range from 0 to 200, where a value 
of 100 indicates that the color is unchanged.

Green Changes the amount of green in the whole image. The 
parameter value is a percentage of the range from 0 to 200, 
where a value of 100 indicates that the color is unchanged.

Blue Changes the amount of blue in the whole image. The 
parameter value is a percentage of the range from 0 to 200, 
where a value of 100 indicates that the color is unchanged.
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Crop

Parameter Type Keyframeable

Description Removes material from the top, bottom, left, and right edges of the video.

Use of Controls T (top) Removes video from the top of the inner or incoming video. 
Values range from 0 to 999; 0 is the top of the screen, 500 is 
the middle of the screen, and 999 is the bottom of the screen.

B (bottom) Removes video from the bottom of the inner or incoming 
video. Values range from –999 to 0; 0 is the bottom of the 
screen, –500 is the middle of the screen, and –999 is the top of 
the screen.

L (left) Removes video from the left side of the inner or incoming 
video. Values range from 0 to 999; 0 is the left side of the 
screen, 500 is the middle of the screen, and 999 is the right 
side of the screen.

R (right) Removes video from the right side of the inner or incoming 
video. Values range from –999 to 0; 0 is the right side of the 
screen, –500 is the middle of the screen, and –999 is the left 
side of the screen.
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Foreground

Parameter Type Keyframeable

Description Used, together with keyframes, to set the relative amount of the effect to be 
displayed over time. The additional options included with the Level slider vary, 
depending on the effect.

Use of Controls Level Controls the opacity of the foreground image. A Level of 0 is 
0 percent opacity (the foreground is transparent), a Level of 
50 is 50 percent opacity, and a Level of 100 is 100 percent 
opacity (no transparency).

Swap Sources This option applies to key effects (such as Chroma Key or 
Luma Key) and the PIP (Picture-in-Picture) effect only.

Click Swap Sources to swap the image source for the 
foreground and background layers of the effect.

Reverse 
Animation

This option is available for all effects.

Click the Reverse Animation button to cause the entire effect 
to be reversed, including the direction of movement as well as 
the incoming and outgoing sources.

This maintains the shot continuity while reversing the 
movement. For example, instead of the outgoing shot peeling 
off from the top left corner, the incoming shot peels on from 
the bottom right corner. This option effectively creates a 
mirror image of the sequence of keyframes for the effect as 
they appear in the Effect Preview monitor’s position bar.
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Invert Key This option applies to key effects only (such as Chroma Key 
or Luma Key). Select Invert Key to reverse the key.

In the case of a Chroma Key effect, inverting the key displays 
the key color regions while showing the background image 
source through the foreground image area.

In the case of a Luma Key effect, inverting the key displays 
the background image source through the darker areas rather 
than the lighter areas of the foreground image source.

In the case of a Matte Key effect, inverting the key effectively 
reverses the black and white areas of the alpha channel so that 
foreground and background are reversed.

Show Alpha This option applies to key effects only (such as Chroma Key 
or Luma Key).

Displays the grayscale alpha channel used to apply the key 
effect to the foreground and background source. This allows 
you to examine the problem areas of the key while making 
adjustments.
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Key Parameters

Key parameters appear only in the Chroma Key and Luma Key effects. 
These parameters control the key color and allow you to fine-tune the 
edges of key effects and the appearance of the foreground elements.

For information on the workflow for applying key effects, see “Creating 
Key Effects” on page 216.

Key

Parameter Type Global

Description Selects the primary key color to be replaced by video. Available in both Chroma 
Key and Luma Key.

Use of Controls Other Options 
button

Opens the Windows Color dialog box or Macintosh Color 
Picker for precise color selection. For more information, 
see “Using the Windows Color Dialog Box” on page 95 
and “Using the Macintosh Color Picker” on page 96.

Hue Identifies the key color. The Hue parameter is measured as 
values on a color wheel ranging from 0 to 255. The start 
(0) and ending (255) values are both red.

Sat (saturation) Specifies the amount or intensity of the color. Values 
range from 0 to 255, where 0 is no chrominance and 255 is 
a fully saturated color.

Lum (luminance) Specifies the brightness of the color. Values range from 0 
to 255, where 0 is black and 255 is full brightness or 
white.
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Secondary Key

Gain Specifies how much of the foreground and the background 
video will be displayed. Values range from 0 to 63. A Gain 
of 0 shows only the foreground. A Gain of 63 replaces all 
the foreground video with the background video.

Soft (softness) Determines how the bordering colors along the edge of the 
key are processed in the effect. Colors that border the 
luminance or chroma specified for the key are displayed as 
a blend of the foreground and the background video. 
Values range from 0 to 63. The higher the Softness value, 
the more of the background video will be blended in the 
border colors. Use the Soft slider to improve the 
appearance of the edges of the keyed areas.

Parameter Type Global

Description Selects a secondary background color to key out. For example, the floor in a 
bluescreen or greenscreen shot might be a slightly different shade from the 
background. You can choose the floor color as your secondary color and key it 
out. Available for the Chroma Key effect only.

Use of Controls See “Key” on page 334.
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Spill Suppression

Parameter Type Global

Description Neutralizes the selected color for the Chroma Key effect without affecting the 
luminance. Avid Xpress DV changes the spill color to a grayscale, allowing it to 
blend more easily with the foreground image.

Use the Spill Suppression key color to fix the following problems:

• Remove background color spill from the foreground image. Color spill occurs 
when the background color is present in the foreground image due to 
backdrop reflection.

• If the foreground object retains an outline of the chroma key color, you can 
use Spill Suppression to reduce the color effect in the outline.

Use of Controls See “Key” on page 334.
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Matrix Parameters

Parameter Type Global

Description Allows you to customize the grid used to define the position or progress of the 
Matrix effect over time. For example, the grid defines the number of squares used 
for the Grid and Speckle effects, or the number of horizontal bars used for the 
One-Way Row effect. Available for Matrix Wipe effects, Sawtooth Wipe effects, 
and some Shape Wipe effects.

Use of Controls Other Options 
button

Click to open the Matrix Effect dialog box.

Select a standard grid size or enter a custom number of 
rows and columns, and then click OK. The minimum 
number of rows and columns is 2 x 2. A graphical 
representation of the grid you select appears on the 
right side of the dialog box.

Columns Rows Graphical representation 
of the grid
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Motion Effect Parameters

Motion effect parameters apply to Freeze Frame, Variable Speed, and 
Strobe Motion effects. For information about applying and editing various 
motion effects, see “Creating Motion Effects” on page 196.

Freeze Frame Parameters

Duration

Custom duration

Parameter Type Global

Description Allows you to create and customize a freeze frame clip based on the image 
currently displayed in the Source pop-up monitor.

Use of Menu 
Commands

Freeze frame parameters are menu commands in the Clip menu. To create a freeze 
frame and access freeze frame parameters, choose Freeze Frame from the Clip 
menu, and then choose the appropriate submenu commands.

Duration 
commands (in 
seconds or 
minutes)

Specifies the length of the freeze frame clip that Avid Xpress 
DV creates in the Source pop-up monitor. You can either select 
a duration from the Freeze Frame pop-up menu or select Other 
to enter a custom duration.
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Other Opens a dialog box that allows you to specify a custom 
duration for the freeze frame clip.

Two Field Freeze 
Frames

Opens a submenu with commands that allow you to determine 
how the system creates and displays the effect media when 
working with two fields.

Using 
Duplicated Field

The system uses a single field to create the effect. This option 
reduces the vertical resolution of the image by one-half, 
resulting in a lower quality image.

Using Both 
Fields

The system uses both fields to create the effect. This option is 
especially useful when there is motion in the footage.

Using 
Interpolated 
Field

The system creates a second field for the effect by combining 
scan line pairs from the first field in the original media. This 
might result in a slightly softer look to the freeze frame.
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Variable Speed and Strobe Motion Parameters

Variable Speed 
effect 

Strobe Motion 
effect 

Parameter 
Type

Global

Description Allows you to create and customize variable speed or strobe motion clips based on 
all or part of the clip currently displayed in the Source pop-up monitor.

Use of Controls Variable Speed and Strobe Motion parameters are available in the 
Motion Effect dialog box. To open the Motion Effect dialog box, 
click the Motion Effect button in the Source pop-up monitor.

Variable Speed Duration The duration of the effect in frames. Doubling the number of 
frames causes the frame rate to be half the current rate.

Rate The rate of speed in frames per second (fps) at which the video 
will be played. Normal speed is 30 fps for NTSC video, 25 fps for 
PAL video.
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% Speed The percent of speed at which the video will be played. Normal 
speed is 100%.

Fit To Fill Sets the Variable Speed parameters, so the duration of the motion 
effect will match the IN to OUT duration marked in the sequence.

Strobe Motion Update every n 
frames

Specifies the update rate in frames for the Strobe Motion effect. 
For example, entering a rate of 5 causes every fifth frame to be 
displayed in the Strobe Motion effect.

Render 2-field 
Motion Effect 
Using

Duplicated Field Avid Xpress DV uses a single field to create the effect. 

For two-field media, this reduces the information stored by half 
because it drops one field of the image, resulting in a lower 
quality image.

For single-field media, this is usually the best choice because of 
its speed (the other options do not improve effect quality for 
single-field media).

Effects render in the shortest amount of time using this option.

Both Fields Avid Xpress DV uses both fields to create the effect. For 
example, the first two frames of a half-speed (50%) slow-motion 
effect repeat the original Frame 1 (both fields) twice.

This option is good for shots without inter-field motion and still 
shots.

With footage that includes inter-field motion, this method might 
result in minor shifting or bumping of the image because it 
disturbs the original order of fields: a Field 1 will appear both 
before and after the corresponding Field 2.

Effects render relatively quickly. For best results, use evenly 
divisible frame rates with this option.
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n If a Strobe Motion effect becomes unrendered because it has been trimmed 
to a longer duration, the effect will not play and must be rendered again.

n To indicate reverse motion at full play rate, slow or fast, enter a negative 
play rate or a percent.

Interpolated 
Field

Avid Xpress DV creates a second field for the effect by 
combining scan line pairs from the first field in the original 
media. 

This option calculates the motion effect at the field level rather 
than the frame level. Because Avid Xpress DV considers all fields 
and does not disturb the original order of fields, the smoothest 
effect results.

Effects created using this option take the longest amount of time 
to render.

VTR-Style Avid Xpress DV creates a second field for the effect by shifting 
selected video fields of the original media by a full scan line. This 
technique is similar to that used by high-quality professional 
video decks when playing footage at less than normal speed. 

This option also creates the motion effect at the field level rather 
than the frame level; however, because pixels are not filtered, the 
final image is sharper than that created by the Interpolated Field 
option. The image might display some slight jitter at certain 
speeds.

The time needed to render effects created with this option is 
longer than the time for effects created using either Duplicated 
Field or Both Fields but similar to the time needed for 
Interpolated Field.

Ignore Render 
Setting

If a specific motion effect type is set in the Motion Effects Render 
Using option of the active Render setting, Avid Xpress DV 
automatically selects that motion effect type, makes all other 
motion effect type options unavailable, and displays the Ignore 
Render Setting check box. Click the Ignore Render Setting check 
box to temporarily override the active Render setting and make 
all four motion effect types available.
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Plug-in Effect Parameters

If you install third-party Photoshop-compatible (Macintosh only) or AVX 
(Avid Visual Extensions) plug-in effects, these effects usually come with 
their own documentation. For information on installing and using third-
party plug-in effects, see “Using Third-Party Plug-in Effects” on page 36.

Position

Parameter Type Keyframeable

Description Sets the horizontal and vertical position of the effect.

Use of Controls H Pos 
(horizontal 
position) 

Moves the video from side to side. Values range from –999 to 
+999. Negative values move the image to the left. Positive 
values move the image to the right.

V Pos (vertical 
position)

Moves the video up and down. Values range from –999 to 
+999. Negative values move the image to the top. Positive 
values move the image to the bottom.
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Region Stabilize Parameters

Region Stabilize parameters appear only in the Region Stabilize effect. 
They allow you to establish the type of stabilization and the area of the 
image that is to remain stationary. For more information, see “Stabilizing 
an Image” on page 210.

Model

Parameter Type Global

Description Selects the type of stabilization. Available for the Region Stabilize effect only. 
For more information, see “Stabilizing an Image” on page 210.

Options Translational Keeps the region of interest steady along both the horizontal 
and the vertical axis.

Horizontal Constrains horizontal motion in the region of interest. Objects 
in the region of interest can move vertically but not 
horizontally.

Vertical Constrains vertical motion in the region of interest. Objects in 
the region of interest can move horizontally but not vertically.
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Region of Interest

n You can also change the size and position of the Region of Interest by 
dragging the wire frame in the Effect Preview monitor. For more 
information, see “Manipulating Effects Directly” on page 147.

Parameter Type Keyframeable

Description Defines the area of the image that is to remain stationary. Available for the 
Region Stabilize effect only. For more information, see “Stabilizing an Image” on 
page 210.

Use of Controls T (top)

L (left)

B (bottom)

R (right)

Sets the corners of the region of interest. Values are relative to 
the center of the screen.
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Auto Zoom

Progressive Source

Parameter Type Global

Description Stabilization exposes black around the edges of the repositioned frames. Auto 
Zoom compensates by resizing and, if necessary, repositioning the clip to remove 
the exposed edges. Available for the Region Stabilize effect only. For more 
information, see “Stabilizing an Image” on page 210.

Parameter Type Global

Description Produces smoother results for the effect when your footage was captured or 
converted to progressive footage (not interlaced).
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Scaling

Parameter Type Keyframeable

Description Resizes the effect by adjusting height and width.

Use of Controls Wid (width) Controls the width of the image when the Fixed Aspect 
parameter is disabled. Values range from 0 to 400.

Hgt (height) Controls the height of the image when the Fixed Aspect 
parameter is disabled. Values range from 0 to 400.

Fixed Aspect Determines which position and size parameters are displayed. 
When the Fixed Aspect parameter is enabled, the aspect ratio of 
the picture cannot be changed. The Wid and Hgt sliders are 
ganged and move together.
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Transition Parameters

Transition Effect Duration boxClick the Transition 
Effect Alignment 
button to select a 
position from the pop-
up menu.

Parameter Type Global

Description Transition parameters allow you to specify the starting point of a transition 
relative to the cut point and the length of a transition. Transition parameters 
appear at the bottom of the Effect Editor. For more information about using 
transition effects, see “Working with Transition Effects” on page 59.

Use of Controls Transition Effect 
Alignment 
button 

Click the Transition Effect Alignment button to open a pop-up 
menu, and then select a position option.

Ending at Cut — The transition effect will start a number of 
frames before the cut defined by the duration, such that the 
effect completes at the cut point in the video.

Centered on Cut — The transition will be centered on the cut 
so that half the effect will occur before the cut point and half 
will occur after the cut point in the sequence.

Starting at Cut — The transition effect will start 
immediately after the last frame of the outgoing video is 
displayed.

Custom Start — Allows you to specify the number of frames 
before and after the cut to be included in the effect.

Transition Effect 
Duration box

Click in the box, and type a value to specify the length of time 
that the effect will span the transition. The Transition Effect 
Duration format that the Avid Xpress DV system displays (for 
example, 1:00 is 1 second and 0 frames) is determined by the 
Transition Effect Duration setting you selected at the top of 
the Effect Preview monitor.
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2D Effects

This section summarizes each 2D effect in alphabetical order within each 
effect category listed below. Parameters for each effect are listed here and 
are described in “2D Effects Parameters” on page 318.

• Blend Effects

• Box Wipe Effects

• Conceal Effects

• Edge Wipe Effects 

• Film Effects

• Image Effects

• Key Effects

• L-Conceal Effects

• Matrix Wipe Effects

• Motion Effects

• Peel Effects

• Push Effects

• Sawtooth Wipe Effects

• Shape Wipe Effects

• Spin Effects

• Squeeze Effects

• Title Effects
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Blend Effects

Blend effects are general two-channel effects used for transitions or 
multilayer segments. Blend effects include:

• Dip to Color

• Dissolve

• Fade from Color

• Fade to Color

• Picture-in-Picture

• Superimpose

Dip to Color

 

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Blend

Apply to Transitions

Parameters Foreground – level, reverse animation

Background – hue, saturation, luminance

Acceleration

Transition Parameters – transition effect alignment and duration

Description Fades from the outgoing video to black, white, or any color and then fades up to 
the incoming video.
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Dissolve

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Blend

Apply to Transitions

Parameters Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Blends images from the outgoing video with the incoming video over time.
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Fade from Color

Beginning color Middle of effect Incoming footage

Effect Icon

Effect Category Blend

Apply to Transitions

Parameters Foreground – level, reverse animation

Background – hue, saturation, luminance

Acceleration

Transition Parameters – transition effect alignment and duration

Description Fades from any color to the incoming video.
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Fade to Color 

Outgoing footage Middle of effect Final color

Effect Icon

Effect Category Blend

Apply to Transitions

Parameters Foreground – level, reverse animation

Background – hue, saturation, luminance

Acceleration

Transition Parameters – transition effect alignment and duration

Description Fades from the outgoing video to any color.
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Picture-in-Picture

Bottom track PIP as a segment effect Top track

Effect Icon

Effect Category Blend

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, swap sources, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Description Creates a picture within a picture. Video from the higher layer, where the effect is 
applied, is displayed inside the video on the lower layer. When used on a 
transition, the incoming video appears inside the outgoing video.
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Superimpose

Bottom track Superimpose effect Top track

Effect Icon

Effect Category Blend

Apply to Multilayer segments

Parameters Foreground – level, reverse animation

Acceleration

Description Blends the image from the upper video track (where the effect is applied) with 
the image from the lower video track over time. Level set at 100 percent shows 
only the video image from the upper track where the effect is applied. Level set at 
0 percent shows only the video image from the lower video track.
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Box Wipe Effects

Box Wipe effects reveal one video channel on top of another video 
channel, using predefined growing rectangular shapes. Box Wipes include:

• Bottom Box

• Bottom Left to Top Right

• Bottom Right to Top Left

• Left Box

• Right Box

• Top Box

• Top Left to Bottom Right

• Top Right to Bottom Left

n For examples of similar effects, see “Comparison of Similar Effects” on 
page 466.
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Bottom Box

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category  Box Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the center of the bottom edge of the screen and 
wipes out the outgoing video as the box expands to fill the screen.
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Bottom Left to Top Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Box Wipe 

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the bottom left corner of the screen and wipes 
out the outgoing video as the box expands to fill the screen.
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Bottom Right to Top Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Box Wipe 

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the bottom right corner of the screen and wipes 
out the outgoing video as the box expands to fill the screen.
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Left Box

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Box Wipe 

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the center of the left edge of the screen and 
wipes out the outgoing video as the box expands to fill the screen.
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Right Box

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Box Wipe 

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the center of the right edge of the screen and 
wipes out the outgoing video as the box expands to fill the screen.
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Top Box

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Box Wipe 

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the center of the top edge of the screen and 
wipes out the outgoing video as the box expands to fill the screen.
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Top Left to Bottom Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Box Wipe 

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the top left corner of the screen and wipes out 
the outgoing video as the box expands to fill the screen.
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Top Right to Bottom Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Box Wipe 

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the top right corner of the screen and wipes out 
the outgoing video as the box expands to fill the screen.
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Conceal Effects

Conceal effects overlap one video channel over another video channel, 
using a predefined path. Conceal effects include:

• Bottom Left to Top Right

• Bottom Right to Top Left

• Bottom to Top

• Left to Right

• Right to Left

• Top Left to Bottom Right

• Top Right to Bottom Left

• Top to Bottom

n For examples of similar effects, see “Comparison of Similar Effects” on 
page 466.
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Bottom Left to Top Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the bottom left to the top 
right of the screen.
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Bottom Right to Top Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the bottom right to the 
top left of the screen.
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Bottom to Top

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the bottom to the top of 
the screen.
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Left to Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the left edge to the right 
edge of the screen.
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Right to Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the right edge to the left 
edge of the screen.
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Top Left to Bottom Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the top left to the bottom 
right of the screen.
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Top Right to Bottom Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the top right to the 
bottom left of the screen.



2D Effects

373

Top to Bottom

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the top to the bottom of 
the screen.
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Edge Wipe Effects

Edge Wipe effects reveal one video channel on top of another video 
channel by wiping an edge across the screen. Edge Wipes include:

• Horizontal

• Horizontal Open

• Lower Left Diagonal

• Lower Right Diagonal

• Upper Left Diagonal

• Upper Right Diagonal

• Vertical

• Vertical Open
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Horizontal

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Edge Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins at the left edge of the screen and moves to the right edge, 
wiping out the outgoing video.



 Chapter 9 2D Effects Reference

376

Horizontal Open

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Edge Wipe 

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a vertical band in the center of the screen. This band 
expands to the left and right edges of the screen, wiping out the outgoing video.
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Lower Left Diagonal

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Edge Wipe 

Apply to Transitions, multilayer segments

Parameters Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins in the bottom left corner of the screen and wipes out the 
outgoing video as a diagonal line moves from the bottom left corner to the top 
right corner of the screen.
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Lower Right Diagonal

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Edge Wipe 

Apply to Transitions, multilayer segments

Parameters Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins in the bottom right corner of the screen and wipes out the 
outgoing video as a diagonal line moves from the bottom right corner to the top 
left corner of the screen.
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Upper Left Diagonal

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Edge Wipe 

Apply to Transitions, multilayer segments

Parameters Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins in the top left corner of the screen and wipes out the 
outgoing video as a diagonal line moves from the top left corner to the bottom 
right corner of the screen.



 Chapter 9 2D Effects Reference

380

Upper Right Diagonal

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Edge Wipe 

Apply to Transitions, multilayer segments

Parameters Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins in the top right corner of the screen and wipes out the 
outgoing video as a diagonal line moves from the top right corner to the bottom 
left corner of the screen.
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Vertical

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Edge Wipe 

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins at the top edge of the screen and expands downward to 
fill the screen.
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Vertical Open

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Edge Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a horizontal band in the center of the screen. This band 
expands up and down to fill the screen.
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Film Effects

Film effects, an option on some systems, emulate many of the effects an 
optical house can produce. Film effects include:

• 1.66 Mask

• 1.85 Mask

• 16:9 Mask

• Anamorphic Mask

• Blowup

• Film Dissolve

• Film Fade

• Mask
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1.66 Mask

Original image 1:1.66 Mask effect

Effect Icon

Effect Category Film

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a centered rectangle. The 
centered rectangle is 1.66 times wider than it is tall. The area surrounding the 
rectangle is masked by a black background.
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1.85 Mask

Effect Icon

Effect Category Film

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a centered rectangle. The 
centered rectangle is 1.85 times wider than it is tall. The area surrounding the 
rectangle is masked by a black background.
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16:9 Mask

Effect Icon

Effect Category Film

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a centered rectangle. The 
centered rectangle is 16 units wide by 9 units high. The area surrounding the 
rectangle is masked by a black background.
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Anamorphic Mask

Effect Icon

Effect Category Film

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a centered rectangle. The 
centered rectangle is 2.35 times wider than it is tall. The area surrounding the 
rectangle is masked by a black background.
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Blowup

Original image Blowup effect

Effect Icon

Effect Category Film

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Description Blowup modifies the size and portion of the picture that is displayed.
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Film Dissolve

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Film

Apply to Transitions

Parameters Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Blends the outgoing frame to the incoming frame over time. The Level parameter 
has been preset according to Kodak™ specifications. Avid does not recommend 
adjusting the Level parameter on this effect.

The Level set at 0% shows all of the outgoing frame. The Level set at 100% 
shows all of the incoming frame. 

This dissolve has preset parameters that emulate film’s response to light when 
dissolving to another (nonblack) picture.
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Film Fade

Effect Icon

Effect Category Film

Apply to Transitions

Parameters Foreground – level, reverse animation

Acceleration

Description Blends the outgoing pictures to the incoming pictures over time. The Level 
parameter has been preset according to Kodak specifications. Avid does not 
recommend adjusting the Level parameter on this effect. 

The Level set at 0% shows all of the outgoing frame. The Level set at 100% 
shows all of the incoming frame.

This dissolve has preset parameters that emulate film’s response to black 
material. Use this effect for fade ins and fade outs.



2D Effects

391

Mask

Effect Icon

Effect Category Film

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a rectangle defined by the 
Scaling, Fixed Aspect, and Position parameters of the effect.

The effect’s background color masks the area surrounding the rectangle.
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Image Effects

Image effects are general effects that apply to a single stream of video. 
Image effects include:

• Color Effect

• Flip

• Flip-Flop

• Flop

• Mask

• Region Stabilize

• Resize

• Submaster
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Color Effect

n For examples of the Color Effect, see “Color Effect Parameters” on 
page 322.

Effect Icon

Effect Category Image

Apply to Single-layer segments

Parameters Luma Adjust – brightness, contrast, invert

Luma Range – luma range Fast menu, white point, black point, gamma

Luma Clip – high, low

Chroma Adjust – hue, saturation, invert

Color Style – posterization, solarization

Color Gain – red, green, blue

Description The Color Effect modifies the luminance, chroma, style (posterized or solarized), 
and color gain of the segment.
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Flip

Original image Flip effect applied

Effect Icon

Effect Category Image

Apply to Single-layer segments

Parameters None

Description Video image is flipped vertically.
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Flip-Flop

Original image Flip-Flop effect applied

Effect Icon

Effect Category Image

Apply to Single-layer segments

Parameters None

Description Video image is flipped both horizontally and vertically.
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Flop

Original image Flop effect applied

Effect Icon

Effect Category Image

Apply to Single-layer segments

Parameters None

Description Video image is flipped horizontally, which reverses the camera angle.
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Mask

Effect Icon

Effect Category Image

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a rectangle defined by the 
Scaling, Fixed Aspect, and Position parameters of the effect. The effect’s 
background color masks the area surrounding the rectangle.
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Region Stabilize

Effect Icon

Effect Category Image

Apply to Single-layer segments

Parameters Region Stabilize Parameters – Model, Region of Interest, Auto Zoom

Description The Region Stabilize effect defines and tracks an area of an image to eliminate 
unwanted motion in a clip, such as motion from an unstable camera. For more 
information, see “Stabilizing an Image” on page 210 and “Region Stabilize 
Parameters” on page 344.

n The Region Stabilize effect is available as part of the Avid Xpress DV 
PowerPack and installs from the PowerPack CD-ROM. For more 
information on this installation, see the Avid Xpress DV Getting Started 
Guide.
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Resize

Original image Resize effect – reduced image Resize effect – enlarged image

Effect Icon

Effect Category Image

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Description Resize modifies the size and position of the video. The background color 
displays where no video is present. Use the H Pos, V Pos, and Size sliders to 
specify the size and position of the video. Use the Crop parameters to remove the 
edges of the picture.
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Submaster

n The Submaster effect does not render each track separately; you cannot 
play each track separately after rendering.

Key Effects

Key effects combine two streams of video by using components from one 
of the streams. Key effects include:

• Chroma Key

• Luma Key

• Matte Key

Effect Icon

Effect Category Image

Apply to The top video track under which are the video tracks that will be included in the 
Submaster effect

Parameters None

Description When rendered, the Submaster effect creates a single media file for all the video 
on the layers below the Submaster effect. This allows you to group several effects 
that reside on different video layers and render them as one effect; this is quicker 
than rendering each effect separately.
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Chroma Key

Chroma Key effectKey image – video layer 2Background – video layer 1

Effect Icon

Effect Category Key

Apply to Transitions, multilayer segments

Parameters Key – hue, saturation, luminance, gain, softness

Secondary Key – hue, saturation, luminance, gain, softness

Spill Suppression – hue, saturation, luminance, gain, softness

Foreground – level, swap sources, reverse animation, invert key, show alpha

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Transition Parameters – transition effect alignment and duration

Description Replaces one part of the video image with another video image based on color. 
The key color in the video on the higher track is replaced with the video from the 
lower track number. Chroma Key is used most frequently with a foreground 
image shot in front of a highly saturated color screen.
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Luma Key

Key image Background image Luma Key effect

Effect Icon

Effect Category Key

Apply to Transitions, multilayer segments

Parameters Key – hue, saturation, luminance, gain, softness

Foreground – level, swap sources, reverse animation, invert key, show alpha

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Transition Parameters – transition effect alignment and duration

Description Replaces one part of the video image with another video image based 
on luminance.
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Matte Key

Video layer 1 — background Video layer 2 — foreground Video layer 3 — high-contrast 
matte image

Matte Key effect

Effect Icon

Effect Category Key

Apply to Multilayer segments

Parameters Foreground – level, swap sources, reverse animation, invert key, show alpha

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Transition Parameters – transition effect alignment and duration

Description A three-layer track effect. The bottom layer is the background image, the middle 
layer is the foreground image, and the top layer contains the grayscale matte or 
alpha channel. 
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L-Conceal Effects

L-Conceal effects overlap one video channel over another using a 
predefined L-shaped path. L-Conceal effects include:

• Bottom Left

• Bottom Right

• Top Left

• Top Right

Bottom Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category L-Conceal

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides up the left half of the screen from bottom to top and then 
fills the screen from left to right.
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Bottom Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category L-Conceal

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides up the right half of the screen from bottom to top and then 
fills the screen from right to left.
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Top Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category L-Conceal

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides down the left half of the screen from top to bottom and 
then fills the screen from left to right.
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Top Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category L-Conceal

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides down the right half of the screen from top to bottom and 
then fills the screen from right to left.
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Matrix Wipe Effects

Matrix Wipes reveal one video channel on top of another video channel, 
using blocks or bands that appear in a predefined position or path. Matrix 
Wipes include:

• Grid

• One-Way Row

• Speckle

• Spiral

• Zig-Zag
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Grid

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Matrix Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as blocks in a grid pattern that wipe out the outgoing 
video as the blocks expand to fill the screen. Change the size of the grid by 
clicking the Other Options button.
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One-Way Row

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Matrix Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a block in the top left corner of the screen that wipes 
out the outgoing video as the band expands horizontally across the screen from 
left to right. When the first horizontal band reaches the right edge of the screen, a 
second band appears on the left edge of the screen, just below the first band, and 
repeats the process until the incoming video has wiped out all the outgoing video.
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Speckle

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Matrix Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video appears in a random series of blocks that wipe out the outgoing 
video until the blocks have filled the screen.
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Spiral

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Matrix Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video spirals over and wipes out the outgoing video by using blocks of 
screen space, starting in the bottom left corner of the screen, spiraling inward in a 
counterclockwise movement.
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Zig-Zag

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Matrix Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a single block in the top left corner of the screen that 
wipes out the outgoing video as the band expands horizontally across the screen 
from left to right. When the first horizontal band reaches the right edge of the 
screen, a second band appears and expands horizontally across the screen from 
right to left. Succeeding bands repeat the process until the wipe is completed.
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Motion Effects

A motion effect is applied to a clip in the Source pop-up monitor and 
controls the rate at which the video channel is played. Motion effects 
include:

• Freeze Frame

• Variable Speed and Strobe Motion

Freeze Frame

Variable Speed and Strobe Motion

Effect Category Motion

Apply to Current frame in the Source pop-up monitor

Parameters Motion Effect Parameters – duration, two-field media

Description This effect repeats the current frame in the Source pop-up monitor for the 
specified duration.

Effect Category Motion

Apply to The clip marked by the IN and OUT points in the Source pop-up monitor

Parameters Motion Effect Parameters – variable speed, strobe motion, two-field media

Description Variable Speed creates slow motion, fast motion, or reverse motion. Strobe 
Motion creates a stuttering effect. The Strobe Motion effect can be used in 
combination with the Variable Speed effect.
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Peel Effects

Peel effects treat one video channel as though it were a sheet of paper 
being peeled from the other video channel. Peel effects include:

• Bottom Left Corner

• Bottom Right Corner

• Bottom to Top

• Left to Right

• Right to Left

• Top Left Corner

• Top Right Corner

• Top to Bottom
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Bottom Left Corner

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from the incoming video from the bottom left corner to 
the top right corner of the screen.
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Bottom Right Corner

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from the incoming video from the bottom right corner 
to the top left corner of the screen.
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Bottom to Top

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from the incoming video from the bottom edge to the 
top edge of the screen.
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Left to Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from the incoming video from the left edge to the right 
edge of the screen.
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Right to Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from the incoming video from the right edge to the left 
edge of the screen.
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Top Left Corner

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from the incoming video from the top left corner to the 
bottom right corner of the screen.
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Top Right Corner

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from the incoming video from the top right corner to 
the bottom left corner of the screen.
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Top to Bottom

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video is peeled from the outgoing video from the top to the bottom of 
the screen.
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Push Effects

Push effects move one video channel to fill the screen while the other video 
channel is pushed out of the screen. Push effects include:

• Bottom Left to Top Right

• Bottom Right to Top Left

• Bottom to Top

• Left to Right

• Right to Left

• Top Left to Bottom Right

• Top Right to Bottom Left

• Top to Bottom

n For examples of similar effects, see “Comparison of Similar Effects” on 
page 466.
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Bottom Left to Top Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out the outgoing video from the bottom left corner to the 
top right corner of the screen. Border is on the incoming video.
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Bottom Right to Top Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out the outgoing video from the bottom right corner to the 
top left corner of the screen. Border is on the incoming video.
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Bottom to Top

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out the outgoing video from the bottom to the top of the 
screen. Border is on the incoming video.
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Left to Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out the outgoing video from the left edge to the right edge 
of the screen. Border is on the incoming video.
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Right to Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out the outgoing video from the right edge to the left edge 
of the screen. Border is on the incoming video.
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Top Left to Bottom Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out the outgoing video from the top left corner to the 
bottom right corner of screen. Border is on the incoming video.
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Top Right to Bottom Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out the outgoing video from the top right corner to the 
bottom left corner of the screen. Border is on the incoming video.
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Top to Bottom

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out the outgoing video from the top to the bottom of the 
screen. Border is on the incoming video.
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Sawtooth Wipe Effects

Sawtooth Wipes are described in this section. Sawtooth Wipes include:

• Horizontal Sawtooth

• Horizontal Open Sawtooth

• Vertical Open Sawtooth

• Vertical Sawtooth

Horizontal Sawtooth

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Sawtooth Wipe

Apply to Transitions, multilayer segments

Parameters Foreground – level, reverse animation

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video appears with a sawtooth on the left edge of the screen. The 
sawtooth edge moves to the right edge of the screen, revealing the incoming 
video.
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Horizontal Open Sawtooth

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Sawtooth Wipe

Apply to Transitions, multilayer segments

Parameters Foreground – level, reverse animation

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a vertical sawtooth in the center of the screen. The 
sawtooth then expands outward to the left and right edges of the screen to display 
the incoming video in the center while covering the outgoing video.
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Vertical Open Sawtooth

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Sawtooth Wipe

Apply to Transitions, multilayer segments

Parameters Foreground – level, reverse animation

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a horizontal sawtooth in the center of the screen. The 
sawtooth expands up and down, revealing the incoming video.
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Vertical Sawtooth

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Sawtooth Wipe

Apply to Transitions, multilayer segments

Parameters Foreground – level, reverse animation

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Acceleration

Transition Parameters – transition effect alignment and duration

Description The sawtooth edge moves from the top of the screen down, covering the outgoing 
video and displaying the incoming video above the sawtooth.
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Shape Wipe Effects

Shape Wipes reveal one video channel on top of another video channel, 
using a growing or moving geometric shape. Shape Wipes include:

• 4 Corners

• Center Box

• Circle

• Clock

• Diamond

• Ellipse

• Horizontal Bands

• Horizontal Blinds

• Vertical Blinds
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4 Corners

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as blocks in four corners of the screen and wipes out the 
outgoing video as the blocks expand to fill the screen.
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Center Box

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a small box in the center of the screen and wipes out the 
outgoing video as it expands to fill the screen.
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Circle

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Foreground – level, reverse animation

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a small circle in the center of the screen and wipes out 
the outgoing video as it expands to fill the screen.
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Clock

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and durations

Description Incoming video appears as a vertical line from the center of the screen to the top 
edge. The incoming video replaces the outgoing video in a clockwise motion as if 
it were the hand on a clock.
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Diamond

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Foreground – level, reverse animation

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a small diamond in the center of the screen and wipes 
out the outgoing video as it expands to fill the screen.
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Ellipse

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, and softness

Foreground – level, reverse animation

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a small ellipse in the center of the screen and wipes out 
the outgoing video as it expands to fill the screen.
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Horizontal Bands

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Reversible Yes

Description Horizontal bands expand toward the center of the screen to reveal the incoming 
video between alternate shrinking bands of the outgoing video.
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Horizontal Blinds

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as horizontal bands on the screen that wipe out the 
outgoing video as the incoming bands expand vertically to fill the screen. 
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Vertical Blinds

Spin Effects

Spin effects rotate one or more video channels. Spin effects include:

• X Spin

• Y Spin

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Matrix Parameters (access through Other Options button) – matrix columns 
and rows

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as vertical bands on the screen that wipe out the outgoing 
video as the incoming bands expand horizontally to fill the screen. 
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X Spin

Outgoing footage

Middle of effect

Incoming footage

Effect Icon

Effect Category Spin

Apply to Transitions

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is squeezed until it appears as a vertical line. The incoming video 
then expands from that vertical line until it fills the screen. Border appears only 
on the incoming video.
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Y Spin

Outgoing footage

Middle of effect

Incoming footage

Effect Icon

Effect Category Spin

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is squeezed until it appears as a horizontal line. The incoming 
video then expands from that horizontal line until it fills the screen.
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Squeeze Effects

Squeeze effects expand a video channel from a single point or line until it 
fills the screen, obscuring the second video channel. Squeeze effects 
include:

• Bottom Centered

• Bottom Left

• Bottom Right

• Bottom to Top

• Centered Zoom

• Horizontal Centered

• Left Centered

• Left to Right

• Right Centered

• Right to Left

• Top Centered

• Top Left

• Top Right

• Top to Bottom

• Vertical Centered

n For examples of similar effects, see “Comparison of Similar Effects” on 
page 466.
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Bottom Centered

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
center bottom of the screen and expanding to fill the screen.
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Bottom Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
bottom left corner of the screen and expanding to fill the screen.
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Bottom Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
bottom right corner of the screen and expanding to fill the screen.
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Bottom to Top

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning at the bottom of the 
screen and filling to the top of the screen.
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Centered Zoom

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment

Description Incoming video starts as a rectangle in the center of the screen and zooms to fill 
the screen.
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Horizontal Centered

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video starts as a vertical band squeezed in the center of the screen and 
expands horizontally to fill the screen.
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Left Centered

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
center left edge of the screen and expanding to fill the screen.
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Left to Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning at the left edge of 
the screen and filling to the right edge of the screen.
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Right Centered

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
center right edge of the screen and expanding to fill the screen.



2D Effects

459

Right to Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning at the right edge of 
the screen and filling to the left edge of screen.
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Top Centered

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
center top edge of the screen and expanding to fill the screen.
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Top Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
top left corner of the screen and expanding to fill the screen.
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Top Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
top right corner of the screen and expanding to fill the screen.
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Top to Bottom

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning at the top edge of 
the screen and filling to the bottom edge of the screen.
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Vertical Centered

Outgoing footage Middle of effect Incoming footage

Effect Icon

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video starts as a horizontal band squeezed in the center of the screen 
and expands vertically to fill the screen.



2D Effects

465

Title Effects

Effect Icon

Effect Category Title effects

Apply to Multilayer segments

Static Title 
Parameters

Foreground – level, reverse animation

Acceleration

Description Title effects are created in the Title tool and can incorporate text, graphic objects, 
imported graphics, and video. Similar to Matte Key effects, Title effects are 
placed on segments in one video layer and then keyed over background video on 
the underlying video layers.
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Comparison of Similar Effects

Four effect categories have similar results: Box Wipe, Conceal, Push, and 
Squeeze. Examples of these effects are shown here to assist you in using 
these effects.

Box Wipe – 
Top Left to 
Bottom Right

Conceal – 
Top Left to 
Bottom Right

Push – Top Left to 
Bottom Right

Squeeze – 
Top Left
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Numerics
1:1.66 Mask effect 384
1:1.85 Mask effect 385
16:9 Mask effect 386
2D effect parameters

See Effect parameters
2D effects

See Effects
2D titles

See Titles
4 Corners Shape Wipe effect 438

A
Acceleration (2D) effect parameter 319
Activating

Render settings 171
Active group

defined 113
Add Edit button (Tool palette) 232
Add Edit function

with Submaster effects 232
Add Keyframe button 80, 99

Add Keyframe command (Keyframe Graph 
shortcut menu) 108

Add Keyframes commands (Effect Editor 
shortcut menu) 146

Add To Active Group command (Add Keyframe 
Mode menu) 113

Add To Active Parameter command (Add 
Keyframe Mode menu) 112

Add To All Parameters command (Add Keyframe 
Mode menu) 117

Add To Enabled Groups command (Add 
Keyframe Mode menu) 116

Add To Open Graphs command (Add Keyframe 
Mode menu) 117

Add To Open Groups command (Add Keyframe 
Mode menu) 115

Adding
keyframes in keyframe graphs 107

Adjusting
Render settings 169
title parameters 308

Advanced keyframes
See also Keyframe graphs
described 98
scaling 139
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Align Keyframe command (Keyframe Graph 
shortcut menu) 132

Align Objects commands (Alignment menu) 281
Align to Frame commands (Alignment menu) 281
Aligning

keyframes 132
title text 258
titles 281

Alignment buttons
in Quick Transition dialog box 71

Alignment grid
for titles 250

Alpha channel
AVI file import limitations 221
Matte Key effect editing 222
title creation with 246

Analog output
using ExpertRender for 179

Analog output hardware
real-time effects preview with 160

Anamorphic Mask effect 387
Animation sequences

types of 221
Anti-aliased elements in title 246
Applying

Dissolve effect 60
Dissolve effect, in Trim mode 61
effect templates 152
effects to multiple segments 55
effects to multiple transitions 53
effects to one transition or segment 50
effects to sequences 50
fades and dissolves with Head Fade and Tail 

Fade buttons 62
Submaster effect 232
title styles to title objects 293
transition effects in Trim mode 52
transition effects with Quick Transition 

button 63

Arrowhead tool (Title tool) 265
Arrowheads

adding to lines in titles 265
changing size 266

Aspect ratio
See Fixed Aspect option

Assigning
multiple tracks in AVX plug-ins 42

AudioSuite plug-ins 37
Auto Zoom effect parameter 346
AVI files

limitations on import 221
Avid Visual Extensions

See AVX
AVX (Avid Visual Extensions)

defined 36
AVX plug-ins

Angle control 44
assigning multiple tracks in 42
blank icons in Timeline 45
controls for 42
Illusion FX Pack 37
installing 38
interfaces for 42
locating AVX_Plug-Ins folder 40
messages in Console 45
missing effect categories 45
missing icons 44
plug effect icon 37
problems with loading 44
problems with rendering 45
Thumbwheel control 43
troubleshooting 44
upgrading 41
vendors 37
Web site for 37
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B
Background (2D) effect parameters 320
Background Color window (Title tool) 249
Bézier keyframe interpolation option

asymmetrical adjustment 128
described 127
independent adjustment 129
symmetrical adjustment 128

Bins
displaying title frames 302
effect templates in 35, 151
locating fast-saved titles 287
revising titles in 288
title clips in 301

Black point
adjusting with Color Effect 325

Blend Direction box (Title tool) 270
Blend effects

Dip to Color 350
Dissolve 351
Fade from Color 352
Fade to Color 353
Picture-in-Picture 354
Superimpose 355

Blowup effect 388
Blue bars

in timecode track of Timeline 164
Blue dot

in Timeline 198
with effect icons 161

Bold button (Title tool) 258
Bold command (Object menu) 258
Bold text in titles 257
Border (2D) effect parameters 321
Border Width tool (Title tool) 264
Borders

changing width 264
Both Fields option (Motion effects) 341
Bottom Box Wipe effect 357
Bottom Centered Squeeze effect 450

Bottom Left Corner Peel effect 416
Bottom Left L-Conceal effect 404
Bottom Left Squeeze effect 451
Bottom Left to Top Right Box Wipe effect 358
Bottom Left to Top Right Conceal effect 366
Bottom Left to Top Right Push effect 425
Bottom Right Corner Peel effect 417
Bottom Right L-Conceal effect 405
Bottom Right Squeeze effect 452
Bottom Right to Top Left Box Wipe effect 359
Bottom Right to Top Left Conceal effect 367
Bottom Right to Top Left Push effect 426
Bottom to Top Conceal effect 368
Bottom to Top Peel effect 418
Bottom to Top Push effect 427
Bottom to Top Squeeze effect 453
Box Corner tool (Title tool) 264
Box Wipe effects

Bottom Box 357
Bottom Left to Top Right 358
Bottom Right to Top Left 359
Left Box 360
Right Box 361
Top Box 362
Top Left to Bottom Right 363
Top Right to Bottom Left 364

Brightness
See Luminance

Bring Forward command (Object menu) 278
Bring to Front command (Object menu) 278
Buttons

Add Edit (Tool palette) 232
Add Keyframe 80, 99
Bold (Title tool) 258
Centered on Cut (Quick Transition 

dialog box) 73
Collapse (Tool palette) 236
Drop and Depth Shadow (Title tool) 274
Dual Split (Effect Preview Monitor 

toolbar) 89
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Ending at Cut (Quick Transition 
dialog box) 73

Enlarge (Effect Editor) 89
Enlarge (Effect Preview Monitor toolbar) 81
Extract/Splice-in (Timeline) 52
Fade Effect (Tool palette) 59, 308
Fast Forward (Effect Preview Monitor 

toolbar) 80
Fit to Fill (Command palette) 207
Grid (Effect Editor and Tool palette) 82, 89
Head Fade (Command palette) 62
in Effect Editor 86
in Effect Preview Monitor toolbar 80
Italic (Title tool) 258
Justification (Title tool) 258
Kerning selection (Title tool) 260
Lift/Overwrite (Timeline) 52
Motion Effect (Source pop-up monitor) 204
Other Options (Effect Editor) 43, 94
Outline/Path (Effect Editor) 88
Overwrite (Tool palette 203
Play (Effect Editor) 89
Play (Effect Preview Monitor toolbar) 80
Play Loop (Effect Editor) 89
Play Loop (Effect Preview Monitor 

toolbar) 81
Play Preview (Effect Preview Monitor 

toolbar) 81
Point Size (Title tool) 257
Promote to Advanced Keyframes (Effect 

Editor) 88
Quick Transition (Tool palette) 63
Real-Time Effects (Timeline) 162
Reduce (Effect Editor) 88
Reduce (Effect Preview Monitor toolbar) 81
Remove Effect (Tool palette) 57
Render Effect (Effect Editor) 88
Render Effect (Tool palette) 173
Rewind (Effect Preview Monitor toolbar) 80
Save Style Parameter (Title tool) 243

Shadow Depth and Direction (Title tool) 274
Splice-in (Tool palette) 203
Starting at Cut (Quick Transition 

dialog box) 73
Step Backward (Effect Preview Monitor 

toolbar) 80
Step Forward (Effect Preview Monitor 

toolbar) 80
Step In (Timeline) 226
Step Out (Timeline) 226
Styles (Title tool) 243
Tail Fade (Command palette) 62
Templates (Title tool) 243
Transition Effect Alignment 

(Effect Editor) 61, 88
Trim Left 1 Frame 100
Trim Left 10 Frames 100
Trim Right 1 Frame 100
Trim Right 10 Frames 100
Video Background (Title tool) 248

C
Center Box Shape Wipe effect 439
Centered on Cut button (Quick Transition 

dialog box) 73
Centered on Cut option 61, 348
Centered Zoom Squeeze effect 454
Changing

fonts 256
nested effect order with advanced 

keyframes 228
position in effects 84

Chroma Adjust effect parameters 327
Chroma Key effect

described 216
parameter reference 401

Circle Shape Wipe effect 440
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Circles
drawing in Title tool 263

Client monitor
real-time effects preview with 160

Clock Shape Wipe effect 441
Collapse button (Tool palette) 236
Collapsing layers 235
Color

adjusting for shadows in titles 274
background, in titles 248
blending in Title tool 268
parameters 94
selecting with eyedropper for titles 271
setting in Title tool 268

Color and Transparency Blend tools 
(Title tool) 267

Color coding
effects 161
playback information in Timeline 163
Submaster effect 232

Color dialog box (Windows) 95
Color Effect

adjusting black point 325
adjusting chrominance 327
adjusting hue 327
adjusting luma clip 326
adjusting luma range 324
adjusting luminance 322
adjusting midtones 325
adjusting saturation 327
adjusting white point 324
enhancing high-contrast image with 220
inverting chrominance 327
inverting luminance 322
parameters 322, 393
posterizing images 328
solarizing images 328

Color effects
Dip to Color 350
Fade from Color 352
Fade to Color 353

Color Gain effect parameters 330
Color Picker

Macintosh 96
Title tool 270

Color Selection boxes (Title tool) 267
Color Style effect parameters 328
Commands

See Menu commands
Comparison of similar effects 466
Composer monitor

real-time effects preview with 160
Conceal effects

Bottom Left to Top Right 366
Bottom Right to Top Left 367
Bottom to Top 368
Left to Right 369
Right to Left 370
Top Left to Bottom Right 371
Top Right to Bottom Left 372
Top to Bottom 373

Console
AVX plug-in messages in 45
motion effect type change messages in 199

Controlling
real-time effects preview 160, 165

Copying
keyframes 101
text into titles 252

Create Unrendered Title Media command 
(Clip menu) 287

Creating
Chroma Key effect 217
Luma Key effect 218
Matte Key effect 219
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nested effects 226
new Render settings 168
text for titles 251
title templates 294

Crop (2D) effect parameters 331
Current position display

field indicator in 81
Custom Start option 61, 348
Customizing

effect display 79

D
Delete From Active Group command (Delete 

Keyframe Mode menu) 113
Delete From Active Parameter command (Delete 

Keyframe Mode menu) 112
Delete From All Parameters command (Delete 

Keyframe Mode menu) 117
Delete From Enabled Groups command (Delete 

Keyframe Mode menu) 116
Delete From Open Graphs command (Delete 

Keyframe Mode menu) 117
Delete From Open Groups command (Delete 

Keyframe Mode menu) 115
Delete Keyframe command (Keyframe Graph 

shortcut menu) 109
Deleting

effect media files 188, 192
effects 56
keyframes in keyframe graphs 107
motion effect media 192
standard keyframes 102

Diamond Shape Wipe effect 442
Digidesign AudioSuite plug-ins 37
Dip to Color effect

creating with Quick Transition button 64
parameter reference 350

Disabling
real-time effects 162

Display rate
when processing effects 159

Displaying
Effect Palette 33
effect templates in bin 35
estimated render time 174
keyframe graphs 104
motion effect type change information 198
safe title/action area 81
title frames in bins 302

Dissolve effect
adding with Head Fade and Tail Fade 

buttons 62
applying 60
applying, in Trim mode 61
creating with Quick Transition button 64
described 351

Distribute commands (Alignment menu) 282
Distributing

title objects 282
Dragging

effects from Effect Palette 50
marked title clips into sequences 305
unmarked title clips into sequences 306

Drawing
circles and ovals in titles 263
graphics for titles 261
lines in titles 263
rounded box corners in titles 264
setting up environment 245
squares and rectangles in titles 262

Drop and Depth Shadow button (Title tool) 274
Dual Split button (Effect Preview Monitor 

toolbar) 89
Duplicated Field option (Motion effects) 341
DV output

real-time effects preview 160
using ExpertRender for 179
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E
Edge Wipe effects

Horizontal 375
Horizontal Open 376
Lower Left Diagonal 377
Lower Right Diagonal 378
Upper Left Diagonal 379
Upper Right Diagonal 380
Vertical 381
Vertical Open 382

Edit decision list
See EDL

Editing
imported master clips 223
Submaster effect 231
text for titles 254
titles in sequences 310
titles into sequences 303
titles, overview 300
with imported matte keys 222

EDL (edit decision list)
with Submaster effect 232

Effect Editor
adjusting titles 308
color parameters in 94
controlling image updating with keyframe 

graphs 145
controls in 86
displaying parameters 90
displaying thumbwheels with keyframe 

graphs 145
effect parameters in 91
Enable buttons 93
enlarging text with keyframe graphs 144
Fast Menu button 93
indenting rows with keyframe graphs 144
keyframe graphs, Add Keyframe Mode menu 

and Delete Keyframe Mode menu 110
keyframe graphs, toolbar controls 105

keyframe tracks, opening 104
movement of position indicator with keyframe 

graphs 145
opening 78
Other Options button 94
pop-up menu 143
resetting keyframe graph view 143
scroll thumbwheel 141
setting default Add Keyframe button behavior, 

with keyframe graphs 146
showing Add Keyframe Mode menu 146
sliders 92

Effect icons
display of real-time status 161

Effect Palette
applying Dissolve effect from 60
categories in 31
defined 31
display of plug-ins 37
displaying 33
double-clicking icons 52
dragging effects from 50
resizing 34

Effect parameters
2D, overview 318
Acceleration (2D) 319
accessing additional 94
adjusting color 94
Auto Zoom 346
Background (2D) 320
Border (2D) 321
changing for individual keyframes 101
Chroma Adjust 327
Color Effect 322
Color Gain 330
Color Style 328
Crop (2D) 331
described 91
displaying 90
Enable button 93
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extrapolating values with advanced 
keyframes 139

eyedropper 95
Foreground (2D) 332
Freeze Frame 338
global versus keyframeable 91, 319
holding values in keyframe graphs 139
in keyframe graphs, changes at keyframes 124
Key 334
Luma Adjust 322
Luma Clip 326
Luma Range 324
Matrix 337
Model 344
Motion 338
Position (2D) 343
Region of Interest 345
Region Stabilize 344
Scaling (2D) 347
Secondary Key 335
selecting using Fast menu 93
sliders 92
Spill Suppression 336
Strobe Motion 340
title, adjusting 308
transition 348
Variable Speed 340

Effect Preview monitor
described 79
displaying safe title/action area 81
field indicator 81
moving enlarged image 83
toolbar 80
tracking information in 81

Effect templates
applying 152
defined 35, 150
displaying in bin 35

in bins 151
saving 151
viewing 35

Effects
See also Key effects, Nested effects, 

Submaster effect, Title effects, and 
specific effect categories, for example, 
Blend effects

2D parameters, overview 318
2D types 317
applying Dissolve 60
applying Dissolve, in Trim mode 61
applying to a single transition or segment 50
applying to multiple segments 55
applying to multiple transitions 53, 64
applying to multiple transitions using Quick 

Transition button 67
applying to sequences 50
applying to transition in Trim mode 52
categories in Effect Palette 31
changing position in 84
color coding for 161
Color, using to enhance high-contrast 

image 220
comparison of similar 466
controlling real-time preview 160, 165
creating with Quick Transition button 64
customizing user interface for 79
deconstructing 48
deleting 56
deleting media files 188
double-clicking icon in Effect Palette 52
dragging from Effect Palette 50
examples of 48
fading 58
Freeze Frame 199
managing media files 188
media files, deleting 192
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media files, described 188
media files, revealing 189
motion 196
motion, defined 28
multilayer, defined 28
output, rendering for 31
playback capabilities for 30
playing individual 156
playing individual, in a loop 157
playing individual, in a wire-frame 

preview 157
playing individual, using Play button 156
previewing, dependencies for 30
previewing, summary of options 30
processing in real time 159
promoting to advanced keyframes 103
real-time preview 159
real-time preview settings 166
real-time preview, delaying start 166
real-time preview, disabling 162
real-time preview, enabling 161
real-time preview, information in 

Timeline 163
real-time preview, monitor options 160
real-time preview, prefilling 166
Region Stabilize 210, 398
rendering at position 175
rendering between IN and OUT points 176
rendering one 173
rendering, general concepts 167
replacing existing 85
saving templates 151
segment, defined 28
single-layer, defined 28
sizing to fit 74
Strobe Motion 207
summary of creation tools 29
templates for 35
templates in bins 151
title, defined 28

transition, defined 28
transition, summarized 59
types, described 28
Variable Speed 204
Video Underrun error messages 158
viewing media files 188

Elastic command (Keyframe Graph shortcut 
menu) 124

Elastic keyframes 122
Ellipse Shape Wipe effect 443
Enable button (Effect Editor) 93
Enabled group

defined 116
Enabling real-time effects 161
Ending at Cut button (Quick Transition 

dialog box) 73
Ending at Cut option 61, 348
Enlarge button (Effect Editor) 89
Enlarge button (Effect Preview Monitor 

toolbar) 81
Enlarged image

moving in the Effect Preview monitor 83
Error messages

Video Underrun 158
Expanding

nested effects 225
ExpertRender

after real-time playback attempt 182
considerations when using 187
described 177
for output 179
for real-time effects playback 163
for real-time effects preview 178
modifying results of 185
rendering with 180
using 179
using before output 161

ExpertRender commands (Clip menu) 180
Export Title command (File menu) 296
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Exporting
titles as graphics files 296

Extract/Splice-in button (Timeline) 52
Extrapolate command (Keyframe Graph shortcut 

menu) 139
Extrapolate option

keyframe graph parameter values 136
Eyedropper

selecting colors in titles 271
using 95

F
Fade Effect button (Tool palette) 59, 308
Fade from Color effect

creating with Quick Transition button 64
parameter reference 352

Fade to Color effect
creating with Quick Transition button 64
parameter reference 353

Fading
effects 58
effects using Head Fade and Tail Fade 

buttons 62
titles 308

Fast Forward button (Effect Preview Monitor 
toolbar) 80

Fast menus
selecting effect parameters with 93

Fast Save option 286
Fast-motion effects

creating 204
reversing 205

Field indicator in current position display 81
Fill track in titles 312
Film Dissolve effect 389
Film effects

1:1.66 Mask 384
1:1.85 Mask 385
16:9 Mask 386

Anamorphic Mask 387
Blowup 388
Film Dissolve 389
Film Fade 390
Mask 391

Film Fade effect 390
Film negative

simulating look with solarization 328
Fit to Fill

motion effects 341
Fit to Fill button (Command palette) 207
Fixed Aspect option (Scaling (2D) effect 

parameters) 347
Fixed command (Keyframe Graph shortcut 

menu) 124
Fixed keyframes 123
Flip effect 394
Flip-Flop effect 395
Flop effect 396
Font Selection button and menu (Title tool) 256
Fonts

changing 256
compatibility between systems 245
installing 245
setting point size 257
substituting 245

Foreground (2D) effect parameters 332
Formatting

title text 254
Four Corners Shape Wipe effect 438
Freeze Frame command (Clip menu) 200
Freeze Frame effect

controlling with a single button or key 201
creating 199
parameter reference 338, 414
using after rolling clip 203

Function keys
confirming mapping of title styles 292
mapping title styles to 291
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G
Gain with key effects 335
Gamma, adjusting with Color Effect 325
Global effect parameters 319
Glow effect for titles 277
Graphic images

types of 221
with alpha channel 222
without alpha channel 223

Graphical display in Quick Transition 
dialog box 70

Graphics for titles
adding arrowheads to lines 265
adding shadows 274
aligning 281
changing arrowhead size 266
circles and ovals 263
displaying grid for 250
distributing evenly 282
drawing 261
layering of 278
line or border width 264
lines 263
rounding box corners 264
squares and rectangles 262

Graphs
See Keyframe graphs

Green dot
in Timeline 168
with effect icons 161

Grid
for title alignment 250

Grid button (Effect Editor and Tool 
palette) 82, 89

Grid Matrix Wipe effect 409
Group command (Object menu) 279
Grouping

title objects 279
Groups

See Parameter groups

H
Halo effect for titles 277
Handles

for resizing foreground image 149
hollow, for locked objects 280
in Quick Transition dialog box 71
on arrowheads 266
on Title tool objects 244

Head Fade button (Command palette) 62
High Performance option (Video Display 

settings) 160
High Quality option (Video Display settings) 160
High-contrast image

enhancing with Color Effect 220
with Matte Key 219

Hold command (Keyframe Graph shortcut 
menu) 139

Hold option
keyframe graph parameter values 136

Horizontal Bands Shape Wipe effect 444
Horizontal Blinds Shape Wipe effect 445
Horizontal Centered Squeeze effect 455
Horizontal Edge Wipe effect 375
Horizontal Open Edge Wipe effect 376
Horizontal Open Sawtooth Wipe effect 434
Horizontal Sawtooth Wipe effect 433
Hue

adjusting with Color Effect 327
defined 320

I
Illusion FX Pack plug-ins 37
Image effects

Color Effect 393
Flip 394
Flip-Flop 395
Flop 396
Mask 397
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Region Stabilize 398
Resize 399
Submaster 400

Images
graphic, types of 221
graphic, with alpha channel 222
graphic, without alpha channel 223

Importing
AVI files 221

Indent Rows command (Effect Editor shortcut 
menu) 144

Independent keyframes
See Keyframes, Keyframe graphs

Installing
AVX plug-ins 38

Insufficient Source information 74
Interface

customizing for effects work 79
Interpolated Field option (Motion effects) 342
Interpolation options

for keyframe graphs 124
Interrupting

render on-the-fly 158
rendering of effects 172

Invert Key option (Foreground effect 
parameter) 333

Inverting chrominance
with Color Effect 327

Italic button (Title tool) 258
Italic command (Object menu) 258
Italic text in titles 257

J
Justification buttons (Title tool) 258
Justifying

title text 258

K
Kerning of title text 258
Kerning selection button and text box 

(Title tool) 260
Key effect parameters 334
Key effects

Chroma Key 216, 401
described 216
editing with Matte Key 222
Luma Key 218, 402
Matte Key 219, 403
Matte, in nested layers 229

Keyboard shortcuts
saving titles 289

Keyframe graphs
aligning keyframes 132
Bézier interpolation option 127
controlling image updating 145
controlling movement of position 

indicator 145
copying and pasting keyframes in 119
default Add Keyframe button behavior, 

setting 146
described 98, 102
displaying 104
displaying thumbwheels in Effect Editor 145
Effect Editor shortcut menu 143
Effect Editor toolbar controls 105
elastic keyframes 122
enlarging text in Effect Editor 144
extrapolating parameter values 139
fixed keyframes 123
holding parameter values 139
indenting rows in Effect Editor 144
interpolation options 124
Linear interpolation option 125
moving keyframes in 118
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open graph 117
resetting view 143
resizing 142
scale bar 140
scrolling left to right 141
scrolling up or down 142
Shelf interpolation option 125
slipping keyframes 134
Spline interpolation option 126
zoom slider 140
zooming 140

Keyframe tracks
described 102
opening 104

Keyframeable effect parameters 319
Keyframes

See also Keyframe graphs, Keyframe tracks
adjusting titles 309
advanced, Add Keyframe Mode menu 110
advanced, aligning 132
advanced, Bézier interpolation option 127
advanced, changing order of nested 

effects 228
advanced, Delete Keyframe Mode menu 110
advanced, described 102
advanced, displaying keyframe graphs 104
advanced, effects supported 102
advanced, elastic 122
advanced, extrapolating parameter values 139
advanced, fixed 123
advanced, Linear interpolation option 125
advanced, moving in keyframe graphs 118
advanced, opening keyframe tracks 104
advanced, parameter groups 111
advanced, promoting effects to 103
advanced, Shelf interpolation option 125
advanced, slipping 134
advanced, Spline interpolation option 126
advanced, using Add Keyframe button 108
changing parameters 101

copying and pasting 101
copying and pasting in keyframe graphs 119
creating standard 99
defined 98
deleting standard 102
in keyframe graphs, adding and deleting 107
moving 100
selecting 100

L
Large Text command (Effect Editor shortcut 

menu) 144
Layering

title objects 278
L-Conceal effects

Bottom Left 404
Bottom Right 405
Top Left 406
Top Right 407

Leading of title text 261
Leading text box (Title tool) 261
Left Box Wipe effect 360
Left Centered Squeeze effect 456
Left to Right Conceal effect 369
Left to Right Peel effect 419
Left to Right Push effect 428
Left to Right Squeeze effect 457
Lift/Overwrite button (Timeline) 52
Line tool (Title tool) 263
Linear keyframe interpolation option 125
Lines

attribute options 263
changing width 264
drawing in Title tool 263

Locating
AVX_Plug-Ins folder 40

Lock command (Object menu) 280
Locked objects

hollow handles 280
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Locking
title objects 280

Lower Left Diagonal Edge Wipe effect 377
Lower Right Diagonal Edge Wipe effect 378
Luma Adjust effect parameters 322
Luma Clip effect parameters 326
Luma Key effect 218, 402
Luma Range effect parameters 324
Luminance

adjusting with Color Effect 322
defined 320
inverting with Color Effect 322

M
Macintosh Color Picker 96
Managing

title styles in Project window 293
Manipulating

title objects 277
Mapping

title styles to function keys 291
Mask effect 391, 397
Mask effects for film 384
Master clips

editing with imported 223
Matrix effect parameters 337
Matrix Wipe effects

Grid 409
One-Way Row 410
Speckle 411
Spiral 412
Zig-Zag 413

Matte Key effect
creating 219
described 403
editing with 222
in nested layers 229

Media disks
speed limitations with real-time effects 

preview 164
Media files

deleting 192
insufficient source material 74
title 301

Menu commands
Add Keyframe (Keyframe Graph shortcut 

menu) 108
Add Keyframes commands (Effect Editor 

shortcut menu) 146
Add To Active Group (Add Keyframe Mode 

menu) 113
Add To Active Parameter (Add Keyframe 

Mode menu) 112
Add To All Parameters (Add Keyframe Mode 

menu) 117
Add To Enabled Groups (Add Keyframe 

Mode menu) 116
Add To Open Graphs (Add Keyframe Mode 

menu) 117
Add To Open Groups (Add Keyframe Mode 

menu) 115
Align Keyframe (Keyframe Graph shortcut 

menu) 132
Align Objects (Alignment menu) 281
Align to Frame (Alignment menu) 281
Bold (Object menu) 258
Bring Forward (Object menu) 278
Bring to Front (Object menu) 278
Create Unrendered Title Media 

(Clip menu) 287
Delete From Active Group (Delete Keyframe 

Mode menu) 113
Delete From Active Parameter (Delete 

Keyframe Mode menu) 112
Delete From All Parameters (Delete Keyframe 

Mode menu) 117
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Delete From Enabled Groups (Delete 
Keyframe Mode menu) 116

Delete From Open Graphs (Delete Keyframe 
Mode menu) 117

Delete From Open Groups (Delete Keyframe 
Mode menu) 115

Delete Keyframe (Keyframe Graph shortcut 
menu) 109

Distribute (Alignment menu) 282
Elastic (Keyframe Graph shortcut menu) 124
ExpertRender (Clip menu) 180
Export Title (File menu) 296
Extrapolate (Keyframe Graph shortcut 

menu) 139
Fixed (Keyframe Graph shortcut menu) 124
Freeze Frame (Clip menu) 200
Group (Object menu) 279
Hold (Keyframe Graph shortcut menu) 139
Indent Rows (Effect Editor shortcut 

menu) 144
Italic (Object menu) 258
Large Text (Effect Editor shortcut menu) 144
Lock (Object menu) 280
New Title (Clip menu) 240
New Video Track (Clip menu) 222
Preview (Object menu) 247
Real-Time Update (Effect Editor shortcut 

menu) 145
Re-create Title Media (Clip menu) 314
Render at Position (Clip menu) 175
Render In/Out (Clip menu) 176
Render On-the-Fly (Clip menu) 158
Render Ranges (Timeline Fast menu) 172
Reset Graph View (Keyframe Graph shortcut 

menu) 143
Reveal File (File menu) 190
Safe Colors (Object menu) 247
Safe Title Area/Global Grid (Object 

menu) 247
Save Title (File menu) 285

Save Title as (File menu) 285
Select Unrendered Titles (Bin menu) 287
Send Backward (Object menu) 278
Send to Back (Object menu) 278
Set Bin Display (Bin menu) 189, 301
Set Position To Keyframe (Effect Editor 

shortcut menu) 145
Show Add Keyframe Mode Menu (Effect 

Editor shortcut menu) 146
Show Alignment Grid (Alignment menu) 250
Slip Keyframe (Keyframe Graph shortcut 

menu) 134
Soften Shadow (Object menu) 275
Thumbwheels (Effect Editor shortcut 

menu) 145
Title Tool (Tools menu) 240
Title Tool (Windows menu) 250
UnGroup (Object menu) 279
Unlock (Object menu) 281
Update Position While Playing (Effect Editor 

shortcut menu) 145
Video Mixdown (Clip menu) 238

Midtones
adjusting with Color Effect 325

Mixing down
video 237

Model effect parameter 344
Modifying

ExpertRender results 185
Video Display settings 166

Monitors
options for real-time effects preview 160

Motion Effect button (Source pop-up 
monitor) 204

Motion Effect parameters 338
Motion effects

controlling Freeze Frame with a single button 
or key 201

creating Freeze Frame 199
creating Strobe Motion 207
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creating Variable Speed 204
defined 28
deleting media 192
described 196
displaying type change information 198
Freeze Frame 414
icons 197
rendering options 170
rendering requirements for 197
revealing media 189
reversing 342
Strobe Motion 414
type change messages in Console 199
using Freeze Frame after rolling clip 203
Variable Speed 414

Motion path 147, 148
Moving

keyframes in keyframe graphs 118
Multilayer effects

See also specific effect categories, for 
example, Blend effects

creating with nesting 224
defined 28
deleting 58
keys 216

Multiple tracks
as AVX plug-in input 42

N
Nested effects

changing order of, with advanced 
keyframes 228

creating 226
described 224
expanding 225
re-creating title media 314
stepping in and out 225
video layers in 224

with matte key 229
with Submaster effect 231

New Title command (Clip menu) 240
New Video Track command (Clip menu) 222
NTSC frame

safe title/action guidelines 247

O
Objects in titles

adding shadows 274
aligning 281
distributing evenly 282
grouping and ungrouping 279
layering 278
locking and unlocking 280
manipulating 277

One-Way Row Matrix Wipe effect 410
Open graph

defined 117
Open group

defined 115
Opening

Effect Editor 78
keyframe tracks 104

Other Options button (Effect Editor) 43, 94
Outline/Path button (Effect Editor) 88
Output

analog, using ExpertRender for 179
DV, using ExpertRender for 179
of effects, rendering for 31
using ExpertRender for 161

Oval tool (Title tool) 263
Ovals

drawing in Title tool 263
Overwrite button (Tool palette) 203
Overwriting

titles into sequences 303
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P
PAL frame

safe title/action guidelines 247
Parameter groups

active, defined 113
defined 111
enabled, defined 116
open, defined 115

Partial render 171
Pasting

text into titles 252
Peel effects

Bottom Left Corner 416
Bottom Right Corner 417
Bottom to Top 418
Left to Right 419
Right to Left 420
Top Left Corner 421
Top Right Corner 422
Top to Bottom 423

Picture-in-Picture effect
foreground image movement 147
promoting to advanced keyframes 103
reference 354

Play button (Effect Editor) 89
Play button (Effect Preview Monitor toolbar) 80
Play Loop button (Effect Editor) 89
Play Loop button (Effect Preview Monitor 

toolbar) 81
Play Preview button (Effect Preview Monitor 

toolbar) 81
Playback

capabilities for effects 30
individual effects 156
individual effects, in a loop 157
individual effects, using Play button 156
individual effects, wire-frame preview 157
individual tracks, restriction with Submaster 

effect 400

real-time information bars in Timeline, 
described 163

real-time information bars in Timeline, 
disabling 164

real-time information bars in Timeline, 
enabling 164

real-time, rendering to achieve 182
titles, limitations 300
video effects, real-time 159

Plug-in effects
See AVX plug-ins, Digidesign AudioSuite 

plug-ins
Point Size button and text box (Title tool) 257
Position (2D) effect parameters 343
Posterization

adjusting with Color Effect 328
Precomputed master clip

defined 30
result of rendering 168

Prefilling
real-time effect preview 166

Preview
video effects, real-time 159

Preview command (Object menu) 247
Previewing

anti-aliased titles 246
Processing

effects in real time 159
Project window

displaying Effect Palette 33
managing title styles 293

Promote to Advanced Keyframes button (Effect 
Editor) 88

Promoting
effects to advanced keyframes 103

Push effects
Bottom Left to Top Right 425
Bottom Right to Top Left 426
Bottom to Top 427
Left to Right 428



Index

484

Right to Left 429
Top Left to Bottom Right 430
Top Right to Bottom Left 431
Top to Bottom 432

Q
Quick Transition button (Tool palette) 63
Quick Transition dialog box

graphical display in 70

R
Real-time

preview of video effects 159
processing of effects 159

Real-time effects
disabling preview 162
enabling preview 161

Real-Time Effects button (Timeline) 162
Real-Time Update command (Effect Editor 

shortcut menu) 145
Recalling

title styles 291
Re-create Title Media command (Clip menu) 314
Re-creating title media 314
Rectangles

drawing in Title tool 262
Red bars

in Timecode track of Timeline 163
Reduce button (Effect Editor) 88
Reduce button (Effect Preview Monitor 

toolbar) 81
Region of Interest effect parameters 345
Region Stabilize effect

Auto Zoom parameter 346
described 210, 398
Model parameter 344
parameter reference 344

reference 398
Region of Interest parameters 345
troubleshooting 213
types 212

Remove Effect button (Tool palette) 57
Removing

titles from sequences 307
Render at Position command (Clip menu) 175
Render Effect button (Effect Editor) 88
Render Effect button (Tool palette) 173
Render In/Out command (Clip menu) 176
Render on-the-fly

interrupting 158
Render On-the-Fly command (Clip menu) 158
Render Ranges command (Timeline Fast 

menu) 172
Render settings

activating 171
adjusting 169
creating new 168
described 168
options 170

Rendered effects
color coding for 232
viewing in bins 301

Rendering
after real-time playback attempt 182
AVX plug-ins 45
displaying estimated time 174
displaying render ranges 172
dots in effect icons 198
effects at position 175
effects between IN and OUT points 176
effects, for output 31
fast saved titles 287
interrupting 172
motion effects 170
multiple effects 176
multiple effects with Submaster 232
saving partially completed renders 171
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single effect 173
Submaster restriction 400
titles 314
using ExpertRender 180

Replacing
existing effects 85
fill track in titles 312
titles in sequences 308

Repositioning
text for titles 253

Reset Graph View command (Keyframe Graph 
shortcut menu) 143

Resetting
keyframe graph view 143

Resize effect 399
Resizing

Effect Palette 34
foreground image 149
keyframe graphs 142
text for titles 253

Resolution
re-creating title media after changing 314

Reveal File command (File menu) 190
Revealing

effect media files 189
motion effect media 189

Reverse Animation option (Foreground effect 
parameter) 332

Reversing
fast-motion effects 205
motion effects 342
slow-motion effects 205

Revising
titles in a bin 288
titles in sequences 310

Rewind button (Effect Preview Monitor 
toolbar) 80

Right Box Wipe effect 361
Right Centered Squeeze effect 458
Right to Left Conceal effect 370

Right to Left Peel effect 420
Right to Left Push effect 429
Right to Left Squeeze effect 459
Rolling clip

using Freeze Frame after 203

S
Safe Colors command (Object menu) 247
Safe Title Area/Global Grid command (Object 

menu) 247
Safe title/action area

displaying 81, 89
for aligning objects 281
in Title tool 247

Saturation
adjusting with Color Effect 327
of colors in titles 247

Save Style Parameter button (Title tool) 243
Save Title as command (File menu) 285
Save Title command (File menu) 285
Saving

multiple titles 285
partially completed renders 171
title styles 289
titles 284
titles using keyboard shortcut 289
titles with Fast Save 286
unrendered titles 286

Sawtooth Wipe effects
Horizontal 433
Horizontal Open 434
Vertical 436
Vertical Open 435

Scale bar
advanced keyframes 139
keyframe graphs 140

Scaling (2D) effect parameters 347
Scroll thumbwheel in Effect Editor 141
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Scrolling
keyframe graphs, left to right 141
keyframe graphs, up or down 142

Secondary Key effect parameters 335
Segment effects

See also specific effect categories, for 
example, Image effects

applying to multiple segments 55
applying to one segment 50
Chroma Key editing 216
defined 28
deleting 58
fading 58
Luma Key 218
Matte Key 219
multilayer 28
saving with media 151
single-layer 28
Submaster 231
title editing 308

Select Unrendered Titles command 
(Bin menu) 287

Selecting
keyframes 100
objects in Title tool 244
text in titles, for formatting 255

Selection tool (Title tool)
described 242
viewing attributes with 255

Send Backward command (Object menu) 278
Send to Back command (Object menu) 278
Sequences

applying effects to 50
applying Submaster effect to 232
deleting effects from 56
dragging marked titles into 305
dragging unmarked titles into 306
editing titles 310
removing titles 307

replacing titles 308
splicing titles into 303
title editing 303

Set Bin Display command (Bin menu) 189, 301
Set Position To Keyframe command (Effect 

Editor shortcut menu) 145
Setting

default attributes for title text 255
point size of fonts 257

Settings
Render 168
User 245
Video Display 166

Shadow Depth and Direction button 
(Title tool) 274

Shadows
adding to titles 274
adjusting softness on-the-fly 275
confirming current softness 276
depth 273
drop 273
for titles, adjusting color and transparency 274
for titles, described 273
setting softness 274

Shape Wipe effects
4 Corners 438
Center Box 439
Circle 440
Clock 441
Diamond 442
Ellipse 443
Horizontal Bands 444
Horizontal Blinds 445
Vertical Blinds 446

Shelf keyframe interpolation option 125
Show Add Keyframe Mode Menu command 

(Effect Editor shortcut menu) 146
Show Alignment Grid command (Alignment 

menu) 250
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Show Alpha option (Foreground effect 
parameter) 333

Single-layer effects
See Segment effects

Size of effect
foreground image 149
source media 74

Sliders
in Effect Editor 92

Slip Keyframe command (Keyframe Graph 
shortcut menu) 134

Slipping
keyframes 134

Slow-motion effects
creating 204
reversing 205

Snap grid
for titles 250

Soft shadows
adjusting on-the-fly 275
confirming current value 276
creating 274

Soften Shadow command (Object menu) 275
Solarization

adjusting with Color Effect 328
Speckle Matrix Wipe effect 411
Speed of an effect and video underruns 158
Spill Suppression effect parameters 336
Spin effects

X Spin 447
Y Spin 448

Spiral Matrix Wipe effect 412
Splice-in button (Tool palette) 203
Splicing

titles into sequences 303
Spline keyframe interpolation option 126
Square and Rectangle tool (Title tool) 262
Squares

drawing in Title tool 262

Squeeze effects
Bottom Centered 450
Bottom Left 451
Bottom Right 452
Bottom to Top 453
Centered Zoom 454
Horizontal Centered 455
Left Centered 456
Left to Right 457
Right Centered 458
Right to Left 459
Top Centered 460
Top Left 461
Top Right 462
Top to Bottom 463
Vertical Centered 464

Stabilize effect
See Region Stabilize effect

Stabilizing an image
Region Stabilize parameters 344
using Region Stabilize 210, 398

Starting at Cut button (Quick Transition 
dialog box) 73

Starting at Cut option 61, 348
Step Backward button (Effect Preview Monitor 

toolbar) 80
Step Forward button (Effect Preview Monitor 

toolbar) 80
Step In button (Timeline) 226
Step Out button (Timeline) 226
Stepping

in and out of nested effects 225
Strobe Motion effect

creating 207
parameter reference 340, 414

Styles
See Title styles

Styles button (Title tool) 243
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Submaster effect
applying 232
applying to multilayered sequence 232
as alternative to ExpertRender 179
color coding for 232
creating EDL for 232
described 231, 400
minimizing rendering with 168
using with short clips 234

Substituting fonts 245
Superimpose effect 355
Swap Sources option (Foreground effect 

parameter) 332

T
Tail Fade button (Command palette) 62
Templates

See Effect templates, Title templates
Templates button (Title tool) 243
Text for titles

adding shadows 274
aligning 281
bold 257
copying and pasting 252
creating 251
distributing evenly 282
editing 254
eliminating unused space around 252
formatting 254
italic 257
justifying 258
kerning 258
layering of 278
leading 261
repositioning 253
resizing 253
selecting for formatting 255
setting default attributes 255

Text tool (Title tool)
described 242
using 251

Thumbwheel
Effect Editor 92

Thumbwheels command (Effect Editor shortcut 
menu) 145

Timecode track (Timeline)
real-time playback information 163

Timeline
color coding for effects 161
expanding nested effects in 225
real-time playback information bars, 

described 163
real-time playback information bars, 

disabling 164
real-time playback information bars, 

enabling 164
rendered effects in 232
segment editing of titles 304
toolbar 226

Title clips
described 301

Title styles
applying to title objects 293
confirming function key mapping 292
managing in Project window 293
mapping to function keys 291
recalling 291
saving 289

Title templates
creating 294
defined 294
using 295

Title tool
adding arrowheads to lines 265
adjusting shadow color 274
adjusting shadow softness on-the-fly 275
adjusting shadow transparency 274
background options 248
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Blend Direction box 270
blending colors 268
blending transparency 272
bold text 257
bringing to foreground 250
changing arrowhead size 266
changing fonts 256
Color and Transparency Blend tools 267
Color Picker 270
Color Selection boxes 267
confirming current shadow softness 276
creating text 251
described 241
drawing circles and ovals 263
drawing graphics 261
drawing squares and rectangles 262
editing text 254
eliminating unused space around text 252
exiting 284
installing fonts 245
italic text 257
justifying text 258
line or border width 264
lines, attributes for 263
lines, drawing 263
opening 240
overview 240
pasting text into 252
repositioning text 253
resizing text 253
rounding box corners 264
safe title/action area 247
selecting objects 244
selecting text for formatting 255
setting color 268
setting default text attributes 255
setting font size 257
setting shadow softness 274
setting transparency 271
setting up environment 245

text kerning 258
text leading 261
toolbar 242
Transparency Level boxes 267
Transparency Value box 271
User settings 245

Title Tool command (Tools menu) 240
Title Tool command (Windows menu) 250
Titles

adding shadows 274
adjusting parameters in Effect Editor 308
aligning 281
alignment grid 250
applying styles to objects 293
clips, described 301
color of background 248
color saturation 247
creating a glow or halo effect 277
creating templates 294
displaying frames in bins 302
distributing objects 282
dragging marked clips into sequences 305
dragging unmarked clips into sequences 306
editing in sequences 310
editing into sequences 303
editing, overview 300
effect parameter reference 465
exporting as a graphics file 296
fading 308
Fast Save option 286
fast saved, locating in bin 287
formatting text in 254
grouping objects 279
layering objects 278
locking objects 280
manipulating objects 277
overview 240
overwriting into sequences 303
playback limitations 300
previewing 246
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recalling styles 291
re-creating media for 314
removing from sequences 307
rendering 314
rendering fast saves 287
replacing fill track 312
replacing in sequences 308
revising in a bin 288
saving 284
saving multiple 285
saving unrendered 286
saving with a keyboard shortcut 289
segment editing 304
selecting colors with eyedropper 271
selecting objects 244
shadows, described 273
snap grid 250
splicing into sequences 303
templates, defined 294
templates, using 295
ungrouping objects 279
unlocking objects 280
updating video background 249

Toolbars
Effect Preview monitor 80
Timeline 226
Title tool 242

Top Box Wipe effect 362
Top Centered Squeeze effect 460
Top Left Corner Peel effect 421
Top Left L-Conceal effect 406
Top Left Squeeze effect 461
Top Left to Bottom Right Box Wipe effect 363
Top Left to Bottom Right Conceal effect 371
Top Left to Bottom Right Push effect 430
Top Right Corner Peel effect 422
Top Right L-Conceal effect 407
Top Right Squeeze effect 462
Top Right to Bottom Left Box Wipe effect 364
Top Right to Bottom Left Conceal effect 372

Top Right to Bottom Left Push effect 431
Top to Bottom Conceal effect 373
Top to Bottom Peel effect 423
Top to Bottom Push effect 432
Top to Bottom Squeeze effect 463
Tracking information in Effect Preview 

monitor 81
Tracks of video

gain levels 335
in nested effects 224

Transition Effect Alignment button (Effect 
Editor) 61, 88

Transition Effect Duration box (Effect Editor) 88
Transition effects

See also specific effect categories, for 
example, Blend effects

adjusting with graphical display in Quick 
Transition dialog box 70

alignment 348
alignment options 61
applying in Trim mode 52
applying to multiple transitions 53, 64
applying to one transition 50
applying with Quick Transition button 63
defined 28
deleting 58
dissolves 60
parameter reference 348
sizing to fit 74
summarized 59
trimming 75

Transparency
adjusting for shadows in titles 274
blending in Title tool 272
setting in Title tool 271

Transparency Level boxes (Title tool) 267
Transparency Value box (Title tool) 271
Triangular opener

using with keyframe tracks 104
Trim Left 1 Frame button 100
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Trim Left 10 Frames button 100
Trim mode

applying Dissolve effect 61
applying transition effects 52
trimming transitions in 75

Trim Right 1 Frame button 100
Trim Right 10 Frames button 100
Troubleshooting

AVX plug-ins 44
Types of effects 317

U
UnGroup command (Object menu) 279
Ungrouping

title objects 279
Unlock command (Object menu) 281
Unlocking

title objects 280
Unrendered titles, saving 286
Update Position While Playing command (Effect 

Editor shortcut menu) 145
Upgrading

AVX plug-ins 41
Upper Left Diagonal Edge Wipe effect 379
Upper Right Diagonal Edge Wipe effect 380
User settings

controlling Title tool with 245

V
Variable Speed motion effect

creating 204
parameter reference 340, 414
sizing to fit marked duration 207

Vertical Blinds Shape Wipe effect 446
Vertical Centered Squeeze effect 464
Vertical Edge Wipe effect 381

Vertical Open Edge Wipe effect 382
Vertical Open Sawtooth Wipe effect 435
Vertical Sawtooth Wipe effect 436
Video background

updating in Title tool 249
Video Background button (Title tool) 248
Video Display settings

described 166
modifying 166

Video effects
real-time preview 159

Video mixdown 237
Video Mixdown command (Clip menu) 238
Video Placement tool (Title tool) 242
Video Underrun error messages 158
Viewing

effect media files 188
effect templates 35

VTR-Style option (Motion effects) 342

W
White point

adjusting with Color Effect 324
Windows Color dialog box 95
Wipe effects

Box Wipe 356
Edge Wipe 374
Matrix Wipes 408
Sawtooth Wipes 433
Shape Wipes 437

Wire-frame preview of effects 147, 157
Wire-frame resize handles 149

X
X Spin effect 447
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Y
Y Spin effect 448
Yellow bars

in Timecode track of Timeline 163

Z
Zig-Zag Matrix Wipe effect 413
Zoom slider

keyframe graphs 140
Zooming

keyframe graphs 140
on an effect 147
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